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1 General Information
1.1 Introduction
When the engineer Andreas Schubert arrived with the first German-built steam engine in
Dresden on April 1st, 1839, the story of the means of transportation began, which
revolutionised the world, had distances be connected and still cannot be imagined without
these days. Through the rail, invention and new fields of scientific research were promoted
that developed into sciences and educational institutions of its own throughout the 20th
century.
The conditions that were changing within the railway operation- particularly the deeper
consideration to customer needs- intensified the requirement of more improved and more
flexible planning instruments. Timetable Construction Programme FBS has offered
technologists an efficient tool for timetable construction since 1993. With FBS, a programme
package for a computer aided construction of all working timetables necessary within the
railway operation has been created with the help of which railway traffic from extensive
graphic timetables up to station timetables of large central stations are planned and carried
out nationwide these days.
Since 1997, FBS has been further developed at the Institute for Traffic Planning Systems
iRFP. Market-determined benefits as the computer aided evaluation and control of relevant
data (e.g. timetable slots) and the consistent using of system available data are further
extended and important functions are newly implemented, as required by the traffic market
nowadays. However, simple, fast and reasonable work is still possible on account of low
demands on hardware, the central data maintenance within the network and modular
organisation of software.
This instruction offers you detailed information on the work with FBS, on opportunities and
the functional range of the programme system as well as on the organisation and using of
data structure. Since the FBS programmes have constantly been further developed, a
supplement to the manual with the most recent functions is added if required. You find a
summary of the innovation on our Internet page at www.irfp.co.uk.
The timetable programme currently (November 2015) consists of the following programmes:
 FBS-Dispatcher (survey of files)
 Integrated planning program iPLAN
 Station Database Editor BSV
 Train type and h’code Editor ZNV
 Engine Database Editor TFZ
FBS is available in a wide range of functions as well as in versions for industrial purposes
(FBSbahn) and for research and teaching purposes (FBSFuL). For non-industrial purposes
by private individuals a specific version is marketed with the scope of service that is adjusted
to the hobby field (FBSprivat). Thus, mainly historic locomotives are included in FBSprivat;
commercial functions for analyses and statistics were not implemented and expressions
indicate information about private use.
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If requested, further additional programmes are available, in particular, for the conversion of
data in or rather from existing data systems. Likewise, the conversion can be carried out by
iRFP.
The programmes of the FBS-family are still deliberately delivered without any textual
assistance. In our experience, textual assistance loses its meaning after a certain training
period anyway and for the consulting it is still better to use a computer-independent
assistance. You can find quick information above most buttons and symbols if you do not
move the mouse pointer for a moment.
On this spot, we want to thank the users of the previous versions for their advice, tips and
hints, which could be incorporated for the most part. Naturally, such great project still lives
according to the response of the users and the practical orientation involved. Therefore, we
would still like to ask you for active notification of your experience, problems and suggestions
to our institute (addresses look at the inner booklet).

1.2 Further Information/ Support/ Response
You can inform yourself about reforms, update-opportunities as well as planned functions on
our homepage at www.irfp.de/aktuelles.
For specific questions and problems please use our service per e-mail. The following
addresses are available for you:
for FBSbahn-version:

fbsbahn@irfp.de

for FBSFuL-version:

fbsful@irfp.de

for FBSprivat-version:

fbsprivat@irfp.de

In general:

service@irfp.de

In the Info-window in all FBS-programmes (yellow button or menu help/info) you find a
Service-button. So you can send a message quickly and directly to our service team.
For FBSbahn-customers, we recommend concluding a completing service-contract, which
offers, among others, additional telephone-support as well as a technology guarantee for the
time after the deadline of the guarantee period. We welcome you to inform yourself about
extent and conditions at info@irfp.de.

1.3 Text conventions in this document
Bold type indicates menu items, columns headers, tabs and buttons, which you may find
again with this term. The individual menu items, submenus and tabs are separated from
each other by >.
Those individual words, which need to be particularly stressed for an emphasizing of details,
are underlined in the text.
Additional explanations are printed in italics.
Explanations of special significance are indicated by an exclamation mark. Please read
through those passages with careful consideration. Settings, for example, are explained here
which have fundamental significance for a project and should therefore occur in the
beginning of the work or which will have far-reaching consequences.
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1.4 System requirements
1.4.1 Minimum requirements
Pentium IV or compatible processor, 800 MHz, 256 MByte RAM, 4 MByte graphics card
(XVGA, 1024 x 768 points), a two button mouse or similar device, 50 MB hard disc storage
unit, CD-ROM drive for first installation, 32-Bit-system software (Microsoft® Windows© 7, other
Windows versions on request), Windows-compatible printer.

1.4.2 Recommended requirements for a faster use of FBS
Pentium-III-processor, AMD K7 or compatible processor with at least 800 MHz, 512 MByte
RAM or more, 16 MByte graphics card, PCI- or AGP-Bus, mouse, 17“-monitor with 1024 x
768 points, two-monitor-mode, colour plotter
The screen resolution has to be set on at least 1024 x 768 points, otherwise there
could occur problems with the window and type sizes.
If you would like to use FinePrint you need version 5 or higher.

1.5 Installation
The timetable scheduling system is delivered on a CD with an installation programme. It
fulfils the Microsoft-Windows principles and only changes its system files in a permissible
way, which can be cancelled again. For the installation in Windows 2000 and XP you need
administration rights.
Please put the CD into the CD drive and select Start> Run from the taskbar. Following this,
please enter [CD-drive]:\Setup and press Ok. (If auto start has been activated for your CDdrive, the setup-programme starts automatically.) Everything else will be carried out by the
installation programme, which will also ask you about the installation path and extent of the
requested installation. You may subsequently install individual FBS-elements, which you do
not want to install initially, later on.
We recommend compiling a folder (directory) of its own for FBS. The installation programme
suggests C:\Programme\FBS, however, you can compile any other folder, as well. The
target folder must not necessarily be available; it is automatically created if relevant.
If you wish to have the Timetable Construction System FBS be enlisted in menu Start,
please enter a programme group in the installation programme or select an existing one. This
programme group is constructed again, if it does not exist yet.
The installation programme also takes care of the registration of the programmes and the
timetable files in the Windows-registry database.

1.6 Subsequent installation und de-installation
Currently, there can only be one reasonable cause to de-install FBS: You have got a new
version...
You may also install FBS in another directory than the old version has been. When installing
above an existing version you run the risk that not all of the files are replaced correctly or that
unnecessary files remain at the hard disc.
You may also add an incomplete installation. For that purpose, the installation programme
starts appropriate files and registration entries during the installation. At the de-installation all
files that were delivered with FBS as well as the registration entries will be deleted. FBS files
that were started by the user will not be deleted also not the FBS-directory if it still contains
timetable files.
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For the subsequent installation or de-installation please proceed as follows:
Close all FBS-programmes (F12) and select the item Control Panel (Start > Settings >
Control Panel). Open Software and select the item FBS from the list Installation/Deinstallation. The setup-programme now offers you the option for the complete reinstallation,
the supplement of components as well as for the de-installation. For the reinstallation or
supplement you need the original FBS-CD. Windows carries everything else out.

1.7 Trains, train parts and direct connections
1.7.1 Trains in FBS
A train is an operational view on a ride from station A to B. For operational purposes it is not
relevant whether all parts of the train run from A to B or which tariff is allowed for that train.
Important is train’s head code for priority of train and trains number for identification. In some
cases special information of trains attributes is also coded into the head code. So DB uses
annex –T for tilting trains in the head code. A tilting ICE vehicle runs ever as ICE-T in
operational view.
Along a train run several (nearlly all) data can change. The only thing which keeps the train
as one train is the train number.
In FBS runs a background system which combines several sections of a train run to one train
when all following conditions are fullfilled:

 same train number,
 same multiple train index,
 the first section ends where the second section begins and
 arrival and departure of the train is in less the 12 hours.

1.7.2 Function of train parts
Train parts as the name says are parts of a train. Every train has a minimum of one train part
in each section. The train part consists of the vehicles, operational days and a product name
which is shown to the customer. It is also possible to give a train part several attributes like
line number, coloure, ... For circulation purposes it is required that each engine is put in an
own train part. So a train consisting of two multiple unit has two train parts. One for each
multiple unit. It is not usefull to change vehicles during a train part run. If you want to change
from Diesel- to electric-engine you should handle them as different train parts.
Train parts of a train do not need to have one attribute together. They can differ completely in
operation days, vehicles are whatever. It is also not necessary that all train parts have to run
the whole route of the train. So a train part can begin later or end earlier than another. The
operational days of a train route section is defined by an intersecting set of all train parts
inside this section.
Train part number is used to identify a train part in FBS. In case you use the same train part
number in different trains it will be also set together like a train. This way it is possible to
define train coupling and sharing in FBS.
Combining train parts between different trains can change the operational days for a train
rund especially for circulation purposes. For example:
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 graphic timetable 1: Train within train part 3001 Dresden – Bischofswerda, daily,
 graphic timetable 2: Train within train part 3001 Bischofswerda – Zittau, W not 24.
and 31. december
Result for train parts:

 1. train part: 3001: Dresden – Zittau, W not 24. and 31. december
 2. train part: 3001: Dresen – Bischofswerda, S also 24. and 31. december
This way you should make sure what happens in a closed timetable period:
At the last day of a timetable period ends at 12 p.m. and the first day beginns 0 a.m. So a
train runing over midnight would have an apprupt end at the last day and a sudden beginning
at the first day of the timetable period. If the defined timetable period is a mutiple of seven
days it is defined that the train runs at the last day of the timetable period to its normal
destination. Normally a timetable period begins at the night between saturday and sunday so
nearlly all periods can be seen as a closed loop.

1.7.3 Definition of direct connections
For railway customers trains and train parts are not the required database for information. So
a modell of direct connections is defined. They consist of the train part runs and are further
analyised. A direct connection here is the longest section you can travel without interchange.
If there is a second train part at (a part of ) this section and has less operational days it is not
relevant for customer information. So they can be filtered. This is the base for customer
information via customers timetable are arrival and departure poster.

1.8 Functions in all FBS-programmes
The FBS-programmes stick to the general Windows-standard. Menu layout, window control
and short cut are standardised as familiar to you from Microsoft Office products, for example.
Usually, there are four opportunities to activate a programme function: You can select the
appropriate menu item with the mouse or you can activate the menu by the underlined letters
(in combination with the Alt key). Moreover, numerous menu items have a so-called short
cut, a key sequence. This is indicated in the menu. You can tap the key sequence at any
time in which the particular function will be activated immediately.
Eventually, the Timetable Construction System FBS offers you mouse buttons for most of the
functions. Those are arranged in the toolbar at the upper window edge and only need to be
clicked on with the mouse (no double-click) to activate the function. Some mouse buttons
represent an on state and therefore can be ”pushed in“ and “out“.
 Short information to all mouse buttons is displayed if you hold the mouse pointer for some
seconds above the button. This information provides an indication of the function that is
activated by the button.

1.9 Run programme and Open file
If the installation has been carried out correctly, you will find the programme entries of the
single FBS-elements in the subdirectory Programme \ Timetable Construction System
FBS of the “Start“ menu of Windows. Furthermore, the installation programme creates a
linkage at the desktop. This represents the fastest way to reach the FBS-Start window (see
chapter 1.12, at page 6).
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The file extension of the FBS files are linked with the appropriate programmes. You can
double-click those files in the Windows explorer and Windows changes to the respective FBS
programme or rather runs it. In addition, a specific logic ensures the selection of various files
without starting a programme several times.

1.10 The menu “Programmes“
If you work with several FBS programmes, the functions to change programmes are
available to you: There is the Programmes-menu in all FBS programmes. By choosing an
entry you can select another programme or change to it.
Moreover, the menu buttons correlate with a uniform key sequence. Thus, you reach every
FBS programme directly via keyboard. In principle, the following short cuts are applied:
Shift + F1

FBS – Data Overview

Shift + F2

iPLAN – Timetable Programme

Shift + F5

BSV – Station Database

Shift + F6

ZNV – Train Type and h’code Database

Shift + F7

TFZ – Engine Database

Shift + F12

Exit all FBS-Programmes

When selecting a programme by the Programmes-menu (or a F-key respectively) it is
checked first, whether the selected programme has already been run under Windows. If this
is the case, the current programme will be minimized to an icon. The programme that has
been selected is informed that it has to display itself as complete picture and that it must
undertake the input control. If it does not run yet, it is started again.

1.11 The menu items “Window“ and “File“
The programme iPLAN is a so-called Multi-Document-Interface-Programmes. This means
programmes, which can open several files in there own sub-windows. Each sub-window is
allocated to a file and can be scaled at will in the range of the main window.
The menu items in the menu Window regulate the sub-windows. You may arrange those in
various ways and change and jump among them.
The menu item File each opens, closes, saves and starts sub-windows. The number is solely
limited by the memory store.

1.12 The FBS-Start Window
1.12.1

General Information

The click on the FBS-icon at the desktop or in Start menu opens the FBS Start Window. With
this you have a quick access to the Timetable and Network Timetable Programme, in which
you can begin with a new file or an existing file. FBS-Dispatcher leads to FBS’ own file
overview (see chapter 1.13, at page 7). At the Additional Programmes you find the the
Station database, the Train type and h’code Programme, as well as the Engine database
programme.
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1.12.2

Installation and maintenance

1.12.2.1 Change language
Ctrl+Alt+L
FBS is available in English, French, German and Czech. Under Installation and Repair >
Change Language you can select the required language. However, please pay attention to
the fact that not all windows allow the change of the language during the processing. In this
case, please close the window and open it again after the change of the language. Additional
languages are implemented on request. Some windows are managed by your Windows®
and so they use the Windows-language you have chosen.
1.12.2.2 Installation and Repair – Additional Functions
With this you can check or, if necessary, change the file types and path details for the FBS
programmes within the tab Update Registration Entries. For it you must possess
administration privileges. For the work at the computer you can change the layout of the
menus under Menu-Layout Configuration. Next to four standard designs, there is a colour
palette for each of the menu items available to you. Moreover, you can change diverse
measures.
Changes to the licence data may require a modification of the licence plug. For that purpose
appropriate functions are offered under Install Driver for Licence Key and Run Service
Programme for Licence Key. Finally, with Window Configuration you can adapt the Start
window to your ideas by yourself. Besides, you can decide whether the Start Window may be
kept open or should be closed if you run one of the FBS Programmes.

1.13 The FBS File Overview
1.13.1

General Information

You reach the FBS-file overview via the menu item Open FBS-File from the Start menu or
via key Shift + F1 from all FBS-programmes. This is arranged similarly to the WindowExplorer. It features the same functions to delete, copy, rename and replace files as well
known through the explorer. Moreover, there is the tree structure of the databases.

1.13.2

Detail Layout

Here, the FBS-files are displayed additionally with version number, purpose, creation time,
editing time and person as well as with a short specification. With this, a clear structured
administration of FBS-files is possible and the orientation within the FBS-database is
facilitated.
You can edit information on Purpose and Specification files in the appropriate FBSprogrammes (e.g. within the Timetable Programme in the General Line Data) or with the
menu item Properties from the FBS-File Overview in the context menu of the right-hand
mouse button.

7

Chapter 1  General Information
1.13  The FBS File Overview

Documentation to FBS
Edition November 2015

8

Chapter 2  Working in a network with iPLAN
2.1  General

Documentation to FBS
Edition November 2015

2 Working in a network with iPLAN
2.1 General
2.1.1 Preliminary note
iPLAN manages one or more lines in track files (*.fpl). So for example a customer timetable
does not need to beginn at the station where the line file starts. A junction is mostly not
interesting for a passenger. Also a train can change the line at a station but the driver´s
timetable should be continued so that the driver does not need to search another page.
Furthermore the engines of a circulation plan would not only operate at one line. Finally you
can produce an ambitious interval graphic to show the relations in a clock-face timetable
system.
A network for the programme is a collection of line data, timetable at the line and the
definition of nodes in which lines are combined. If you would like to create timetables for a
single line, you also need to define a network with only this line. Just for your orientation you
can produce a network grafik and print it. This graphic is not used any longer in the
programme. For illustration, publishment or presentation the interval graphic might be the
better way.

2.1.2 Condition for use of iPLAN
iPLAN uses a file ending on ntz. So the track files (*.fpl) are linked into the ntz-file and
combined there by knodes. This file includes the basic informations about the network: the
links to the fpl-files, the nodes and so on. All this data are saved in a file ending with .ntz.
The file includes the objects, which are:
 grafik timetables,
 station timetables,
 driver´s timetables,
 customer´s timetable or schedules,
 circulation plans and
 interval graphics.
It is possible to use relative paths and variables to define the folders in which the files are
saved. So the timetable data do not need to be saved in the same folder as the NETZ-file.
The fpl-files are searched by the following ways:
 if there is no path filled in:
 if a path is known:

inside the folder in which the NETZ-file is saved

in this patth which can start by <FBS>, <OWNER>, <USER>.

2.1.3 Steps by working with network timetables
The following steps are recommended for simple use of iPLAN:
1. create a folder for the timetable and network file on your hard disk
2. start the iPLAN-programme and create a new ntz-file in this folder
3. add a line to the network (chapter 2.2.3, page 15)
4. as an option you can set the color of the line
9
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5. select the nodes of the line
6. repeat the steps 3 to 5 until all lines are filled in
7. as an option you can fill in koordinates for the nodes at the network graphic
8. as an option you can edit the nodes in the network graphic (symbol, size of font and
angle of text)
9. insert new objects (driver´s timetable, customer´s timetable, circulation plan, interval
graphic)
Please note, that some objects have to be supplemented by further informations, which are
not included in the fpl-file (hints in customer´s timetables,...). Normally some circulation
planes are possible so that you have to select one of them. At the end you can print the
objects.
All the steps are described at the following pages. Before you create your first ntz-file you
should comprehend the steps in a delivered example ntz-file. The context menu summerises
functions, which you often need and so you can do a fast job.

2.1.4 Contents of main window
The main window is separated in several parts. The left part shows you a network graphic
based on coordinates of the stations and the colours of the lines. This is used for your
orientation and is one of the options to get a graphic timetable (see chapter 3 starting at page
27) or a customers timetable (see chapter 5 starting at page 93) for example. The part on the
rightern side is split in three parts. The upper part contains the list of line files which are
included in the current network. If you click on a node inside of the graphic on the left the first
line which is linked to the node will be selected. Below the list of line files you can see a list of
nodes of the network. If a node has the same abbreviation in every line file the lines will be
combined there so it is possible to change at this node from one line to the other.
At the lower part of the rightern side of the window you find the list of all network objects
which have been created for this network.
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2.1.5 Handling of network graphic
Some network objects (graphic timetable, customers timetable) are defined by marking the
path inside of the network graphic. To be able to see which lines have been selected at the
moment they are highlighted with yellow colour like using a text marker on paper. After you
defined the main route of a customers timetable and used the continue button the colour
changes from yellow to blue. The branch line you define now will again be shown with yellow
colour.
It is possible to extend or detour the current path. By klicking the first and the last node of
your wished path the programm shows you the shortes way between them. Using the right
mouse button allows you to define, whether your thrird click is an extension of the current
path or it is a detour maybe for easier train runs.
Additionally to the show path inside of the graphic a window is shown which lists all nodes at
whom the lines are changed. A doubleclick at the last entry of this list delets the node so that
you can correct the way through the network.

2.1.6 The context menu (mouse meu) of iPLAN-programme
If you click an element in the network graphic
or the lists by mouse and do a right click the
contextual menu opens. So you see all
functions which ca be done with this element.
The current functions depend on the element
you have choosen. All the functions are
äquivalent to the symbol line on top of the programme window.
Some items can be reached faster by a double click at the
element. These items are written in bold.
The functions in relation to driver’s timetable are explained in
chapter 4.6 on page 91.
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2.1.7 Undo/Redo
Alt+Rück for undo
All objects and the iPLAN-programm itself have there own undo
and redo functions. They are located inside of the Edit-menu.
Just take care, that the undo functions are interleaved. That
means if you undo step 3, after doing step 4 inside of the
shown changes inside of the shown NETZ are undo too. A
special function exists inside of the function edit table inside of
the customer’s timetable. It has an own undo function, which is
integrated in the undo system. Undoing step 5 after doing step
h inside of the table means changes I to IV are undo too. The
number of possible undo steps is configured by you as
explained in 2.5.1 at page 20.

2.2 Edit menu
2.2.1 General network data...

step
1

iPLAN
1

2

2

3

3

object

4

a

5

b

6

c

7

d

8

4

9

5

10

e

11

f

12

g

or context-menu in line files list or context menu inside network graphic
2.2.1.1

Register “File information”
This page shows you path and file name and further details of
the file itself. For example file version, last change and so on.
The label File information can be used for a free text which
will be shown in the list of line files. Also File useage helps you
to get an orientation what would be filled in this file.
2.2.1.2

Register “File provileges”

Here you have to push the “Change rights” button first. After
that you can define, who is allowed to open this file. Every User, every User with the same
license name (your company), Users with your license key (number) or with a valid
password. You can also limit here the users which are allowed to change and/or save
data. It is also possible to limit the access to the infrastruktur or levels or train groups of
trains. So you can fix for example your regular train services and other users can only add or
delete special train services. To do so all trains to be saved have to be in the levels or train
groups you select here.
2.2.1.3

Register “Network map”

Here you can insert a description of the network in the meaning of a headline. The headline
is also shown in the corner on top left.
The description filled in here can be used in several objects you can create so it would be helpful to
use a signifcant name.
2.2.1.3.1

Area “Coordinate system (outer coordinates)”

The coordinates of the stations are filled in in geographic coordinates (longitude and
latitude). The advantage of this system is shown by station databases, which include this
data and so they can be used here. You can change the size of the graphic so that it is
12
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stretched or compressed. If you do not have the coordinates you have to position the stations
manually.
2.2.1.3.2

Area “line width and font sizes”

Here you define the behaviour of iPLAN by zooming in
the network graphic. You can say scale down only or
scale down and enlarge lines and font sizes. The first
option is usefull if you want to see details which are
placed near. The other option can be used like a normal
loupe.
2.2.1.4

Register “Other”

This is a free text box to fill in remarks for you or other
uses how to handle this file.

2.2.2 General Timetable Data
Or Alt + F
This window contains several question mark buttons. By clicking them you can see a list of
files which is included in the network and the database or setting which is included at each
file. So you must select one of them to be used in every single file. In case of all files use the
same setting a hint is shown to you.
2.2.2.1
2.2.2.1.1

Register “References“
Part “cross references“

At first you can select the database files for stations, engines, waggons, train type and
h’code, which are used, for this timetable. New files point to delivered database files. The
string <FBS> means the installation path of FBS-programmes. So the programmes start
searching the datafiles at the position of the current file and can find the other files shown
there. This relative links are also avaibale for <FPL> and <NTZ> for network files.
If you do not wont to use the delivered file you can create your own databases. The FBSprogram family includes programs, which will help you editing:
 BSV for station database (chapter 9, Page 145)
 ZNV for trains type and h’code database (chapter 12, Page 150)
 TFZ for engine database (chapter 13, Page 152)
2.2.2.1.2

Part “Railway Company“

You can define a standard railway company to find engines easier. It helps you to find the
engines with names you know. Engines used by other railway companies get the short cut of
the company at the beginning. The engines of your standard company are shown on top of
the engines list.
2.2.2.2
2.2.2.2.1

Register “Technical Data“
Area „Run time calculation“

iPLAN takes care for a minimum remaining period between accelerating and breaking during
the time calculation. This remaining period helps you saving energy. 30 seconds is default for
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the minimum remaining period. You can change it bye yourself. A realistic result of today is
rail traffic is calculated with 5 to 10 seconds. By engineering the infrastructure you should
use 30 seconds. The difference in run time is not important but the difference in used energy.
2.2.2.2.2

Area “braking table”

In case you need a special braking table to be used for brake calculation you can select the
version which should be used.
2.2.2.3

Register “Calendar“

Detailed information to fill in the operation days can be found in Annex – Declaration of
operation days.
If you would like to create a study or prototype timetable without exact dates you do not need
to fill in anything here. In this case you can use only the standard functions of statistics and
regular operating days. Functions like special operating days or data related days of run are
not possible.
To use statistic and other functions of the FBS-family you should define a timetable period.
Just activate the box period is defined. Please fill in the first and the last date of the period.
Normally a period is not longer the 370 days. If you wont you can define periods of some
years but not more then 32768 days.
Take care: If you have defined a timetable period and filled in other calendar dates (e. g.
holidays, special operating days) you can change the period only by reset-button. So Please
note this for defining the period of your timetable.
If you wont to recycle a timetable with a defined period you have to reset the period at first
and reload the special
operating days.
The following parts of the
instruction will help you to
reload the holidays with less
effort.
After defining timetables
period you should define
holidays. It is not possible to
enter the dates in the input
field. Press the button on the
right of the input field. A new
calendar window opens. The Saxon holidays are marked red. A double-click marks or
demarks a day.
The file fbs.ini includes a part in which the default holidays are included. You can change
them in an easy editor program. The headline of the section is [Feiertage]. If you enter an
exact date the holiday is located every year at the same date. FBS is able to calculate
variable holidays for example
Christmas.
The button variable holidays
shows you selected Christian
holidays. You can activate or
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deactivate the black written by a click. Holidays in grey colour are not in the period and so
they cannot be activated.
You can also mark holidays, which are not fixed by law or confession but relevant in the
period, by double-click.
If you need special holiday definitions just call the service of FBS.
The field The set of days includes the following days: shows you all selected dates for
holidays. The months are summarized if possible. The reset button erases all dates, which
are not default. (All holidays are cleared and default holidays are reloaded from fbs.ini.) If you
have defined service periods in the calendar register you can also define them as holidays
in your period.
In register calendar you can define up to 20 service periods, which are often used. It is
easier to define school holidays here as to mark the service days for every train in your
timetable. These service periods can be used as regular operating days for your trains. So
trains can be “in service only in”, “except of” or “also in” the service period. You can connect
the operating day informations e.g. “Mo-Fr, only service period 1” or “Mo-Fr, except of
service period 1”. For your control you should give the set of days a name like “summer
holidays” or “soccer championship”. The examples as to be seen above means: “Train is in
service from Monday to Friday only by summer holidays” resp. “Trains in service from
Monday to Friday but not in summer holidays.”
To use the service periods as holidays you have to open the holiday window again and use
the button include other sets and collect the correct period by here name.
A day of service period can include other days of services or single days – just like you want.
So you can build a service period “school holiday” by service period “summer holiday” and
“winter holiday” and “spring holiday” and so on. To choose the days quickly click the first day,
press shift and click the last day.
Existing service periods can be edited by double-click on one of the list elements. To erase a
service period use the button delete. A request helps you to block erase by mistake.
If you would like to use the service periods in another timetable you can use the copy to …
button. The following dialogueue shows all opened timetables and gives you the possibility to
copy period and holidays only ore period, holidays and special days. It is important that no
other service periods are defined in the file you would like to copy them in. The copied
service periods are not linked so that you can edit them in different files.
Sometimes you might need a summary of service days. To get it easy into your text editor
press the summary … button. iPLAN copies the data into the clipboard so that you can
paste it in your text editor.

2.2.3 Traffic input data
2.2.3.1

Register “Regular stop times”

This side shows you all stations inside your network and the stop times which are definied in
the 8 lists from each line file. So you can rename a list in all files by clicking the header and
replacing the text. You can also select the included lines, the order of the stations and the
station attributes which have to be fullfiled by the stations which are shown. In some cases
an entry in the table is marked with yellow background color. That means in different line files
is a different behaviour defined at the current list of stop times for this station. If you correct
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them next time you will see only one line for this station and no yellow background color
anymore.

2.2.4 Insert line ...

You have to repeat the following procedures for every line you need in your network. The row
of the lines is not important.
To go one you have to select whether you would like to include a line from an existing file or
you would like to create a new FPL-file as a blank line file.

2.2.5 Edit line

You can change the colour, the category and remarks for a line by adding here or do it
separat. The category is also the tickness of the line beeing shown in the network graphic.
The remarks are not shown anywhere.
The file name is the fpl-file you selected and the description is taken from the lines start and
ending station.

2.2.6 Remove line

This function delets the selected line from the network. All stations, which belong only to this
line, will be deleted too. The fpl-file itsself is not deleted.

2.2.7 Rename FPL files
In some situations it might be helpfull to give the included FPL-files in your network another
name. So you have several options here to define a new name for the files.

2.2.8 Choose junctions...

The railway nodes in the meaning of the NETZ-programme are the terminals of the timetable
files. Also every possibility to change a line along another line has to be marked as a railway
node or junction. This can also be a junction! You can mark every other station as a railway
node if this station is important in you meaning. Please note, that customer timetables can
only start or end at nodes.
The left part of the window shows all train order
change places of the current line and the right
one shows all nodes selected from the line. You
can move the stations from left to right or just the
opposite by the arrow buttons. The option show
all shows all stations and locations along the line.
So they can also be shown in the network graphic
which can help you by your orientation.
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If the station and location database includes the geographic coordinates of the node it will be
positioned automatically in the network graphic. If not, you can use the function as written in
2.2.9, page 17.
All nodes are differe in the system by there abbreviation. So a node, which exists in some
line files, has to have the same abbreviation! So you should use the function Create
unequivocal abbreviations of stations in graphic timetables (look at chapter 3.2.10.4,
starting at page 39). The lines and nodes are listed on the right of the iPLAN-window. The
window at the corner down right is reserve for the objects made by iPLAN. To call up one of
the following functions you can click in the network graphic or in of the three lists by a right
click. The mouse menu shows you the possible functions to the element you have choosen.
The
button opens the Station data-window in which you can fill in the data as
written in chapter 2.2.9 on page 17.

2.2.9 Edit junction
or Network > Edit junction or double click at the station in the station list or double
click at the station in the network graphic or mark the station in the station list and use
the item Edit junction
It might be possible to adjust the label of a station because
the label overlaps each other. You migh also need differet
font sizes or symbols to show the importance of a station.
The station data window allows you to change:
 the name of the station (taken from the graphic
timetable file),
 the coordinates of the station inside of the network
graphic (related to the maximum size of the network),
 the size of the symbols in typographic points an
 the text justification, the angle and the typface. It is possible to justify the text left, right
or up or down the posistion.

2.2.10

Set position of junction

If you would like to create your network graphic you only need
to set a posistion for every node. Click a node at he list on the
right of the window. If the coordinates are found in the station
and location database this coordinates are used. Otherwise
click the mouse button Set position of junction or choose the
item at the context menu. After that click the position at which
the node should be placed.
Repeat this step for all nodes. To keep the window open click the check box Leave the
window open and click the next station and use the context meu to repeat the function. The
nodes of one line are linked directly. You can change colour and thickness as written in
chapter 2.2.5, at page 16.
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2.2.11

Reload coordinates

If you changed the positions of the stations and locations manually and you are not happy
about the result, you can reload the coordinates for all stations as saved in the station and
location database. All stations are moved back to this coordinates.

2.3 Network objects menu
2.3.1 Open network object
You can open an object by a double click at the list item or by some items of the context
menu. Further details about the possibilities can be found in the object chapters at the
following pages.
An object cannot be opened twice. If you open an object, which is still open the programme
shows you the window of the object. You can skip between open windows by Tab or
Shift+Tab or Ctrl+F6.
Every object has its own name, which is normally related to the content and is simillar to a
headline. The name is used to identify the object in the list of objects and can be changed by
context menu item Rename network object.

2.3.2 Rename network object
You can use this function if you would like to change the name of the network object. Enter
the new name in the line and press Ok to save the new name.

2.3.3 Delete network object(s)

Select the object and use the mouse button or the item in the context menu. If the object is
still open please close it at first and delete it after that. If you erase the object all links and the
object is lost forever. So you have to confirm the erasing of any object. It is not possible to
undo this function!

2.3.4 New NETZ-objects
At the moment it is possible to create the following objects:


graphic timetable



station timetable



driver’s timetables



customers timetables



circulation plans



interval graphic

,
,
,

and
.

It is also possible to create arrival and departure posters, which are handled in a special
way.
These functions are only available if you have defined at least one line in your network.
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All objects belonging to the network are shown in the box on bottom right of the iPLANwindow. Furter details to create a object and how to handle it you can read in the chapters 4
for Driver’s timetables (starting at page 80), 5 for Customer’s timetable (starting at page 93),
6 for Circulation plan (starting at page 110) and 7 for Interval graphic (starting at page 130).

2.4 Analysis menu
2.4.1 Station overview
2.4.1.1

General

Here you can see the result of the comparison of all stations and locations in your network
against the stations and locations included in the station database. The result is shown in the
right column. If everything is ok there is an x. If there is an exclamation mark to be seen there
might be a conflict because there is a station or location known by the abbreviation but it has
a different name. The question mark shows you a station known in the database by
abbreviation and name but it has a different state.
2.4.1.2

Station database > Select station database

There opens a window to select the station database, which should be used for comparison.
2.4.1.3

Station database > Update station database

This way is useful if you could use most of the
data by the station database and if there are only
fewer conflicts. Choose one of the options to
update the station database. You can select the
stations, which should be changed in the station
database by the conventional way of selection in
Windows®-programmes.
2.4.1.4

Station database > Edit station database

The item edit station database opens the station database programme as explained in
chapter 9, starting at page 145.
2.4.1.5

Station database > Create new station database

If you could use only some data by your station database or you are not interested in a
nationwide database you can create a new station database by your network. So you have to
create a new station database by this item and to give here a name. The station database
will be opened. Please close this winow and select the function Station database > Update
station database > Fully update whole station database to fill the data in.

2.4.2 Train overview
2.4.2.1

General

In this window all found trains, train parts and interval groups are shown to controll them. So
you can check the data if all changes to other lines are made correct. This check is important
to create correct timetables and circulation plans.
Changing data can only be done in the graphic timetables. After comeback to this window
the Train overview window is updated automatically.
The lists can be sorted by every coloumn ascending or descending.
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Register “Trains”

2.4.2.2

The departure time at the first station and the arrival time at the last station are shown to you.
So you can copy the first and the last station to all fpl-files in which the train runs to show this
data at the graphic timetable. Marking all relevant trains and using the context menu can
make this. The item there sets this data to all graphic timetables, which are relevant.
Register “Train parts”

2.4.2.3

Here you can see detailed data of every train part to controll them.
Register “Interval groups”

2.4.2.4

The register shows all known interval groups to controll theire correct run. If there is no
inteval group to be found here you are not able to create an interval graphic.

2.4.3 Stop time overview
The appearing window shows you trains, train parts or direct links which have stop times
higher than the defined figure and lower than the other figure. To control the contents of the
window you select to see trains, train parts or direkt links.

2.4.4 Overview of driver’s timetables
This window shows you all trains inside of the network and gives you the title and the page
no. which is defined as first page inside of the existing network object. So you can check
whether every train has an driver’s timetable.
If some trains are running in intervalls you can also see whether a driver’s timetable is given
by another existing driver’s timetable or not. This way you can also check which driver’s
timetables have to be created to make sure that every trains has a driver’s timetable and you
did not create to much of them.
The button check for update shows you whether you have to do an update for existing
driver’s timetables or not. The button show unrequired driver’s timetables lists you all the
existing timetables which have no train inside of the graphic timetable.
It is possible to copy the list into clipboard and to use it in other programms for further details.

2.5 Options menu
2.5.1 Configuration
or Ctrl+K
Here you can set default values for creation of network objects.
2.5.1.1

Register “General”

To be shown at headers or footers a general logo can be set here. Only bitmap-files (*.bmp)
can be used as a logo.
To be able to offer you differen functions by a double click at the list of line files you can
define here what should happen.
2.5.1.1.1

Part “System”
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To use an automatic save function you can switch it on or off here and set the period to save
the file. Please do not use this function any longer. Some trouble might appear by an
automatic safe during opened windows or during train handling and so on.
You can also set here the Number of undo steps. All existing objects and iPLAN itself
reserve per step 100 kB in your RAM. That means if there are 5 elements and 3 number of
undo steps configured, you need (5+1)*3*100 kB = 1,8 MB. So be carefull by raising the
number of undo steps, because the used RAM space increases unknowingly by creating a
new object. (Every driver’s timetable is an own object!) The steps inside of the edit table
function in costumers’s timetable are included in the steps of this customer’s timetable. If you
choose more steps take care of more required space to keep the steps in the RAM of your
computer and so it can take more time to calculate one step. Look also at part 2.2 at page
12.
2.5.1.1.2

Part “Elements in graphic timetable window”

You can also select a Horizontal or a Vertical scrollbar. At small displays you might blank
the scrollbar to have more space for the timetable.
There can also be settings done here for further informations beeing shown in the status bar
at the bottom of a graphic timetable. Select here the informations you would like to see there.
2.5.1.2

Register “Public holidays”

To define public holidays which should be handled by FBS you can Add or Delete here days
into a list of public holidays. Fill in a Description and a fixed date or if it is not possible a
predefined non-fixed holiday can be calculated by the programm. Please do not forgot to
define which base calculation should be used for the calender.
In some cases it is not necessary to know the current public holidays so you can fill in
Default settings for statistical year. Here you can define the number of days the statistic
year includes. So you can add the numer of public holidays then or the number of sundays
and public holidays, saturdays and monday to friday without public holidays. This settings wil
be used for default calculation of statistic year in the network statistic.
2.5.1.3
2.5.1.3.1

Register “Graphic Timetable”
Part “Train lines”

If you select the Radius of points at arrival and departure as 0 no point will be drawn. We
advice you to use 2 points to differ trains that stop from trains running through.
By activating Draw standing lines while stopping a line is drawn between the arrival and
departure time of the train. So you can see, that a train stands in the station. If some trains
stop in the stations the lines are drawn one over another.
2.5.1.3.2

Part “Time scale”

With Interval of time lines you can select the time lines shown in the graphic timetable for a
better orientation. Default interval is set to 10 minutes. The intervals can be changed in steps
of 5 minutes.
For a better orientation you can also Stress full and half hours in the graphics. Clock hours
get a fat line and half hours a thin continuous line.
By activating Repeat times at mouse pointer a little box is shown close to the mouse
pointer which includes the current minutes and tenth of a minute at which the pointer is
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situated. If Windows® starts another action during iPLAN draws a new arrow the box does
not disappear. This can happen from time to time and is not critical. These “ghosts”
disappear if the graphic is painted again. If you do not like these ghosts or you will get too
much of them you can deactivate this option. The time is also shown in the status line below
the graphic.
2.5.1.3.3

Part “Change departure times”

If you use the function Construction > Move departure times you can move the preview
line by help of the cursor keys every tenth minute. This way is precise but takes a lot of time.
Departure times are normally used at special tenth of a minute, for example x,2 or x,3. The
departure time is published by a rounded down minute so that your crew has the rest of the
time to close the doors and start the engine.
So you can configure whether all tenth are allowed as departure times or the mouse position
by moving departure times is changed to the number set here.
2.5.1.3.4

Part “Colours”

You can set here the background colour and the colour of timelines and time scale and
the station lines and timetable header. Clicking the quadrate in front of the label can
change the colours. These settings are also used for the prints. Normally the raster is painted
in orange. Some defined colours are a free set colour can be used for all the colour functions
here. The colour is selected by a click in the boxes there. The brightness can be changed at
the bar on the right. At colour/basic you can have a preview to the colour. The button Add
colour amended the colour to the user-defined colours.
2.5.1.3.5

Part “Labelling of trains”

These settings are made to get the position of the train label at the graphic timetable. You
can set the relative position to the mileage the train runs.
Delete background makes a better readability.
If Recalculate angel after moving of label is activated the angel of the label is calculated
again after moving the label. Otherwise the calculation of the angle is online made by adding
the train to the graphic timetable.
2.5.1.3.6

Part “Minutes at train line”

Here you can set to Delete Background for a better view to the time information along the
train line.
2.5.1.3.7

Part “Automatic train number indication”

During the construction of your timetable a small window close to the mouse pointer shows
all trains which are near the pointer and which one of them can be selected. Here you can
set the situation in which the window shall be shown (look at chapter 3.2.2.3, page 28).
2.5.1.4

Register “Driver’s timetable”

By creating a new Driver’s timetable iPLAN uses the settings of the last Driver’s timetable,
which exsists in the file. If there is a Driver’s timetable marked his settings are used for the
new one.
You can set a default format in this window. All useable formats are shown in the list. It is
difficult to change from one format to another one. So please be careful by selecting the
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format. If you choose the option to select the format during the creation of a new one you will
get a window, which asks you for the format.
All other settings related to a Driver’s timetable are made inside the object.
2.5.1.5

Register “Circulation plan”

You can set here the Frame colour in your circulation plans. So you are able to modify the
colours of the circulation plans to your one wish. The frame colour is also used to mark 0, 6,
12 and 18 o’clock.
The colour of the other hours can be set by Colour of the time lines.
For better overview guidelines can be drawn between the single jobs a vehicle has to do.
These lines are drawn if the check box is set. The colour can also be changed at the colour
box.
The maximum running interval for centric display of direction reversing stations in
minutes can be set here. This time has to be free to show all abbreviations along the
circulation day. If the break is shorter than the time set here only one abbreviation is shown
to get a better overview in the circulation plan.
To get the right minutes to be shown in the circulation plan you can choose here the
Rounding rule for new circulation plans.
2.5.1.6

Register “Customer’s timetable”

Customer timetables are printed and given to your customers so you can avoid incomplete
train columns. So you get a better view of your timetables, because all train columns
orientate on the right border of the page and the left space is given to the station column.
The size of the station column as set in Register “Layout & content Part “Table at page 99
shows only the minimum.
It is also possible to Fill last chart with empty columns on the right. So all charts have the
same size and no free space is shown at your timetable pages. If you deactivate the box the
empty columns are not shown so that you can use this space for legends or promotion or
something else.
To get your own colour scheme you can set here the Standard foreground and
background colour. The background colour is only used for showing the timetable on the
screen.
2.5.1.6.1

Part “Standard for new timetable charts”

Here you can set the general design of the graphic timetable. You can use the Hot type or
Photosetting face. The hot type is the older design. Both designs are defined in UIC no.
411.
The following aspects depend on the switch between hot type and photosetting face:
 The headline of the table is set in hot type in the centre and in the photosetting on the
left. In photosetting there is a frame set around the headline.
 The headline of the table consists of three lines in photosetting and two lines in hot
type. So in hot type train code and train number have to be placed in on line and in
photosetting in two separate lines. In photosetting all train headcodes are shown and
in hot type only them for important trains (the trains with short train numbers).
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 Headcode, train number and general train informations are shown centred in hot type
and right aligned in photosetting along the train column. This is also for horizontal hint
texts inside the table.
 In hot type there are shown arrows between the two-neighbourd departure and arrival
times in the station column on the right. In photosetting there is only a symbol shown
in lines, which include only the arrival times.
 The line style of table lines changes at different positions in the faces.
To show the Railway administration and their Logo you can fill in the name and the logo as
a Bitmap file. If you would like to show only one of them keep the other field clean.
2.5.1.6.2

Part “Highlight times in bold print”

To mark trains, which are important you can fill in the train types here. So iPLAN prints this
trains in bold. Separate the categories with comma and no blanks in the whole line.
2.5.1.6.3

Part “Show train category”

The train category is shown in the headline of the timetable. Here you can select, which train
categories should be shown. You can choose between all or no train categories or only for
special trains as written in the line following trains. Please separate the categories by
commas and use no blanks.
2.5.1.7
2.5.1.7.1

Register “Customer’s timetable symbols”
Part “General symbols”

A double click allows you to change the symbols in both timetable designs for the following
entries:
Symbol for

Photosetting

Hot type

Empty entry

...

Passage

|

|

Arrival (at the station column if the whole line shows the
arrival times or before the time if only this entrie shows the
arrival time)

o

an

Subject to supplement

:

:

Diversion (train uses another line)
Restriction of traffic

Railcar
The points for empty entries in hot type are used for keeping the line by reading the
schedule. The useage of this helpful symbol is also recommended to the photoseting like the
different symbol for passage a diversion.
By creating the customer’s timetable iPLAN searches all timetables and sets the railcar
symbol, if the train consits only of railcars.
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Yourself can change the symbols by a double click at the line you
would like to replace. A window opens, which allows you to set the
new symbol or text. You can also use here the Special characters
as defined in FBS programme familiy.
2.5.1.7.2

Part “Replace the following categories by symbols”

You can define here train categories, which have an own symbol for corporate design. A
double click opens a new window, which asks you for the name of the train category that
should be changed or replaced. After the Ok you will see a window to exchange the symbols
for hot type or photosetting. By creating the customer’s timetable iPLAN replaces the train
cateogries by the symbols. The

buttons give you the possibilty to add or erase train
categories from the lists. The settings here are saved
and are reloaded again.
2.5.1.7.3

Part “Mark as subject to supplement”

To show the trains, which can be used only by paying
a supplement, you can define here the train
categories, which should be marked. If such a train is
found during creation of the Customer’s timetable all
entries in the table get the symbol, which is defined
before the entry.

2.5.2 Button bar
Ctrl+L
You can hide or show the standard toolbar to save space or to get faster access to these
functions.

2.5.3 Language
Ctrl+Alt+L
All useable languages are shown in a dialouge window. You can set the new language only
for this session or as default. Please note, that some functions will not change theire
language during the programm is open. The best way to make sure, that all parts are
translated is to save the new language as default and close and reopen the programme.

2.5.4 Reset splitter
This function resets the splitter in the global network window. If you moved the splitters to get
a better overview to special parts of the window you can reset the position of the splitter.

2.6 General object functions
2.6.1 Object preview
If this button is pressed the network graphic on the left of the window disappears and a
preview to the selected object is shown to you. This may help you if you have a lot of objects
in your file. If the objects consist of more than one page only the first one of them is shown.
Driver’s timetables are even shown in portrait and circulation plans are shown in landscape
size of a paper. Customer timetables format depends on their last setting.
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2.6.2 Sort objects
As default the objects are shown in the row of their creation. You can change this
row by using the mouse buttons. If you click at one of the buttons the object moves one
position up or down.
You can also sort the objects automatically by name and type or by type and name.

2.6.3 Measure distance

This function opens a window, which lists you the distances between
a selected station and all other stations inside the network. A station
can be selected by a click inside the network graphic.
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3 Graphic Timetable
3.1 Getting a new graphic timetable
You have several ways to define the path of a graphic timetable you would like to see in
iPLAN.

 First option is to select a line file and use the context menu there which allows you to
open the graphic timetable of the file. This is not the best option to get a graphic
timetable because most of the trains might not be shown in there whole runway. So
you might not be able to check and edit them completly.
 Second option is to use the button new graphic timetable. If you have not more than
10 line files in your network you can also open them here.
 Third option is to open a graphic timetable by
defind the runway in the network graphic. This is
explained at 2.1.5 at page 11.
 Fourth option is to open a graphic timetable for
an existing train. If you call up this option you get
a window which shows you all found trains in
your network. You can select a train from the list
there. You can also limit the number of shown
trains by filling in a head code and/or the first (or
all) figures of the train number. After that you
can define whether you would like to Create
timetable for the whole
route of the train or
Create timetable for a
section of the train’s route
only. You also have to set
the option to Insert graphic timetable into object list or
Create temporary graphic timetable. If you would like to see
a section of train’s route only a second window appears. At
which you can select the part of route. Please make sure that the
first and the last entry you marked is a train order change place
like a station.

3.2 Edit Menu
3.2.1 Add a new train...
To add a new train you have to choose the direction the train will take. After that you
can select the from station and the to station by a list. This list shows all stations marked
as Train home station. Then you have to fill in a departure time. iPLAN uses the next free slot
after the departure time you filled in. All settings made here can be changed later except of
the direction of the train.
If you miss a station in the list it is not marked as a train home station. If it is only one train,
you can use a station before and change the real start station in the train data window at
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point “Train is route sections” (look at chapter 3.3.7, page 56). You can also change the
station settings in the infrastructure window.
It is possible to copy train data settings from one train to another. To do this select the Copy
train data from box and choose one of the existing trains. You can also copy data by a train,
which takes the other direction, but please change in these cases at least the speed list in
the train data window. The new train is added by button Ok. The Train data window opens
than (chapter 3.3.10.1, page 57).

3.2.2 Call up a train...
3.2.2.1

…by menu

This way is the safest but the longest too. Choose the menu edit > Call up a train… and fill
in the head code you would like to edit. If two trains with one head code exist in your file the
one starting earlier is called up. It is possible to use the same head code again and again but
it should not be done. The same function can be used in the mouse menu called up with the
right button. The current head code is shown in the footer.
3.2.2.2

…by mouse click

You can select a train by click on the train line. The footer shows the current head code
which will be opened if you click. To use this function the button leftmost in the headline hast
to be pushed.
The opposite picture shows you the general connection between the mouse position and the
train, which will be chosen. The picture shows you a typical train crossing. The vertical in the
middle is a station line. If you click in one of the sectors up left or
downright, the train arrival 54/departure 00 would be selected. A click
down left or up right would call up the other train arrival 57/departure 58.
Please note: If you click at a position amount the minute 54 on the right of
the station line, the second train would be called up whether the train arrival
54 is closer to the mouse pointer! So respect the station line and the time to
select the right train.
The advantage of the principle is shown you in your daily work: If you would
have to edit some trains in a short time it is difficult to hit train lines exactly. If you internalize
the sector principle you can work fast and intuitive.
3.2.2.3

…by mouse click and some trains close together

During your timetable construction you might be interested to see a long period on your
screen to have a good complete picture. At the same time the train lines move close together
so it could become difficult to click the right train line. In this case a yellow hint window with
the possible head codes will be shown. This window can be configured the following ways:



The window is shown, if there is more than one train near the mouse,



The window is shown, if trains lay over each other (they occlude them self)



The window is not shown in any case.

If you keep the shift key pushed and move the mouse the window is shown in every case
also if there is only one train close to the mouse pointer. So you get a fast orientation if you
are not able to see the train information at the train line.
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By a left click a menu opens in which every train close the mouse pointer is shown to select
or to select. If you click a head code on the upper part the wished train becomes the current
train. This way means more clicks, but it ensures that you get the right train and do not have
to click again and again the wrong train.
If you would like to do any mouse action with one train (e. g. Change departure time,
chapter 3.3.3, page 55), and some trains lines are close to the mouse pointer you can select
the right train by Alt key. The edit action is done with the first train in the yellow window. The
order changes by every use of the Alt key. It is also possible to do this if the yellow window is
not shown.

3.2.3 Edit several trains
3.2.3.1

Selection of trains in the window “select trains“

This window lists all trains, which exist in the file. You can select trains, which you would
like to edit in common. A fast selection can be done by the following functions:
Button to select all trains
Button to deselect all selected trains
Button to invert the selection
Button to select all passenger trains
Button to select all freight trains
Button to select all trains of one train type
Button to select all trains belonging to an interval group
Here you can change the sorting of the train list.
If you selected trains by train type you can mark some train types by repeating this function.
Inside of the list Select trains the typical Windows®-standards are useable. Some trains can
be selected by mouse click while Ctrl-key is pressed, a complete area of following trains can
be marked by Shift-key and mouse click.
By interval traffic the interval groups allow you the
following possibilities:
You can sort trains by direction or interval group.
You can select all trains with the same interval
group. So all trains belonging to the same interval
group to which the current train belongs are
selected.
Tip: If you select a train, which does not belong to
any group and use the all trains with the same
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interval group, all trains without an interval group are selected.
 A double click at a train number in the “Select trains” window the graphic timetable moves
so that you can see the train.
3.2.3.2

Selecting trains by click in the graphic timetable

 Single-click: selects one train (look at chapter 3.2.2, page 28)
 Double-click: opens the train data window (look at chapter 3.3.10, page 57)
 The Ctrl-key kept pressed and clicked at some trains after another. You can let the key
go between two clicks.
 So far as you selected some trains the other trains are shown grey. The function can
only be used if the mouse mode Select trains is active. Clicking another train without
pressing the Ctrl-key can stop the selection.
3.2.3.3

Edit some trains

By click at this button in the symbol line you can use the following functions:

 Edit data for selected trains: look at chapter 3.2.3.4, page 30
 Copy selected trains in an interval: look at chapter 3.3.12, page 69
 Move selected trains parallel: look at the chapter 3.2.3.4,page 32
 Park trains: look at chapter 3.3.10.6, page 69
 Delete all selected trains: deletes all trains after a safety question
 Finish multi section: deletes the current selection and closes the mouse menu
The last used function is shown as shortcut next to
3.2.3.4

.

Edit data for selected trains

This window stops the troublesome editing of every train to change train or label data. Select
only the options, which should be changed for all marked trains. Use this function with care.
Undo of accidental changes can be difficult. ( Is the Undo-Function active? )
3.2.3.4.1

Register “General train data“

3.2.3.4.1.1 Part “Train category and non-linear supplements”
This part allows you to assign train categories and to check the supplement times depending
on train category.
3.2.3.4.1.2 Part “Run time / technology”
You can assign new input data to driving dynamics (maximum speed, load, run time
supplement, load supplement or brake percentage. So activate the cell and fill in the new
value.
Changes in this data although changes the run time calculation, so all run times have to be
recalculated. This is only being done if you activate the function in the part of the window.
iPLAN reminds you to this problem.
After that, the trains have new run times, but they are not changed in the graphic timetable.
This will only be done if you click the function “Search new slot for all selected trains” or you
do it manually. This function can change the complete picture of your graphic timetable
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because the relations between the trains can be changed. Try to appreciate the result to your
timetable and decide by yourself to do the slot search automatic or manual.
Finally you can change reference lists for the selected trains. This might be helpful if track
works will start or the traffic input data changes.
If you change the train type it is normally needed to change the reference lists too. You can
adopt the stop times list, the line speed list and/or the station track list.
3.2.3.4.2

Register “Train parts“

This register allows you to change train data for train parts of some trains. So select at first
whether the changing is are valid for the first train part at each section only or for all
train parts of the selected trains.
You can change the operation days or although the line name. It is also possible to replace
an old engine series by a new one in every train part. It is better to activate the function
“recalculate run times” in the general train data register, because of different engines data.
All coaches and waggons can be cleared to block engines runs. Especially by composite
freight trains you can change the maximum speed, the load and the train length. The fields
are filled by the current data if you activate the box to change the data.
3.2.3.4.3

Register “View data”

During the timetable construction it can happen that a train label is not to be found directly at
the train line. To sort them again you can recalculate the position and the angle of all train
labels. The position of the label is set in the configuration. But labels can be positioned this
way that you cannot read them completely. So you can move the label manual (look at
chapter 3.3.2, page 54) and activate here Recalculate angle for all train labels at actual al
position. This function might be used at finishing your graphic timetable to get a better view
of your timetable.
You can change the Colour of train line and the
Type of train line differently from the standard. So
set the check mark und choose whether the
parameter should be set by type of train or
manually. If you choose this option a list opens
and shows you the possible formatting.
The part Content of lettering of selected trains
allows it to you to change the informations shown
at the train line. You only have to activate or
deactivate them if you like.
The typeface is only changed if the typeface window was opened at least one time and
closed by Ok. The line number is only set to the labels if you changed one or more of them.
Typeface button and line number are shown bold if they will be set new (as to be seen in the
graphic above).
The train labels in the graphic timetable should be written in TrueType- or OpenTypetypeface, because typeface, which do not belong to this groups, are not shown inclined in the
graphic timetable by using some Windows®-Versions.
3.2.3.4.4

Register “Remarks and other is”
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This register makes it possible to change remarks to the trains or to set a Far-distance route
(a route which is longer than your line) and construction remarks. Just an example:


You calculate freight train slots for different Train Operating Companies. If you have only
slot query and not orders you should use the state planned. At the day you get the orders
for the slots you can select the trains and set the current construction state to “to be
processed”.

3.2.3.4.5

Copy trains in an interval

This function is explained in chapter 3.3.12, on page 69. Here the function is used
automatically to all selected trains.
3.2.3.4.6

Move selected trains parallel

This function moves all selected trains at an interval. So you can calculate a model timetable
for your line. At the time you know the connections at a station exactly you can move all
(selected) trains at an interval to get better connections. The interval time has to be filled in
by the typical FBS scheme. This function also releases no slot search.
 A movement of 90 minutes has to be filled in like “1.30“ or ”130“!
3.2.3.4.7

Park trains

This function is already explained in chapter 3.3.10.6, page 69.
3.2.3.4.8

Delete all selected trains

This option deletes all selected trains. A question helps to block operating errors. To undo
this function you have to activate the undo function in configuration.

3.2.4 Interval groups
This way a window opens, which shows you all existing interval groups and the trains
belonging to them. Here you can fill in single trains or dissolve out a train from group.
Additionally or later you can collect groups together or collect single trains to a group. So
look at the right button menu at the list.
A double click or enter at the current
interval group another window opens. The
table shows you all trains belonging to this
group. The column Offset includes the time
distance between the current train and the
first one of them. The trains are shown in a
row starting with the train after the largest
gap (normally it would be over night). The
button Recalculate offset
helps you to
get the trains in order again. The train after the largest gap gets the offset 0 and then the list
starts. This train is now shown in all window related to the interval groups.
If you would like to Renumber trains or bring mixed train numbers in a row again you can
open another window by the button
. Here you can define the train number of the first
train and the offset to the next train and the consequences to the train part numbers.
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During the timetable construction arrival and departure times can be changed. The column
Ok includes a cross if the train passes exactly to the group. The tolerance of interval times to
get the x amounts ±1/10 min.
By clicking the arrow a train list is added to the window
which includes all trains that could belong to the
interval group but do not belong right now. The
tolerance in this case amounts ±1/2 min. If there is
now train shown in the left list (new, clean interval
group), all trains shown on the right could belong to
the group.
Please note, that the interval groups can be evaluated
at an interval graphic in NETZ programme (look at
chapter 7, starting at page 130). So the interval time is
only shown if the intervals are “clean”, that means all
interval times between the trains have the same range.
It is possible to adapt changing is in the interval
graphic after changing is in the graphic timetable.

These buttons allow you to add or erase
trains to an interval group.
Please note the following specifics to work with trains in interval groups:
If you move a train line label of a train belonging to an interval group by mouse there is no
question to adopt these changes to the other trains. The labels of all the other trains are
adopted by time or data changes in the interval group. If the labels of all trains in the group
should get the same relative position you can do this by “apparently” changes of train data or
train times.
Removing a single train is not related to other trains of the group. If you remove an interval
group by window Edit > interval groups the trains are not eliminated. To remove all the
trains belonging to a group you should select them by multiple selection (Window Select
trains > Select all trains with the same interval group > Delete all selected trains).
If you edit arrival or departure time is manual (window show arrival and departure times) it
has no influence on a possibly existing interval group. Instead of this time changes you
should use non-linear Supplement times (look at
chapter 3.2.11.3, on page 47).
Set train messages
This function is adjusted to the German operation
system called “Zugleitbetrieb”. It is a simplified
system for lines with less traffic. If you call up this
function you can assign every station or location
train messages. So select the stations or
locations, which use the same principle for train
messages. The selection can be done in the
Windows®-logic. After that you can assign train
messages differed by the shown possibilities.
Train messages can be assigned to the train
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driving the other direction or the trains
the reaches the station first.
To configure the situation train crossing
in all existing possibilities the button
Crossings opens a new window. The
four special cases are written here and
the time parameter to recognize these
situations automatically can be changed.
If the parameter is 0 this crossings are
not checked and if it is 1440 min (=24 h)
all crossings are respected.
If such a case exists, the train messages
are automatically given to the trains. The
messages can be differed by the
direction.
The function sets this train messages to
all existing trains in your timetable. If you
add new trains later this trains do not get the messages automatically. So the best way to
use this function is to call her up when all trains are filled in. The messages set here are
automatically filled in the driver is timetable made in NETZ-program.

3.2.5 Change drawing order
Train lines and informations can lay one upon the other. The following trains overdraw the
existing trains. This has a great influence to the labels. Take care that all the train lines are
painted first then all the labels are drawn in the same order. So the labels are ever on top of
the graphic timetable. The changes act to all trains been marked.

3.2.6 Continue running from another line…
Trains often change from one line to another line. This train helps you saving time to fill in all
train data. It also helps you to start trains at junctions not earlier as they arrive at the junction.
Call up this function by the timetable in which the train should continue running. The file,
which includes the train, has to be opened too. You can choose to Continue train route or to
Copy train data only and insert a new train. By using the last option you can also start the
train at another station and not at the junction. If the train number you would like to copy is
used iPLAN shows you a message. It is made to get a clear identification of the train. The
information is related to the station track are set by the new line. The complete function can
also be used for interval groups. If you change train data (stopping times, speed lists, …)
they are also changed for all trains in the group. Only the changed data are copied to the
other trains. Different operation days or something else are kept alive.

3.2.7 Adopt trains from another line…
An extension of the function explained below is the function to adopt trains from another line.
If a line section exists in two files you can copy all trains you calculated in one file into the
other file. This function might be helpful at line section near stations with a lot of traffic.
The file, which you use to copy the trains from, has to have in at least one section the same
stations and locations as the file you want to fill them in. It is possible to have more stations
in the original file as in the copy file but not less than the copy file.
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Adopted trains can be deleted or hide completely. The common erase function is helpful if
you would like to readopt them again. This might be necessary if you change data in the
original file.
If you hide the adopted trains they are also respected at slot search. The hide function helps
to get a better overview.
Trains, which are adopted from other lines, cannot be edited. You can change only the labels
of them.

3.2.8 Blind out adopted trains
Blinding out trains makes them invisible. The trains are anymore included in the graphic
timetable and respected by conflict search or evaluations. Recalling these functions makes
the trains visible again.

3.2.9 Delete adopted trains
If you want to delete all the trains you adopted into the graphic timetable you can do it by
using this function.

3.2.10

Infrastructure data

Or Alt + S
3.2.10.1 The Profile Diagram Window
You can have a look at the different line speeds, the gradient profile, the curve
profile or the tunnels along the line. To open the diagram window use the profile-button in
the infrastructure window. The shown lines have to be marked in the list to be found behind
button lines. The different profiles are shown in one
diagram so that you can see differences in different lists
easily. The stations are shown with their abbreviation and
the line style defined in the stations & locations register. If
you mark a line point in one of the lists a green line shows
this point in the profile diagram window.
The colours of the different lines can be changed by click
on the lines button and the right mouse button at the line
you wont to change.
The profile diagram window can be changed in its size. You can export the window to the
clipboard, save it as a bitmap or print the window by click on the export button.
3.2.10.2 Register “Zones“
3.2.10.2.1 Part “Kilometre zones“
To manage all the line data iPLAN needs a relative distances. That means: every information
has a relative distance to the first station. So the relative distance starts with 0 and increases
linearly to the last station.
The mileage or kilometres shown along the line often have different numbers to the relative
mileage. Just an example: to fasten the trains some curves are rebuild, so that the lines
becomes a closer straight way. The mileage along these changes will be adapted but the
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rest of the line is not touched. So the mileage can change, “jump” or decrease. FBS assists
the absolute mileage too.

 Absolute mileage or distance = position of the milestones along the line
 Relative mileage or distance = real distance of one point along the track to the first
station
You have to define the mileage zones before you start filling in the infrastructure. The
mileage zones cannot have gaps between them and must be sorted by the real (absolute)
mileage. The jumps or directions can be changed like you need it.
If the absolute mileage is identically equal to relative mileage you can define on zone starting
at 0.0 and increasing mileage.
To fill in a new zone bring the cursor to the first free line and press enter. An assistant is
opened and helps you defining and sorting the new zone into the existing mileages zone
system.
Only the delete button at your keyboard can delete the last mileage zone.
3.2.10.2.2 Part “Tariff- or recordation zones“
A lot of statistic results are not limited by milestones but political or administration. One of the
zone limits can be a border of different states.
You can define up to 16 zones with the button number of zones. These zones are shown
behind the remark column. By double click at the title line you can give the zones a name.
Zones can be:

 States, departments, districts, …
 Traffic management organisations.
Now you can define mileage zones in the mileage point is column and set a cross by click in
the zone column.
These zones can be evaluated in FBS statistic functions for the whole line or single zones.
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In this example you can see a section beginning at mileagepoint 0,000 belonging to
“Sweden”. All data behind the relative kilometre 129,200 belongs to the section “Norway”.
The remarks are just for your information and can be used as free text.
3.2.10.2.3 Cab radio zones
Cab radio zones are shown in driver’s timetable to give the driver the information for cab
radio. You can define cab radio zones here and the will be filled in the drivers timetable
automatically. A double click makes a cab radio zone for the whole line. So it helps you that
the cab radio zone information do not have a gap along the line. If you click an empty line
below the existing zones an assistant will be opened and leads you through the define
process. Fill in all the data. The use of the data depends on the driver timetable layout. Hints
for example are not shown in every layout. The remarks are only for your information and are
never shown in the driver timetable.
3.2.10.3 Register “Classification”
This register saves the global information to kind and properties of the line. These settings
can change at every mileage along the line. Some properties normally change only in the
middle of a station (e. g. class) but other can change also on between the stations (e. g.
owner, start or end of rack).
In many cases you can select the information out of a list but you can also enter free text. It
is planned to do cross checks for some properties to block illegal combinations. For example:
the electrification system and the equipment of the engine. This cross checks can only be
done with the FBS proposals.
If you miss zones, figures or rules please call the service. We will include the data in one of
the next versions.
Here you find some explanations to the properties and kinds:
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Relative and absolute mileage point: look at the instructions above (register zones).
Line-Number: The line number
design is X.Y.Z, by: X: UICNumber
of
the
railway
infrastructure company, normally
two-digit, Y: rather line number,
unique
in
the
railway
infrastructure
company,
Z:
optional track or part number to
differ
separated
graphic
timetables if there are more then
two tracks.
A double click into the field opens
an assistant with a special help to
find out the right UIC-Number.
Gauge: This setting is important for run time calculation for the calculation of the curve
resistance if curves are filled in. Default gauge is 1435 mm / 4’ 8,5“.
Another assistant helps you to fill in Legal provision (legislative nation and the exact law),
classification of the line (e.g. main or branch line) maximum axle load and load spreading.
Owner: (abbreviation of the railway infrastructure company). This field is only for information.
You can choose it also by UIC-Number.
Distance-keeping: At first choose the principle to keep the distance between the vehicles:
View distant operation: This method is typical for trams or busses. FBS does not control the
distance between the vehicles. This job has to be done by the user.
Time interval operation: You can choose this operation type but FBS does not support any
function for it.
Space distant operation: This method is typical for railways. At the moment you can use only
fixed blocks.
Train protection and cab signalling: Additionally to the distance-keeping method you can
set a train protection and cab signalling system. These settings are needed to calculate the
correct run times by some train protection systems. It is possible to fill in some train
protection systems for one zone.
Regular distant signal distance: The regular distant signal distance means the way
between the distant signal and the main signal. Please enter this fact exactly because it has
a great influence to the break phases in run time. The break phase handling by planned stop
expect signal is at the moment implemented.
Electrification: The details to contact line voltage and so on are explained here. These facts
are necessary to choose the right engine diagrams for multi voltage engines. FBS warns you
to use an engine, which does not belong to the electrification data you filled in here.
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Others: At the moment you can enter remarks or rack sections or train control sections. The
rack sections are used to select the right engine diagrams by mixed rack-wheel and
adhesion engines.
At the moment the gauge information is the only information used for calculation. All the
other informations do not have any influence to the FBS scheduling. Take care if you would
like to exchange the data by data interface this facts can be important. The data can be
shown in the head of the graphic timetable, if you are interested in. Furter details to this
function can be found in chapter 3.2.12.3 (Register “Header of timetable”) starting at page
51.
3.2.10.4 Register “Stations & Locations“
You can move the active field by cursor keys
on the keyboard. To edit the field use enter.
To fill in a new station or location use the
button. A dialogue window opens and here you
can enter the name, the abbreviation and the
position. If there exists a station and location
database you can fill in the name by choosing it
with the abbreviation. You can also search the
station or location in the database by complete
name. You have to fill in the location.
Every location has an exact relative or absolute
mileage (look at chapter Part “Kilometre
zones“, page 35). The absolute mileage is being calculated by iPLAN in using the defined
mileage zones.
The absolute mileage is shown in the head of the graphic timetable. If the absolute mileage
changes in the station or location you should position it at the beginning of the new zone.
You can use three ways to locate the station or location. The relative mileage is the fastest
way if you now this fact. Normally you will use the absolute mileage. So you have to enter the
mileage and the zone in which this mileage is situated. (A mileage can exist more than one
time in a line!) This way can only work correct if there are no gaps in the mileage zones. A
comfortable way to position a new station or location is a relative mileage to an existing
station or location. Take care of the before and after possibility.
If you change the relative mileage the new absolute mileage of the station or location and the
mileage data of the tracks in the station are calculated by iPLAN. So the whole station is
being “moved”. If you change the absolute mileage the relative mileage and the position of
the station tracks does not change.
It is possible to enter stations, which have a negative relative mileage. All stations and
locations are moved by iPLAN so that the first station gets again mileage 0,0. Take care, that
such a station is a block stop with loop.
For fast scheduling you should enter all stations before you start filling in trains. If you have
forgotten a station you can edit her also then but all trains will pass this station without a
stop. So it is possible that you might have to change many trains.
To do get correct train sequences it is important to give the stations and locations the right
properties. iPLAN differs between operational, customer and other properties.
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The first and the last points of a line have to be stations. You can change between single or
double track only at stations. Please define a halt also as a station. Trains can only begin or
end in a station not at a halt.
The column stop should be filled with a “T” like terminal if it is a bigger station or a junction.
This information is needed if you export the data to a crew rostering program or to customer
information system this data can be needed. This information also help you in the NETZ
program of FBS family. All stations and locations being marked with “T” are shown to you as
potential start or end station if you create a new train. You can set the “T” by double click and
click to “Train home station”. This window allows you to set general stop informations.
Seldom used halts can be marked as a stop by request to mark it in the customer timetable.
If all stops at this point are only without passenger change or cargo handling for example to
change the crew you can mark them as an operational stop.
At the righter sight of this window you can set default messages given by the train crew to a
dispatcher. It is possible to set default messages only in one direction.
If there are still trains in the graphic timetable FBS asks you what to do with this trains and
the edited station settings. You can also change this data for all existing trains in the graphic
timetable. A stop on request is only set for trains, which consists majority of coaching stock.
If the stop time is longer than 0,5 minutes the stop is not kept as a stop on request.
Hint: You can set the stop on request information also to trains, which pass the station
without a stop. So you can use the gain of time by stop on request halts. Please use this
function only if these trains have a train type speed restriction at this stations or the first stop
on request has a stop time.
The number of tracks can be chosen between 1 and 2 and change only at stations. At
monotrack lines train crossings can only be done in stations. A double track line is divided in
two monotracks with one direction. It is possible to use the double track tracks in both
directions. You can define it at the train settings. Lines with more than two tracks have to be
divided in several files. Good experiences are made this way in great stations. The
combining of tracks in NETZ is not trammelled by this method.
Line column sets the line style of the station or location in the graphic timetable. The current
line style is to be seen in this column for every station and location. If there is no preview to
be seen so no line will be drawn. Maybe you should modify these settings before printing the
graphic timetable. The line style has no influence to the run time calculation.
At the point of intersection of a train line and a station line the arrival and/or departure time is
shown. You can choose the time, which is shown in column Arr/Dep by, double click. It is
also possible to shown nothing to get a better picture.
At short stops regularly the departure time is shown. To save pace the arrival time does not
need to be shown. So you can choose a setting Dep., >1 min Arr which shows automatically
the arrival time if it is more than one minute earlier than departure time. The function >1min
Arr.+Dep is designed for stops at e.g. home signals if there are sometimes operational stops
needed. The arrival and departure times are shown if the difference between them is greater
than one minute.
The column allows you to select a font size for the times. 8 points are normally used at
important stations, 7 points at normal stations and 6 points at stops.
The pre and post-occupation time (tPP) of a station or locations is an additional time to the
blocking time. This time is needed to change the routes so it is additionally needed between
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two trains driving one after the other. The times can differ so that there exist two columns
one for each direction.
The crossing time (tCr) (also known as direction changing time) means the time, which is
needed between the arrival of one train from one direction until another train can enter the
same track in the other direction. This time is only needed if you (regularly) use tracks in both
directions. Because of possible differences between the directions there are also two
columns for the direction of the first train, which enters the station.
At a first glance one or two minutes seem to be a lot of time. But these times include the
running times to pass view distances, safety distances or safety overlap and reactions times
of man and machine. The back blocking of an automatic block signal is of course finished in
some seconds but Please note that the following trains should have enough space to the
distant signal of the next block signal so that the engineer does not start breaking. If there
are train protection technologies installed they also might force the train to break to a lower
speed. This case should not be included
in a timetable.
The column station tracks are
explained in the following chapter
3.2.10.5. We suggest you to fill in the
station track informations after the line
speeds.
The button create abbreviations opens
a window to bee seen on the right. FBS
is able to create the abbreviations by it
is self. You can choose three ways: The
first one creates abbreviations for all
empty entries with conditions. The
second way checks the uniqueness of the abbreviations and changes them if they are
identical. The third way fills in the abbreviation of station names in all empty entries for
stations.
The uniqueness is important for the cooperation of all FBS programs and all interfaces to
other programs. The NETZ program needs unique abbreviations in all timetables but this
cannot be checked by iPLAN. By defining a signal you have to check the direction it is used.
In default the signal is used in both directions, also at a two-track line.
By reation of a driver’s timetable it can happen, that a lot of stations and locations are shown
in a short distance and if only lesse time between them. So it could be helpful to hide the
station line in some cases. Use the right mouse button to call up a context menu, which
includes the item Display in driver’s timetable.
3.2.10.5 Register “Station tracks”
The register “line speeds” (3.2.10.6) encloses only the track maximum speeds and so it
contains the speed on the main tracks in stations. Normally other speed limits are necessary
in the other tracks in a station because of the points. These station speed limits are
authoritative to the run time calculation and so for the whole timetable.
All the data filled in this list are used only for run time calculation! FBS does (at the moment)
not check the length of track with the length of the trains and also the usage of the track.
These checks have to be done by yourself until FBS programme family is able to do it.
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After double click or enter in the second column of this register you get a new window to fill in
the station tracks of the station.
The following data is needed:

 The name of the track,
 The maximum speed for entering or leaving at every head of the station,
 The position of the home signals and,
 The position for the clearance points for every head of station.
The beginning of the entrance speed limit is normally at the starter signal but if the speed
limit starts at the first point you should use this position in the starter signal column.
 The position of the starter signal is used only for run time calculation not for train sequence
searching. The train sequence calculation uses a station as a simple point. At the moment a
station is used as a point with unlimited train capacity. That means that the trains beginning
and ending at one day is not compared with the station tracks. At the moment it is the easiest
way, because shunting runs are not watched in FBS. If you need trains signals as train
following place, please define an extra signal at the position of the starter signal in the
register station & location as a signal group of signals.
The end of the escape speed is normally positioned at the end of the last point. In some
cases it is before. iPLAN calculates the train length to this point and starts acceleration after
leaving this point. A start signal should only be defined in an exception. For example if the
distance between the regular trains stop and the start signal is large.
iPLAN can only calculate one speed for one station track so you have to define the track two
times if it is possible to enter the station in the same track with different speeds (for example
missing overlap). You should also define it if the entrance and the leaving speed are different
this difference is important for you.

 If you click the box table coloured a graphic is shown to you with different colours that are
also shown in the coloums where you have to fill in the data.
Stations often have some tracks with the same speed and the same clearing point so that
you are able to fill these tracks in as one track. If you would like to create a station timetable
it would be easier if you define here all tracks. So they can be adopted automatically in the
station timetable. We please you to fill in all the tracks to be able to use the checks in the
stations belonging to track use and the length.
The function View > Station tracks shows the track names in the graphic timetable in
square brackets behind the arrival or departure time.
After defining the station tracks you can refer the station tracks to up to 4 different train
categories in traffic input data in the register usage of station tracks (chapter 3.2.11, page
47). If for example regional trains use regulary track 4, you can fill it in there and do not need
to refer it later. It is also possible to change the usage of station tracks train by train in the
graphic timetable.
 Trains ever using the through track you do not need to list here. This is default.
You can change the order of the tracks by drag & drop. So you see this order in every case
you can refer the station tracks to the trains.
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3.2.10.6 Register “Line speeds“
This register is separated into three parts.
The left table shows all known speed lists with theire indication and the number of speed
changes. Below the table you can see the remarks concerning this list to get a fast
overview. On the right table you can see the relative and absolute mileages and Remarks,
if filled in and the speed to be used from this kilometre. On the right column additional
informations are shown for the validty of the speed change.
A list can be added by the
button and deleted by the
button. If you delete a list,
which is not the last one, all
other lists are moved up. So
all trains linked to this lists
loose the correct speed list.
This can be avoided by
clearing the list. The context
menu in the speed list table
can also call up these
functions. If you add a new list
an empty list is set to the
speed list table.
The properties of the lists can
be changed by a double click to the speed list item.
Another window opens, which contains four registers.
You can add or erase speed changes every time. iPLAN does not recalculate the new run
times. You have to start this by yourself. Speed limits given by engine or waggons are not
relevant here!
To add new speed changes you have four possibilities to set the location:

 Relative mileage to the start station
 Relative to a station or location e. g.: “2 miles after Xy junction”
 Relative to an existing track point: “miles before the next gradient change”
 Absolute mileage. The absolute mileage differs to the relative mileage if
o The first station is not located at mileage 0,0,
o The mileage increases along the line or
o One or more mileage changings are included.
If you used one of the last three possibilities and press the Ok-button iPLAN calculates the
relative mileage at first. Please check the mileage and then press ok again.
Inside of stations you have to enter the maximum speed for the through path. The entrance
and escape speed for the other tracks are defined as written in 3.2.10.5 on page 41.
Take care by working with absolute mileage that you use the right mileage part. Absolute
mileages can exist sometimes along a line. To define a mileage part, look at page 35.
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The row of the lists can be changed by drag and drop. The links between the lists and the
links from the trains to the list are kept alive.
3.2.10.6.1 Register “Contents”
The indication helps you to find out the right list in the other functions, which use the speed
lists. In addition to this, it is possible to describe other hints in the Remark box on the bottom
of the register. You can fill in free text in both fields.
3.2.10.6.1.1

Part “List contains of”

Here you can define the handling of the speed list. A
base profile includes Continous speed information in
opposition to a list of Several speed informations. If
you use the second option you can choose the way of
the information useage. So the speed informations can
act restrictive or raising only. This way allows you to get
a speed list quickly for example for trains with tilting
technology or for trains
with heavy axle loads.
3.2.10.6.1.2
“Labelling”

Part

This part is used for
speed changes data. You can set them by Contineous
changes with one mileage per line or From-to-positions by
two mileages per row.
3.2.10.6.2 Register “Function”
This register is made to set limitations to the validty of the
speed list. So the limitations can be set depending on the
direction, track useage, train equipment or engine series. Limitations can also be given by
axle load or load spread. The maximum axle load is respected by the limitations of the track
it self. So they are calculated for every train and checked by the validty of the speed list.
You can also set a period of validty independent from the timetable period. Please set the
check box, if the list should be compulsory if valid. That means if a configured train fullfills all
settings of the list, the list can not be deselected.
3.2.10.6.3 Register “Macro list”
Here you can summarize speed lists to be used in the current speed
list. One of the speed lists has to be set as a base profile. Just click the
boxes before the indication of the line to include them into the current
speed list. It is not possible to use speed changes in summarized lists, if
there exist changes, they will be deleted.
3.2.10.6.4 Register “Actions”
This register is designed for faster handling of speed lists. So you can set all speeds to a limit
or limit all speeds to a maximum speed. It is also possible to replace all set speeds to a new
speed value. Redundant values can be deleted too for a better overview for you and a faster
calculation for the programme. It is also possible to delete the list totally. To check the effects
of speed changes or to handle the speed limitations for building sites you can copy complete
lists to a free list number and change the speeds there. If you have checked the correctness
of the speed changes you can exchange the positions of speed lists to set them into function.
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3.2.10.7 Register “Gradient profile“
Similar to the speed changes you have to enter gradient changes along the line. Every
gradient change has a defined height to normal zero and a defined gradient, which starts at
this point. Because of the connection between the height and the gradient some algorithms
are positioned here: By filling in a gradient the following altitudes are calculated. If you
change an existing altitude a window opens which allows you to correct the following or
previews altitudes or gradients.
To fill in the mileage the same system as to change line speeds is used as written in the
chapter before. To put in the gradients you have two possibilities:

 Gradients as miles per thousand miles or
 Gradients as ratio between height difference and length difference. You can only
enter the length after which one miles
height difference is fulfilled.
The sign of the number is related to the
increasing mileage. So a positive sign means
increasing altitude and negative sign decreasing
altitude.



Take care that the gradient profile and the
speed profile have a great influence to the run
time calculation. On the one hand the maximum
speeds should be filled in exactly on the other
hand you should fill in not too much gradient
changes. It is no problem to combine some
gradient changes. As a rule of thumb the distances between gradient changes should not be
shorter than the length of a train. Normally it is adequate to fill in the crest and the lowest
point of each valley.
Some hints to fill in gradient changes:

 It is exactly enough if you have the altitude of the stations and the breaking points of
the line.
 Guess the length of the station or location and calculate the beginning and the end by
the know middle of the station. Fill in these points as line points. You can use the
function Station altitudes.
 If you have the mileage of the starter signals use this mileage also for gradient
changes because at starter signals the speed changes often.
 Put in the altitude change between the end of a station and the beginning of the next
station. Normally stations do not have an important gradient. If you would use the
middle of the station as the beginning of a gradient the trains start in the gradient and
will take a lot of time to accelerate.
 Avoid if it is possible gradient changes between stations to keep the calculation at the
acceleration as exactly as possible. Gradient changes are inhomogenities in the
acceleration curve calculation. This hint is insubstantial if there are rack changes
between the stations.
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 Take care of breaking points between the stations. It is a difference if you have an
increasing gradient and then a decreasing gradient or a plane line between two
stations.
If you have the altitudes of your stations and the distances between the station middle and
the breaking point you can use the assistant as to be seen on the left. This is assistant is
started by the station altitude button. To use the assistant no gradient changes should be
filled in the list yet.
After starting the assistant the first station is sown. Fill in all the parameters and press Ok.
After it the next station or location is shown. Repeat the put in until all values are filled in. If
the altitude does not change between two stations or locations you can skip them with the
button.
3.2.10.8 Register “Curves“
This register is shown to you after marking the more… button. New curve changes can be
filled in the same way as known by speed or gradient changes.
The influence of the curve resistance to the run time is small. It is only appreciable if the
engines are driven at the limit
of power for a longer period.
This is to be found if there are
many acceleration parts or
strong gradients at the line. The
run
time
difference
for
passenger trains is smaller than
½ % and 1-2 % for the rest of
the railway traffic. The curve
resistance has a little bit more
influence
to
the
energy
consumption because energy
is consumed in every phase of a run and not only at the seldom driving at the limit of power.
There exist examples in which the difference of energy raises up to 5 %.
The gauge has an influence to the curve resistance and this way also to the run time. If there
is no gauge filled in register classification 1435 mm are used as default. If a line has a
change in gauge it is respected by iPLAN. But if you create a train driving through the gauge
change the change is not respected for run time calculation. It is no problem to respect the
different gauges in one file if no train passes the gauge change. The program does not check
it but the run time calculation will not be exact. If you want to create a train driving through
the gauge change, you should divide the train path into two trains.
The context menu gives you the possibility to calculate speeds inside of curves depending on
different parameters.
3.2.10.9 Register “Tunnels“
This function is only available if the button More… is marked. The tunnel resistance depends
on the cross section, the length of the tunnel, the form and the number of waggons in the
train. The most important influence is made by the form and the relation between train cross
section and tunnel cross section. The preciseness of the tunnel cross should be smaller then
10 square meters (~10 sq).
Though the tunnel resistance can be quite high, it has lass influence to the run time because
of the small tunnel length in relation to the line length. So the tunnel resistance is important if
the line has a great part of tunnels as usual on subways or suburban trains. Tunnels shorter
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than 500 meters can be neglected (as written in W ENDE, Fahrdynamik, Teubner-Verlag,
Wiesbaden, 2003).

3.2.11

Traffic input data

Or Alt + V
3.2.11.1 Register “Regular stop times“
For easier handling of stop times you can list here the regular stop times for every station
and location which is marked as an access place in the Line > stations & locations
register. So you can select the list in the train datasheet, which sets the stop times for the
train. It is possible to change the stop times during the timetable construction.
If you have to do a stop at a station or location, which is not marked as an access place, for
example to change the crew, you can click show all stations and posts at the bottom of the
register. So you are able to define regular stop times for every station and location.
A double click opens a list where normal stop times are filled in. You can also select stop on
request or run through or not applicable and of course you can enter a time by yourself.
You can mark an area of cells (keep shift or click and move with the mouse) and edit the
times by pressing the enter button. So you can change the times for several stations quickly.
The lists can be named free. Click in the head of the column and fill in the name. These titles
you see in the list of regular stop times in the train datasheet. So we suggest you to use train
categories or line numbers.
It is not needed, that trains have to finish at the last station of the track, because the train can
go one on another line. So you can fill in the regular stop time for the last station too.
3.2.11.2 Register “Usage of station tracks“
At the infrastructure data (chapter 3.2.10.5, page 41) you could define different station tracks
with different speeds. It is often demanded that special groups of trains have to use a defined
platform or trains have to use a siding because a platform exists only there and not at the
trough path. You can list 4 different regular station tracks.
At the first column you can see al the stations where additional tracks are filled in. In the next
columns you can enter the tracks normally used. The list of tracks in the station is shown to
you by double click so that you can choose one. If you select the through path the cell is
clean.
You can name the lists by double click on the headline of the column.
3.2.11.3 Register “Supplement times“
To balance differences in run times between several programmes or to react to short not
predictable speed limits (e. g. track works) with an FBS timetable, it is possible to define
supplement times applied to a station or a section of the line.
The column section/station shows the section or station at which the following data are used.
The supplement times can be limited to train categories or train types or engines. Different
train categories can get different supplement times in one and the same section. The
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supplement time can be filled in in minutes and tenth-minutes or also in percent in the
supplement time column.
Please note for using supplement
times. Differences in run time
calculations or more exact data can
be cleared often so that this way is
the better way than supplement
times. In a worst case a train wants
to use a station track earlier,
because the supplement time is
sized too large or was not needed. If
the station track is still used the train
would have to stop at the open
signal. So the run time and the
energy consumption rise up and the
next train has to break to because
the block he wants to enter is used
longer than calculated.
If there are trains in the timetable, which are concerned by edited supplement times, you can
use the button Check all trains to see which trains need a new run time calculation.
Supplement times applied to a section for only one direction are similar to station supplement
times. Relative supplement times in both directions are illogical because the run times in the
sections can differ.
3.2.11.4 Register “Line blockings“
This register allows you to define line blockings,
which are not caused by running trains. To define
a new blocking uses the button New. At first the
blocking should be limited along the line. You can
use only stations and locations as start or end
position. Then you can define the time in which
this blocking is active. You can use absolutely
times or relative times belonging to trains or a
combination. So the blocking can start
immediately after a train and end immediately
before a train.
If you have defined a timetable period you can
also use a limitation of days of run.
These blockings are respected by slot search and
conflict detection.
The blockings are shown in the graphic timetable with settings you can do in the bottom of
the window. You can select a hatch, the colour, a label and the position of the label relative
to the blocking frame. The font settings can be done by the button, which is signed with the
current font and font size. It is possible to turn the label. You can also leave remarks for your
orientation. Finish the editing by Ok or Cancel.
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3.2.11.5 Register “Connection wait periods“
To consider connections to other means of transportation or to other lines, iPLAN includes
connection wait periods by slot search. You should define all connections, which trains
should be waiting for.
Use the New button to fill in a new connection wait period into the list. A new window opens
in which you can edit the relevant data. At first you should give the connection a name for
example: “Arriving of bus line 3”. Then you should choose the station at which the connection
should be realised. Just for your information: If you erase the station all connections at this
station are erased too.
Here an example to use the window:
Starting at 8.20 every second hour a bus reaches the station “Dyfi Junction”. You are
interested in connections to this bus line. So you should fill in Connection from line the
mean of transport, the line and the transportation company. It is just for your information and
not shown at any place. At junction you have to select Dyfi Junction. The arrival time you
will get by the connection partner. The minimum changing time depends on the way, which
the passengers have to cover. In this example we calculate 3 minutes to walk and two
minutes supplement time the trains earliest departure time is 8.25. The maximum
preliminary period of time is default by 20 minutes. So no train, which could have a
departure time between 8.05 and 8.25, can leave the station because they should wait for
the bus.
If this connection repeats (for example every two hours) you can enter the number of
repeating and the interval between two connections.
If the connections are limited to some days of run you can fill in the code for the days of run
and mark the train types. It is also possible to use this connection for the one, the other or
both directions.
The connection wait periods can be shown in the graphic timetable with a little frame at the
station line. The frame starts at the time when no departures are allowed and finishes at the
connecting time. The frame is positioned in the direction, which has to connect. The colour of
the frame can be chosen individual by the coloured button at the window.
If you try to move a departing train into the connection frame the departing is blocked. Take
care, that the slot search is made as written in chapter 3.3.3 on page 55. So you are not able
to set an arrival time. You have to look at the preview line by moving departure time.
To ignore the connection in your timetable construction, click the check mark in the On
column. So the connection is deactivated but shown in the graphic timetable and ignored by
all trains. This is helpful in case of unimportant connections, which should not be managed in
every situation. Independent from this function you can deactivate all connection wait periods
per simple click (look at the following break).
You can also use this function to take care for traffic input data. For example the times of
school ends or loading slots for combined traffic.

3.2.12

Display settings depending on timetable

or Alt+A
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Here you can do settings only for the display settings in opposition to the general timetable
data.
3.2.12.1 Register “Units & Layout”
3.2.12.1.1 Part “Paper alignment”
Here you can set the format of the paper used for showing the informations on screen. You
can choosen between the different DIN A-formats in Vertical or Horizontal orientation or an
individual size defined by Width and Height in mm.
Set default size depends on the resolution of your screen. If the size is larger than 1024
pixels the DIN A2-format is used, if it is small than DIN A3-format is set.
3.2.12.1.2 Part “Margins”
The margins are used to save space on the borders of the paper. It gives a better view after
printing the graphic timetable. You can define margins on all four sides of the paper in
different values. The head- and footlines are always printed above respectively below the
Upper or Lower margin. These margins are called up by starting the print function. They can
be changed there for the current print.
3.2.12.1.3 Part “Alignment of graphic timetable on screen“
Here you can choose the orientation of the whole graphic timetable on screen. You can set
Distance axis horizontally, time axis vertically or just the opposite as Time axis
horizontally, distance axis vertically. We advise you to change this option before starting
the creation of the graphic timetable. Some functions get in trouble by changing the
orientation after filling in the trains. The orientation of the graphic timetable is a traditional
fact, so that you might set this before starting the editioning and do not change it during the
work.
This function changes also the orientation of other functions like moving the time axis from
the up and down arrows to the left and right arrows.
3.2.12.1.4 Part “Contents of graphic”
Some options are helpful to keep the overview especially if large graphic timetables are
needed. So you can Repeat hours at right/down side to avoid searching them on the other
end of the paper. Zoom line width of train lines too keeps the proportion of the train lines
in different zooms to be able to differe the importance of trains too. It is better to deactivate
this option if there are a lot of trains to be seen in a tighty space. Espescially if you have to
move some trains you might keep this function off.
To keep the “What you get is what you see”-principle alive you can Show margins on
screen. So you get an empty border on the left and right respectively on upper and lower
side which takes only space on screen. The limitations of the margins can be shown by
Show lines at margins on screen. This way allows you to get an overview of the needed
space on the paper.
3.2.12.1.5 Part “Distances and Speeds“
This box allows you to change the unit system for distances and speeds. Default units are
based on Metric system km and km/h in conformity to SI-system. It is possible to use to
ways for mile unit. If you choose Decimal miles the figures behind the point mean miles
divided by decimal figures. The Imperial mile system divides the mile in 80 chains. Take
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care for the separator: in decimal systems it is the comma and in imperial systems it is the
point. In FBS the SI-system is used for calculating.
3.2.12.1.6 Part “Altitudes“
You can switch the unit for altitude data between Metric m and English feet ft.
3.2.12.2 Register “Titles“
The titles entered here are shown on top of the timetable by printing it. As default the first
and the last station are filled in the part “Title for timetable’s header”. The length of the
track and the period (if defined) are shown in the part “Remarks, hints, annotations”. You
can complete the information with free text and/or the following variables:
#P

=

timetable period (validity period)

#L

=

length of line

#B1

=

First station of line

#Bx

=

Last station of line

#N1

=

Name of first user

#N2

=

Name of last user

#D0

=

Current date

#T0

=

Current time

#D1

=

Date of file is creation #T1

=

Time of file is creation

#D2

=

Date of previous change

#T2

=

Time of previous change

#FN

=

File is name without path

#FP

=

File is name with path

The texts are shown on the graphic timetable print. If you want to safe hints, which should
not be printed use the Edit function of hint text (chapter 3.2.13, on page 54).
It is also possible to fill in these macros inside of the parts Headline(s) and Footline(s).
To show page numbers on the pages you can show page numbers. You can set the First
page no. here.
3.2.12.3 Register “Header of timetable”
This register sets the shown data on top of the graphic timetable. These informations are
positioned above the distance
axis. The Contents of timetable
header can be set by activating or
deactivating
the
different
informations in the list. The
informations are collected from
the different lists inside of the
timetable file. The row of the data
can not be changed.
The picture on the right shows you
an example of the maximum
shown informations inside of the head of the graphic timetable. Please note, that the title and
his remarks are shown independent from the orientation of the graphic timetable always on
top of the paper. All the other informations are shown on top of the distance axis.
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The Remarks are set in Infrastructure
data > Register “Classification” >
Others as explained in chapter 3.2.10.3
starting at page 37.
The Minimum height of title lines is
usefull if you would like to print more
than
one
graphic
timetable
abreast/beneath each other at the same
page.
To save space you can define the
Height of station names or Calculate height automatically.
Height of heigt profile and curve profile is fixed by the data filled in here. So the size of the
data is calculated automatically to keep the data inside of these dimensions.
Reference speed list for maximum premitted speed is set here to be shown inside of the
head of the timetable.
3.2.12.4 Register “Stations“
At the moment there are no functions useable here.
3.2.12.5 Register “Days of operation“
This register allows you to set the display settings of days of operation.
3.2.12.5.1 Part “Display name of months as “
Here you can change the notation of month. For example complete name or Arabic numbers.
3.2.12.5.2 Part “Number of special days of operation at train line“
A better picture will be done by reducing the number of special days of operation at the train
line. If the limit is exceeded the code “VT” refers to the legend.
3.2.12.5.3 Part “Display of VT-references “
If a train has limited days of operation the
days of operation can be shown in different
outputs in different ways. You can differ
between graphic timetable, legend or train
datasheet. At the train line you can use the
number of set of days and at the legend
the complete name of the set of days. You
can also show all days in the set of days.
The set of days can be edited by general
timetable data > calendar (look at chapter
2.2.2 on page 14).
3.2.12.6 Register “et al.“
3.2.12.6.1 Part “Operator logo“
It is possible to set a special logo to use in this timetable in opposition to the logo set in
options > configuration.
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3.2.12.6.2 Part “Content of train features“
The list shown in this box shows you the extra data, which is shown in this timetable below
the train number.
The load unit is fixed in t, the axel unit is x and train length in m. The order of this data is also
fixed by iPLAN.

 Maximum speed (in miles/h or km/h),
 Short name of engine(s),
 List of short names of waggons,
 Load in t,
 Length of train in m,
 Number of axels and
 Seats.
If you click “show” load, the load is only shown if it is greater than zero. This is essential for
the waggon list too. If the train exists only of engines or multiple units this data are not
shown. Seats are also shown if the train is a cargo train. Seats are only shown as sum of all
classes.
We advise you to use axle number and seats only, if you can reach a result by this
information. If you use it just for fun it will decelerate FBS. The program has to load the data
from list files, which takes time.
3.2.12.6.3 Part Rounding of the minutes in the graphic
Here you can set the shown times inside of the graphic timetable. You can differ between
Showing tenth of minutes, Round to half minutes or to integer minutes. The tenth of
minutes are the most exact way, which could be shown so the times are not rounded. The
other options allow you to choose different rounding rules:

 Traffic rule (normally round off departues, round up arrivals),
 Mathematically (round off <x.5, round up >=x.5),
 Round off departures, Round arrivals mathematically or
 Round off all.
The intention is to separate the shown times from the rounding rule.
3.2.12.6.4 Part “Character set for train messages“
At the moment there are 4 schemes useable for train messages, which have to be sent by
chief of train. These messages are shown in graphic timetable and also in driver’s timetable.
It is a system used for less engines in steam lines in countries with German safety
philosophy. If you want to get detailed information please call the service.
3.2.12.6.5 Part “View settings for new trains”
The Button Edit settings opens the View settings for trains window. Here you can change
settings for trains, which are put in the timetable after pressing ok button.
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So you are able to get detailed data for trains you added new to the file and only short
information for trains, which have been in the timetable. If you choose copy train data from
the settings of this train are used. These settings are saved with the file. To reduce the
information look at chapter 3.3.10.5 on page 68 for only one train or for more trains at
chapter 3.2.3.4 on page 30.

3.2.13

Info text file

Or Alt + I
This window helps you to remember hints to the timetable or to the line. The scratchboard in
the button shows you whether a text is present (a filled scratchboard) or not (an empty
scratch board). These hints are saved together with the timetable and opens automatically if
you open the file.
You can edit the text by the Edit button in a window. The usual buttons on top of the edit
window can change the formatting of the text. It is possible to copy the text to a standard text
program or can paste texts form there.

3.3 Construction Menu
3.3.1 Select train
3.3.1.1

General

Any mouse action in this chapter can be assisted by the method to mark single trains. If a
help window shows you some trains so the mouse action is related to the first train. The row
of trains is change by Alt key, so press as often as you need and move the mouse pointer a
little bit. Look also at chapter 3.2.2, page 28.
3.3.1.2

Mouse menu

The mouse menu can be opened every time by clicking the right mouse button. If you are in
preview mode (move departure times, train leaves the line/train changes to line) the preview
can be stopped by the first entry in the menu.
You can also call up a train in the second part of the menu. This is helpful if the train is not
shown in the current view and cannot be selected by mouse.
All the other menu entries are short cuts to function, which can be opened in other ways. The
most functions are related to the selected train.

3.3.2 Move description in the graphic timetable
Select the second mouse button and click close to the train line. Note the shown train in
the status line on the bottom. The next click marks the left bottom edge (independent of the
direction the train uses) of the label. The label is positioned new at this position.
Position and angle can also be changed in the train data window (look at chapter 3.3.10.5,
page 68). If the label is not shown, you can call up the train by mouse menu.
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3.3.3 Move departure times
This might be one of the most important functions of the programme. It allows you to
change departure times fast and clear without typing in.
Select at first the third mouse button and after that the train by clicking close to the train line
(note the status line). You have to select the right train at the right station. Only departure
times in direction of the train are changed. The programme shows now a preview line, which
you can move by mouse. Preview lines are shown only for useable slots at all operation days
by respecting the trains filled in the timetable. Move the mouse until you found the best
departure time and press the left mouse button to select the times or the right button to
cancel. You can read the current time in the status line on the right or at the mouse pointer. If
you are not able to see the wished departure time use the roll buttons in the symbol line.
If it is to difficult for you to select the new departure time you can type it in by function Enter
departure time or Enter stoppage time at mouse menu (look at 3.3.1.2, page 54). FPS
uses the next free slot after the time you filled in.
An exact slot search can be done by helpful of the up and down (respectively left and right)
cursor keys. So the preview line is moved a tenth minute.
It the next free slot does not include a pass through at a station an operational stop is
calculated. So an arrival time is calculated and as fast as possible a new departure time is
used. The operational stop is signed by a “+” in the column info at the run time table (look at
3.3.15, page 71). In the case of compact train relations it can happen that the programme
changes recurrently between pass through and operational stop. The sand glass is shown
(). You can stop it by clicking and fill in the times by yourself.
The calendar function makes it possible to calculate the exact exclusions during the slot
search. That means that two trains exclude themselves if they run at more than one day in
common at one day of the timetable period. The regular and the special operation days are
respected in this function.
Just an example: If one train runs every working day without Saturday and another one runs
Saturday, Sunday and on public holidays so they can use a single track line at the same time
because the operation days have no day in common. If the first one of them runs also at the
first of may (it is a public holiday in Germany) they cannot run at the same time because a
common operation day exists!
This problem can became quite difficult by finding an answer to the question: “Is it possible,
that a train operating every Friday and Saturday and a train operating at days before public
holidays run at one day?” Who can answer it quickly?
The devil is in the detail: Two trains operating W and S do net exclude themselves. If you
divide the train operating at W in a train dividing WXSa and one operating Sa you will get a
problem. The train operating on Saturdays gets in conflict to the train running on S, because
there exists a public holiday at a Saturday. To solve this conflict you have to change the
operation days of the Sa train to SaXS.
Attention! As long as a period is not defined, iPLAN checks only the regular operation days.
Only conflicts between weekdays and holidays at weekdays, but not concrete public holidays
are checked. So a train operation at S gets in conflict to every other train.
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3.3.4 Determine station tracks
Choose the mouse button “Determine station tracks” and click an intersection between
train and station line. Please not again the train head code written in the status line. After that
you can select the station tracks and their speeds.
At a station you have more than only the through track, which speed is limited only by the
speed list. If you have defined station tracks and a determined a train this track he respects
the speeds of the station track.
Attention! iPLAN does not check the train order in a station track. But you should take care
for this problem in iPLAN too to avoid changes. You can control the station tracks as written
in chapter 3.4.7, page 74.

3.3.5 Determine/cancel non-stop running
Choose a train by click at the station in which the train runs through are stops and it is
switched between stop and non-stop running. If a non-stop running is not possible because
of a used track to the next signal an operation stop is shown. To undo this process you can
repeat your click. Chapter 3.3.9 tells you at page 56 how a stop is named.

3.3.6 Train ends at intermediate station
Select a train again at a station to end him there. If you would like to undo this you can
use mode “Move departure time” at this intermediate station.

3.3.7 Train starts at intermediate station
This function is needed if a train should start at a station later on his current run. Choose
the station at which the train should start now and click there. It is not possible to undo this
function except of undo at edit menu. If you would like to start the train at an earlier station
you have to change trains route section (look at chapter 3.3.10.3.2, page 59) or to define the
train again (look at chapter 3.2.1, page 27).

3.3.8 Train leaves or changes to this line
This mouse mode works in the same principle as the one explained before. The
arrival or departure times are connected with a short line starting or ending at the station the
train leaves or reaches the line. You can move these short lines by drag and drop with the
mouse. Note the time shown in the status line.
The short lines do not end as a normal line at the station line they end shortly before or after
it. So it is easier for you to differ between trains, which end at a station or leave the station to
another line.

3.3.9 Set stoppage information
This function has no influence to trains run but you change properties of a stop. Such
properties are for example operation stops (+) or stop on request (x) as train messages used
in simplified operation modes (in Germany known as “Zugleitbetrieb”).
If you select the button stoppage information the last type of information is in use. To change
this, use the small button on the right of the stoppage information button. A small menu
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opens to select the information you would like to set and after that you can click at an
intersection between train and station line and the symbol is set.
If you repeat setting the same information the information and the symbol are erased.
The operational stop symbol (+) is set by programme if it is needed. You can use this stop
also for other things if it cannot be cleared. Please note that such an operational stop set
only by iPLAN can be cleared automatically if it is not needed any more.
If you need the stop for example to change crew or to refill the water of a steam locomotive
you have to set the operational stop manual.
The symbol for a stop on request (x) does not have influence to the stop time. It is better to
set the stop time in the list (chapter 3.2.11.1, page 47) by a short time or 0. It makes no
sense if you declare a stop of two minutes to a stop on request.
It is also possible to define a stop for pick up only or alight only. This will also be shown
inside the customer’s timetables.
Some symbols cannot be used together. The programme shows in this cases only one of
them.
The symbols for simplified operation modes are taken from the list defined in display settings
depending on timetable (chapter 3.2.12.2, page 51). These symbols are shown directly in
front of the arrival resp. departure times. The Arrival message cannot be used at the start
station of your train and the Permission to proceed not at the end station of the train. The
sense of these messages is not checked by iPLAN so handle them with care. The messages
set here, are automatically used in the driver is timetable if the right form is chosen.

3.3.10

Edit train data ...

or Double click at a train
This function is only available, if a train is selected. The current train is also shown at the
status line on the bottom of the iPLAN-window. This window allows you to set all the data
being relevant to the train.
3.3.10.1 Part “Train type and number”
His train type and his number identify every train. The train type shows also the traffic job he
has to do and the meaning of the train. So try to give a train his own headcode arisen from
train type and number. A special file includes the list of train numbers lined to the train types.
The general timetable data (Register “References“, page 13) keeps the information which
Train type and headcode database is being use in this timetable because they can differ by
every infrastructure company.
To fill in a train type you can choose a train type shown in the list there. To work faster, you
can also fill in a train number in the space for train numbers and iPLAN finds the train type
belonging to this train number automatically if have not fill in a train type by yourself (look
also at chapter 9, Page 145). It can happen, that some train types are possible to one
number, but often the automatic function finds the right result.
The train type is not urgent needed but helps to differ trains in the graphics and makes other
functions useable in timetable construction or statistics.
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3.3.10.2 Part “Days of operation”
This box shows you the summary of all operation days of the train inside of this timetable.
Every day where at least one train part runs one section of the line is shown inside to control
th operation days.
3.3.10.3 Register “Overview”
3.3.10.3.1 Part “Train parts”
Every train consists of at least one train part. But there are many cases in which trains
consist of some parts. Examples for these cases are:

 Train sharing and coupling: Two (or more) parts are shared at a station and both parts
use different lines to run on.
 Additional waggons at special operation days: for example on Fridays or before
and/or during holidays. The additional load and length has to be considered to the run
time calculation. So take care that the run time differs to the other operation days.
 Through carriage: Special waggons belong to a train for a part of it is run and are
given then to another train.
 Sharing of freight trains: In some cases heavy trains have to be shared to pass strong
ramps and to be coupled again at the flat country and continue running. You can also
fill in parts, which are left or picked up in stations during the run.
 Changing engine(s) at a border or energy supply changing station: Normally a train
operating company tries to use the most effective engine(s) to run a train. Also an
approval can be missing or the parameters of the electrification system can be wrong,
so that the engine hast to be changed.
Whenever the train composition changes or single parts (also only a single waggon) require
other operating day rules the train should be separated into several parts.
Take care for the property Train parts are homogeneous. It says, that the properties of the
train are the same in every section the run is divided in. This does not mean, that all train
parts exist in all sections, but if they exist, all parts with the same head code have the same
data. If you would like to use train parts with the same number at different operation days to
different sections set in you have to deactivate the Train parts are homogeneous box.
 The train part number is the unique name for a train part. It is important if trains or parts
of trains leave the line and continue running at another line. To make sure, that the FBS
programmes will detect a complete train run right, the train part number has to be the same
at every line!
A new window opens by using the New train part… button in which the new train part
number should be filled in. iPLAN gives you a suggestion, which you can overwrite. Two
ways to do this exist:

 If two coupled trains run alone at other sections use the regular train numbers. Only
the first train number is shown to you but the second train number is saved in the
data. This is the usual way to handle trains being shared. The train parts keep their
train number so that change free connections can be found.

58

Chapter 3  Graphic Timetable
3.3  Construction Menu

Documentation to FBS
Edition November 2015

 Train parts without their own train number (e.g. through carriage…) should be
named as the train they are transported followed by a small letter.
3.3.10.3.2 Part “Train’s route sections”
If the train parameters differ at different route sections you have to define the route sections
at first. Click at Split route… and choose the station to split in the following window. So the
route is divided into two parts. A new register is shown in the train data window between the
Overview and the others register. Every route section has there own register. These
registers are named by the abbreviations of the stations.
It is possible to split the route if you have just filled train data in. The existing train parts have
the same settings in all route sections and so they can be changed now independent.
So long as the filled in and the really route sections are different please check if:

 It was not possible to calculate a run time (gradient, maximum speed) or
 It was not possible to find a slot in a section with five hours.
3.3.10.4 The registers of the single route sections
3.3.10.4.1 Input into the table
To get a better overview the route
section is written with his complete
name at the register side. The table
includes the train parts in the same
order as in the train himself. You can
change the order in the table by using
the “hand” buttons
. Please
note that the order is changed in head
stations.
If you would like to change only less
data between the separate route
sections you can copy all train parts and
their settings from the other route
sections by using this buttons
.
The train part numbers can be changed
here by double click directly into the
table. By click into the last (empty) cell a
new train part number will be shown. A small letter will add the train number. It is also
possible to fill in a completely different train number. If you use the same train number the
first train part gets an “a” after leaving the train part number settings.
The column Days of operation is used to fill in the regular and the special operating days.
This function can only be used if a timetable period is defined in Edit > general timetable
data > Calendar (look at chapter 2.2.2.3, page 14). A double click opens the window, which
allows filling in the operation days.
You can fill in the regular operation days as written in chapter 15 starting at page 162 (for
example Mo, Fr). Take care of the Operates and Not on Field. By leaving these fields the
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working days are translated into the calendar shown on the bottom. The colours are set in
the following system:
Yellow fields:

regular operating days

Blue fields:

days of the week at which the train does not operate

If you are not able to do an optimal recreation of the traffic task of a train by standard rules,
you can do the following detailed inputs:

 The day, where the train does not operate becomes an operating day. So it is an
additional day, which is also shown in the line also.
 A double click at a regular operating day changes him to a loss day and will also be
shown in the line not on.
To select a whole range of days click at the first day and keep the shift key pressed and click
at the last day. After that a mouse menu opens in which you can:

 Invert all days from… to… in their meaning.
 Include all days from… to…as Also days.
 Exclude all days from… to… as Not on days.
 Define a new period only for this train. This
data is filled in the line Only. This function is
helpful, if the train operates only in a season. Typical for this function are holidays or
harvesting times.
The data entries can be inverted. iPLAN summaries the dates in the grey cells automatically.
On the top of the window you can see the sum of the operation days in the timetable period.
Days, which do not belong to the period, cannot be chosen. These days are coloured in grey.
As an alternative to the shown window you can also fill in the operation days faster directly in
the cell in the train data window in the train route section registers or can paste them by
clipboard. To do this keep the Ctrl-key pressed during you call up the column days of
operation. Here you can use the abbreviations of the regular operation days and the key
words not, also and only and also a concrete date.
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If you use the timetable for daily work you can change operation days shortly by keywords
today, tomorrow and the day after tomorrow without filling in the date it is self. iPLAN
changes this relative dates to a concrete date. This function works only if a period is defined.
Depending on the Windows®-settings you can also use the complete name of a month or the
abbreviation. It is also possible to fill in a month in Arabic or Roman figures.
You can find further informations to operation days in Annex – Declaration of operation days.
The column Line is used in iPLAN for multi selection of trains. And interval graphic can be
made easily by using the line names in Netz programme (look at chapter 7, page 130). This
property is also needed to use interfaces to passenger information systems to differ different
lines using one route.
The Engine column shows all engines used in this train part at this route section. A double
click opens a window to change or choose the engines. At first you can see the engines
defined for the Train Operation Company set in configuration. After that the engines are
listed in alphabetic order of all Train Operation Companies and followed by a list sorted by
producer. The right button mouse menu allows it to change the sorting system.
The table also shows you important run time calculation parameters of the engines. So the
different columns include maximum speed, engine power and the power-mass-relation. The
engine power is shown because this parameter is more known than the power at the
coupling hook. The
power-mass-relation
is calculated by the
tractive power and not
by the engine power.
So you have a better
indicator
to
the
acceleration
behaviour. So it is
possible to compare
engines easier without
reading the complete
engine datasheet.
Engines, which you
are not allowed to use by your license, are normally not shown. You can show them by
clicking Show not usable engines. Here you can also use only the engines, which are
known by the programme. Finish you choice by Ok button. If you want only a simple list to
choose the engine, you can also click the cell and use Ctrl+Enter to select the engine.
A second engine used in your train has to be defined as a second train part.
If you double click in one of the cells Speed, Load or Length the
coach and waggon arrangement window opens. The upper list
shows all useable waggons and the lower list the waggons being
used in your train part composition. After double click a waggon,
a new window opens to fill in the Number of waggons of type
and the Reservation/booking no.. By filling in the Reservation
noumber of the first one the numbers are counted on until the used waggons are fulfilled. If
you use the same type of waggon after each other and the numbers are not counted
continousley, the waggons have to be listed one by one inside of the waggon list. These
numbers can be copied into reservation systems ore something else.
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You can copy the current train composition by click with the context menu to the clipboard.
So the composition is added to the mouse menu and you can recall it by selecting in the
context menu. This clipboard is not the WINDOWS®-clipboard. It is an iPLAN-own clipboard
and exists as long as iPLAN is not closed. Train compositions can be copied to other iPLANfiles by this way. Add all existing train compositions to the clipboard means that every
composition used in this file is copied into the clipboard. Delete current composition erases
all waggons used for the current train.
It is not necessary to
model all the existing
waggons to get a
better precision of run
time calculation. You
can replace waggons
with the same length,
mass and maximum
speed like you want.
The order is also not interesting. But please note that this data can have influence to other
timetables made by this timetable.
A freight train with unknown composition cannot be modelled exactly so that you can fill in
the (maximum) mass, length and the maximum speed of it by using Ctrl+Enter at the cells
for this data.
The maximum speed of the composition is the speed of the slowest waggon. The maximum
speed of the engine is accounted by iPLAN. You only need to change the speed cell if you
would like to run the train slower as he is allowed to.
The trainload is the mass of the loaded waggons so it is without engines mass. Train is
length includes the engines. The programme calculates this values by it is self. You can
change this data in your own authority to any value. Please note, that the run time
calculation can result useless results because trains are to heavy and to short or to long and
to easy. The relation of train length and mass should reach a good result. Please prefer the
waggon lists.
The column “X” of the tab is marked if the train part is regarded in run time calculation.
Attention: If separate train parts do not run on all operation days please select the
composition of the train, which results the longest run time. Which combination results it you
can get by help of the diagram window (as written below). So a separate train part can
extend the run time because of it is mass or can shorten the run time because of its engine
power.
If you press Ok or the diagram window the run time is calculated again if necessary.
3.3.10.4.2 Part “Technology and Extras”
A linear time addition should be used to balance the scattering because of bad weather or
wet rails. The value should not be under 2 %, 3 % for regional trains and 6 % for long
distance trains.
If you need a load supplement you can fill it in the next cell.
The run time calculation needs the Braking percentage (quotient by break mass and train
mass of all vehicles in the train multiplied by 100) and the Braking switch. Both values are
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determination the absolute breaking of the train. Typical braking percentages are between
80 % and 200 %. Avoid braking percentage below 50 % and above 225 %.
The real braking is influenced by the existence and the system of Train protection. iPLAN
can differ between:

 No Train Protection: Trains start braking at a position, which is calculated by
empirical formula, depending on current speed and speed at next speed change,
gradients, braking percentage and braking switch.
 ATP: The train gets information to signals at discrete track points and has to break
the way the train protection leads. The ATP-System is designed as PZB90 being used
at German railways (Today this mode does not work.)
 ATO1: This mode is similar to the German LZB72/80. So the trains have to brake
down in steps, which are defined in hardware with constant braking acceleration.
 ATO2: The braking acceleration is calculated as constant depending at the speed,
which should be reached. The braking acceleration is calculated up to 0,78 m/s². This
mode does not belong to a special technique and so it can be used international.
 ATO3: The current maximum speed is calculated by variable braking acceleration
depending on the current speed. This mode is in discussion for future ATO-systems.
3.3.10.4.3 Part “Line reference lists”
The line reference lists determine the regular stop times, the station tracks (speed in the
station) and the maximum speeds (along the line). The stop times and the station tracks
can be changed in the timetable individual. The speed lists will be checked to the validity for
this train configuration.
If you change at a station the station track list the station where you change will be run
completely by the old list. Stop times are similar to this.
3.3.10.4.4 Further Settings
Normally all trains of a double track line running in one direction use the same track. If you
would like to use the track of the other direction, activate the option In this section at the
track of the opposite direction. This option can only be used, if there exist two tracks in the
following section.
Train runs through a part of this section only means a train, which would start or end at a
location that is not block post with loop. This is typical for attending private sidings or shunts
over station limits. It is possible to use a track in the false direction. We know, that this
operation type is a Germany speciality. FBS can only allow runs that do not start or end at a
station this way.
The Information Train leaves the line after the section is only activated at the last section the
train runs on this line. So that stop at the last station is calculated and a short line shows you
that this train continues running at another line. Train changes to this line exists but hast to
be set manually.
3.3.10.4.5 Train diagram
The train diagram is a graphic output of the calculation of run times as a speed profile. The
colours of the lines mean:
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 Blue line

shows the speed allowed by track

 Green line

speed at start of train

 Violet line

speed at the middle of train

 Red line

speed at end of train

It is of course trivial that the end of the train runs as fast as the start of the train. The diagram
shows the influence of speed changes because they have to be passed by the whole train
length.
Above the train speed diagram the run times of every section is shown. By switching
between train data window and train diagram it is easy to show differences of different
engines, mass or tab lists.
If you open the train diagram by the register Overview the complete run is shown. By
opening it at a section register only the run in this section is shown.
If you have changed settings which have an important influence on the run time and you
close the train data window a message appears and tells you, that the train lines in the
graphic timetable do not agree with the run time. You are asked to search for now slots.
The context menu opened by right mouse button allows you to change the form and the
outputs. So you can show tractive effort or theoretical output. So you can reach a run time
calculation protocol, which shows you the separated acceleration-, run time- and brake
process.

 If you wonder at the constant speed sections below the maximum speed you can explain
them by the Minimum remaining period. This period can be changed at general timetable
data (look at chapter 2.2.2.2, on page 13) to realities values of 5 to 10 seconds.
The Export button opens a dialogueue window to save the diagram as a bitmap or to save it
into the clipboard to fill in a text.
If the train diagram and the protocol are shown at the same time (use the right mouse button
at the train diagram > Show protocol) the protocol jumps to the position where the mouse
pointer is clicked in the train diagram. A green line shows the position, which is selected at
the protocol window.
3.3.10.4.6 Dynamics
The button dynamics leads you to helpful functions to calculate the effective gradient, the
maximum load being used in this configuration and the minimum braking percentage. These
functions have a relation to the current train data but you do not need to call them up. You
might need the seldom.
The maximum load can be helpful to calculate the maximum load of a freight train. This
function is helpful to rate engines and lines and not to configure the timetable construction.
Sometimes it is better to calculate the timetable by using the minimum braking percentage
for a train because the real braking percentage is not known at the day of scheduling.
The effective gradient for a concrete train is a necessary condition to calculate the values
written above. So it is only a step to the result, which is shown only for your information.
3.3.10.4.6.1

Function “Minimum braking percentage”
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Please note, that the braking percentage for a train is normally higher than the minimum
braking percentage. The minimum braking percentage should only be used if the train
composition is unknown or highly varying. For passenger trains, multiple units, light engines
and freight trains of fixed rolling stock the existing brake percentages are to be used.
For an assumption of existing brake percentages and brake switches the following guiding
values can be used:

 Passenger trains and multiple units > 160 km/h:

225 % R+Mg

 Passenger trains and multiple units > 140 km/h:

165 % R+Mg

 Other modern multiple units:

150 % R+Mg

 Other passenger trains:

140 % R

 Light engines:

100 % P

 Freight trains > 100 km/h:

100 % P

 Freight trains <= 100 km/h:

80 % P

3.3.10.4.6.1.1 Register “Single calculation”

The minimum brake percentages
λMin(vMax, iM, sVA) tells the minimal
necessary braking capacity to stop a
train from its maximum permitted speed
vMax at the given pre-signalling
distance sRVA and the ruling gradient
(descent) iM with an emergency braking.
The presignalling distance contains the
braking phase but not the reaction
phase.
Please note that several combinations
consisting of presignalling distance,
gradient (descent) and permitted speed
are possible on one line. The most
restrictive case is to be debugged.
The empirically calculated minimum
brake percentage does not always
correspond with the results of a brake
percentage table, which is determined
by experiment.
Part “Calculate With”
The Minden Braking Formula (Sauthoff 1961) defines the connection between braking
percents, speed, gradient and braking distance for a completely emergency braking including
a 10 % surcharge for a compressed air disc or block brake. It is only valid between 30 and
160 km/h (P, R, R+Mg) or between 10 and 90 km/h (G). If there are Individual Braking
Tables available you can also select them for the calculation.
If the speed exceeds 160 km/h, in some countries automatic train operation with cab
signalling is mandatory. In case disturbances occur, these trains have to be able to stop
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within the usual pre-signalling distance (1000 - 1300 m) from 160 km/h. So you can calculate
the minimum braking percentage for ATO1-system up to 160 km/h and in ATO2/3 it is limited
by 225% braking percentages. If higher braking percentages are necessary new tables have
to be defined.
3.3.10.4.6.1.2 Register “Whole train
route”

This register includes a table of
all sections which could be
relevant for finding the minimum
braking percentage.
A new line is set by a change in the descent, braking distance or speed. The maximum is
marked line in green background.
If you reach the table of the whole train route from outside the table a hint is shown to you
including the line section to give you information of the position of this part of the line.
3.3.10.4.6.2

Function “Effective gradient and Maximum Load”

3.3.10.4.6.2.1 Register “Effective gradient”

The effective gradient considers the train as an inhomogeneous mass line. So it is only valid
for the current composition at the current line section and for the running direction. It changes
continuously by running along the line.
A long train will often involve some gradient changes. An inhomogeneous train related to his
mass allocation – and this is normal – has to be differed whether the heaviest or easiest part
of it is in the superior gradient. This is also true by more than two gradient changes and more
than two train parts.
At a train part the mass of the engines and the waggons are shown as homogeneous related
to the engine and the waggon part. The train parts are calculated in the row of the list shown
in the train data window: At first normally the engine and than the waggons of every train
part.
The minimum of the
effective gradient (regularly
it is the most effective
descent for the train) is
needed to calculate the
minimum
braking
percentage.
The maximum of the
effective gradient is needed
to calculate the maximum
load.
The
register
effective
gradient
includes
a
diagram that shows the
local effective gradient and
the gradient profile. By click
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in the diagram the values of this position are shown.
The table of the effective gradient shows you all parts of the line in which the effective
gradient exceeds a chosen limit. This table can help you to identify section in which a too
heavy train should not be stopped. So you can decide whether the train can run because
there is no reason to stop there are if he would be stopped he can roll back. The table shows
only the maximum of the effective gradient inside one part of the line.
3.3.10.4.6.2.2 Register “Maximum Load”

The maximum load is the maximum load (mass of the waggons), which can be run safe with
the engines along a line with a minimum speed. The value includes variable input data
(weather, engine power) and to get a better operation.
There are different formulas used for passenger and freight trains waggon resistance
(passenger trains: Sauthoff; freight trains: nach Strahl).
Free remaining acceleration (at maximum speed) is a kind of reserve. To accelerate in the
maximum gradient it would take a long time to reach the maximum speed without any free
remaining acceleration. Simplified you can say: as much higher the free remaining
acceleration is as shorter are the acceleration phases. Typical values are 0,01 m/s² for
freight and 0,02 m/s² for passenger trains.
The head wind hinders the acceleration so that you should use a head wind speed to
calculate the acceleration. Normally 10 to 15 km/h are used for head wind speed.
Inside the maximum load table the colours tell you:

 Grey columns are the speeds, which are possible for the engine but not allowed at
this line.
 The green column is the line maximum speed at the current route section (it can be
lass than the maximum speed of the whole line).
 The yellow line shows the maximum effective gradient at the current route section
(see below).
Please note, that the calculation of the effective gradient is done for the concrete train length.
The maximum load can require a shorter length so that the effective gradient is different to it.
So if the maximum load results another train length (especially a shorter one) repeat the
maximum load calculation.
The column for speed = 0 shows the load which can be kept at their position at engines
maximum power or the friction limit in the effective gradient. So the train is not able to
accelerate. The start maximum load is the load by which the engine(s) is able to accelerate
and leave the section by starting in the effective gradient. The lowest speed results by the
maximum of:

 The lowest run speed of the engine (for example 20 km/h) and
 The lowest accepted speed to leave the section.
It is also possible (and is the custom at DB Netz AG) to calculate the starting load from the
speed = 0 but with a relatively high free remaining acceleration. This acceleration then
causes the train to move after all. In this case it is recommended to use 0.2 m/s² for
passenger and 0.1 m/s² for freight trains.
67

Chapter 3  Graphic Timetable
3.3  Construction Menu

Documentation to FBS
Edition November 2015

If you would like to see the
driving force and resistance
of engines the symbols mean:

 FT = sum of all driving
forces
at
traction
wheels perimeter of all
engines
 FWFT = sum of all
resistance of engines.
3.3.10.5 Label
3.3.10.5.1 General information
The button Label opens a large
window in which you can edit
settings to data, which should
be shown to a train line in the
graphic timetable. So you can
reduce the data for your
timetable calculation and fulfil
them to print the timetable. It is
possible to do different settings to every route section. Please note the selection by the Ok
button.
The Label window can only be opened at a route section register. If you leave the window by
cancel button the labels are not changed. At the lower side of the window you find a preview
window.
The register “General” at display settings depending on timetable sets the default values for
the label (look at 3.2.12.2, page 51).
3.3.10.5.2 Parts “Colour of train line” and “Style of train line”
The easiest way to get the right colour and style of the train line is to select her by type of
train. So the colour and style defined in the train type and headcode database is used. The
advantage of this selection is the easy way to read the timetable. If for example passenger
trains are painted red and freight trains black you can read a timetable easier.
If you choose Select manually a menu opens to select the colour and the line style. So it is
possible to:

 To show the regular trains in one colour and trains outside the interval or additional
trains in another colour,
 To mark trains which belong to another connection,
 Mark if multiple units are used as single or double (differed at route sections).
3.3.10.5.3 Parts “Display in graphic timetable“ and “Train diagram remarks“
iPLAN shows you here the position of the left down corner of the label. The coordinates are
shown in timetable form that means in kilometre and time. The angle related to time and
kilometre is also shown. So you can move the label to every coordinate of the diagram.
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A train diagram remark makes it possible to fill in free text as hints to read the timetable.
These remarks are shown and printed and not covered like all other remarks.
3.3.10.5.4 Part “Display options“
During the timetable construction it is possible that train lines and labels are not parallel or
close together. The options Recalculate angle and Recalculate position produce a better
style of the timetable. The other options give you the possibility to add or erase arrival or
departure times. So if you do not have much space at your diagram between trains you can
reduce the shown times.
3.3.10.5.5 Part “Contents of label in graphic timetable“
Seven elements to for lettering the train line are useable here. These parts can be selected
and deselected at the beginning of the line. You can use different typefaces for every letter.
The button opens a Windows®-Window to edit the typeface. You can also position the
lettering in six lines.
3.3.10.6 Register “Others“
The Far distance route of a train can be entered manually to show the complete run of the
train. Start- and end station of the train do not need to be at current line. If it is too difficult for
you to fill in the informations to every graphic timetable the informations in chapter Register
“Trains on page 20 may help you.
Internal remarks are saved to every train but not printed.
Construction remarks, Train state and Order date help you at your daily work, especially
the different requirements of Train Operating Company and Railway Infrastructure Company
can be respected here.
The property Train consist majority of coaching stock sets the formula to calculate the
run resistance if filled in only length and train mass. The train typesets this property
automatically so that you only need to activate this manually if you do not use a standard
train type.
If you mark Train is parked the train is not respected by slot search. All this trains get a grey
train line and label. So the train needs not be moved away and later back to the time he
should run. Other trains do not respect parked trains but respect all other trains at slot
search.
The conflict check continues working, so that a conflict involving a parked train is shown by
red warning sign. The parked trains are named in the conflict list too, also if they do not have
any conflict.
For dispo mode look at chapter 3.5.4, page 78.

3.3.11

Copy train

This function copies the train. The new train has the same data as the original and so you will
get a conflict automatically. To solve this problem you have to change train data. You can
use other operation days or other departure times. This function is helpful to get a train with
the same data.

3.3.12

Copy train in interval

This function is similar to copy a train but the trains created
here are copied in an interval. The train numbers of these trains
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are counted in an interval too. The function can be opened by Alt+T or Construction >
Copy train in intervals…
To use the function you have to fill in the number of copied trains, the interval time and the
steps between the train numbers. The time interval has to be filled in in hour.minute or
hour.minute,tenth like in all FBS programmes. The point between hour and minute can be
kept away but the comma must be set if you would like to use tenth.
 A 90-min-interval is set by “1.30“ or “130“!
For your later work you can group the interval trains. So you can select the option to extend
an existing group or to build a new group. So you have two possibilities:

 Create new interval groups is marked automatically if you create more than one
new train. This trains and the original train are grouped together.
 Extend existing interval group(s) can be marked if a train is copied which belongs
right now to a group.
Please note, the copies are made without a slot search. The trains are simple copied in the
interval distance and get another number. So you can get conflicts after using this function.
The existing conflicts are shown to you by a sign and listed in the conflict list. You have three
possible ways to solve the problems:

 You decide a higher priority for the trains in interval and move all disturbing trains
away.
 In a single case a change in the interval time is allowed because it cannot be avoided.
After creating the interval group you can move single trains without changing the
whole group.
 It is ideal to move the complete group of trains to solve the conflicts. So you keep the
idea of the interval timetable alive. iPLAN asks you to transfer the changing is to all
the other trains in the group.
If you would like to create only a copy of the train use the function Copy train (look at
chapter 3.3.11, page 69).
By copying the trains in interval all new created trains have the same properties as the
original train and are related to him – so interval groups are build.
So the programme saves the information, which trains belong to an interval group because of
the Copy-in-intervals-function.
If you later change properties of a train belonging to an interval group iPLAN asks you to
transfer the functions to all trains in-group. If you click Yes it will be differed between:

 After changing data in the train data window all trains get exactly the same data as
the train at which you changed the data. Only the train number and the train part
number are kept. It similar to delete all trains copied before, changing the first one
and copies them in interval again.
 During the timetable construction all other trains of the group get the arrival and
departure times and the exactly route section. All other properties are not changed
this way. So differences in the arrival and departure times in relation to the calculated
times are possibly wrong. If such a difference exists a yellow sign pops up.
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3.3.13

Park a train

A parked train is not respected by slot search and shown in grey. So you do not need to
move the train away and later back.
Any other trains do not respect parked trains but they respect all other trains by slot search.
All parked trains are named in the conflict list. So you get a warning sign if there is one or
more train parked.

3.3.14

Delete train

This function deletes the current train. If the undo-function is activated you can recreate the
train. There is also a question to make sure that you want to delete the train.

3.3.15

Show arrival and departure times

This menu point opens a window with a table of the run times of the train. This window can
also be reached by mouse menu (look at 3.3.1.2, page 54).
If you marked a line and open the context menu you can handle occupation times of the
current train. You can copy them or edit them manually. The data inside the clipboard will be
erased, if the original train is deleted.

3.3.16

Slot search until...

The function Slot search until… allows you to move train times only at a part of the line at not
until the end of the line or train. So you can choose slot search until Next token exchange
place or the end of the train or line. This is helpful if you would like to move a train only
between two stops and not at the complete line.

3.3.17

Enter departure time

This function allows you to enter the departure time at the station the current slot search
starts. So you can avoid long movments of the train line. The programme uses the next
possible slot to start trains run. That means you fill in the first time stap the train should start.

3.3.18

Enter stoppage time

You can change the stoppage time of the train in the station the slot search starts this way.
The programme uses then the next possible slot to start trains run.

3.3.19

Cancel preview

ESC
The preview of the possible slot stopps and the slot search is aborted. The train uses the slot
he used before you started slot search.

3.4 View Menu
3.4.1 Time
Ctrl+Enter
A window opens, in which you can fill in the start time to be shown. This way you change the
first shown time on the graphic timetable.
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3.4.2 Mouse buttons
or
This buttons have a defined function by a different design. To give you a view of the function
you should imagine the graphic timetable as a wheel with an admeasurement of 24 hours.
After that the timetable data repeats. You can turn this wheel by the two buttons on the left.
The first one turns the wheel this way, that you move the time one hour back and the second
one move the time one hour forward. The other buttons displace the wheel along the turning
axis so that the shown line section is moved. So this buttons are only available, if the line
resolution does not allow to show the whole length of the line on the given screen.
The design of the arrows turns 90 degrees, if you change the alignment of the graphic
timetable. Just for your imagination you bowl down the wheel.
As you have defined in chapter 3.2.12.1 starting at page 50 your paper size is set. So the
margins the title and the headlines are subtrahted so that the defined rectangle is fulfilled by
the graphic timetable.

3.4.3 Length/Time resolution

The resolution of the “graphic timetable wheel” is set by the
buttons. The left button
changes the Length resolution and the other one the Time resolution. You find predefined
scales there or can set a resolution by yourself. It is also possible to set the scale to show the
Line completly. You can pull down the time resolution down but it is not possible to show
more than 24 hours on one page.
Please note, that you change the shown part of the graphic timetable this way. If you would
like to zoom in and out the shown data only you might use the functions explained in chapter
3.6 at page 78.
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Turning and Moving of the
“graphic timetable wheel“

Setting paper
size and
orientation:

Moving the visible part of the
paper on your screen:

(Setting the shown part on
the paper by):
, scroll bars
,
arrow buttons, mouse wheel
or Ctrl+Enter

(Edit display
settings)

Zooming in/out of the shown part
of the paper on your screen by:

Alt+Mouse, Ctrl+mouse wheel

3.4.4 Wählen
Weekdays
der Rollengröße
or(Strecken
Alt+W und Stauchen):
Normally all trains are shown in graphic timetable. If it is too heavy you can reduce the trains
by week or operation days. Here you can use the same principle to mark the operation days.
Please note if you select “Mo” the trains operating at Monday and the trains operating on
Public holiday are shown. The common day is the public holiday on a Monday. If you would
fill in MoXS you will see only trains operating on Monday at not on public holidays.
If the timetable period is defined you can use the words today, tomorrow or the day after
tomorrow to show the timetable for these days.
The symbol
Weekdays is marked with a red tick if not all operation days are to be seen.
This symbol shows you the limitation of operation days and helps you to search for trains,
which are not seen.
If a period is defined the button More… leads you to a calendar window, where you can
make detailed inputs. If you limit the operation days down to one day you can print a graphic
timetable for a concrete day.

 This function allows it to print blank control papers for you dispatchers or operators. It is
also possible to print timetables differed by operation days for example for WXS and Sa and
S. This may help you especially by the discussion of local train connections.

3.4.5 Timetable head
Alt+K
This option shows you the head of the timetable, as it will be printed. Normally the head is
not show to save space. So you can control settings made in infrastructure window and
change them if needed. To come back to your timetable you can hide the head of the
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timetable by another call up of Alt+K. If the head of timetable is shown, the tracks are also to
be seen.

3.4.6 Line tracks
Alt+G
This item shows you the Line tracks and the symbols of the stations and locations on top of
the abbreviations. This function is really helpful if single and double track sections change
often. If you click this option again the tracks are hided again. If you use Alt+K one of the
statuses shows you only line tracks too.

3.4.7 Station tracks

For your orientation which train uses which station track you can blend the station tracks.
The track names are shown in square brackets behind the arrival and the departure times.
Please note that the stations tracks are not only important for the right speed but also for
easy creating the correct station timetable. If you use the station tracks consequently you
might have less work at small stations to create the station timetable.

3.4.8 Occupation times
or Alt+Z
The classic railway science knows blocking time stairs, which tell you line usage, train
following distances and so the pass through and strength of your line. An iPLAN-user does
not need to take care for this blocking time stairs. iPLAN makes it in the background.
Some user or in some cases it can be interesting to have a look at the line usage in a
graphic. iPLAN is able to show you occupation time stairs by frames or filled with hatching.
Occupation time stairs are simplified blocking time stairs because they include only the time
a train needs to pass the section (including stops) and the pre- and past occupation times. A
blocking time stair includes also the times at which the blocking of the section starts and is
finished completely.
The formatting and the size of the occupation time stairs can be changed at the menu to be
found by the right the occupation time mouse button. This menu allows it to show the stairs
separate for every direction.
If you marked some trains and are interested only in their occupation time stairs you can
choose this item at the menu.

3.4.9 Connection times

This button shows you the Connection wait periods (look at chapter 3.2.11
starting at page 49) inside of the graphic timetable. The function of these times is
also only useable, if you can see them inside of the timetable. The departure of a
selected train is blocked if you would like depart inside of the connection wait
period. This function is only relevant for the train types you selected by configuring
them. The train can start before the connection wait period starts or after that. This
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way you can easily take care for connections between trains or other traffic systems.

3.4.10

Time labelling

In some cases and depending on the status of the timetable you can change the accuracy of
the shown times. It is possible to show the minutes and tenth, only half of the minute or full
minutes. The function has no influence to the exactness of the calculation but it can bring you
a better view on your timetable.
The additional information is related to the times can also be shown or hide here.

3.4.11

Slot conflicts

or Alt+C
iPLAN does not allow any timetable, which includes train conflicts. As you have read there
are situations in which conflicts can reach your timetable. For example by copying trains in
intervals, so one of the copied trains can
get in conflict to an existing train.
It would be possible to block all functions,
which would cause conflicts. But this will
not help you because you do not know why
the function was blocked. That is why a conflict check runs in the background and shows you
just after a few moments a red or yellow sign if a conflict exists. To stop spreading timetables
including conflicts the sign is also shown on every print you would like to produce to hint to
the conflict.
A list of conflicts tells you the train, the conflict type, the time and the Line section where the
conflict is situated. So you can decide which way you would resolve the conflict.
To find the conflict in the graphic timetable you can do a double click and iPLAN jumps to the
10-minute-limit before the conflict.

3.4.12

List of train parts

This window lists all train parts related to their train number, the train route section and the
vehicles defined for the train part. The list is sorted by the row of the train numbers.

3.4.13

Disposition

To use FBS as help for operators or dispatchers this mode is designed. The programme can
be used this way as a control sheet.
Select the weekday by help of the menu item (as seen in chapter 3.4.4, page 73).
The nominal position in the train diagram of every day running this day is shown grey. If the
first message reaches the operator he has to click the train and open the mouse menu. By
selecting item operate train the train is set in operation and gets the original colour. To be
reminded to the operating train it gets the operation day hint “actual”. You can edit the train in
all data. Normally you will only move the departure time at some stations. The conflict search
is also active in this mode but only active trains are checked. So the operator is able to make
previews to handle overhauls or train crossings. He is also able to see the effects of using a
reserve engine (by different series).
75

Chapter 3  Graphic Timetable
3.5  Analysis Menu

Documentation to FBS
Edition November 2015

At the end you get a complete control sheet at which you can see the differences between
the nominal run and the real run and can evaluate them.
Please note the following hints to this mode:

 To fill in a new train you can use the function add a new train. The operation day has
to be set as “actual”!
 The actual trains are added additionally to the nominal trains. The sum of all trains in
a timetable data is not allowed to raise 255 trains.
 The actual trains are saved in common in the complete timetable file. You should
make a copy for the actual date of the original file before the first train starts and
work with this copy. So the original file can be used as model and the working file
for the can be saved eventually.

3.5 Analysis Menu
3.5.1 Train data sheet
or Alt+X
This window shows you details to a selected train. You can see the arrival and departure
times, the used station tracks and other remarks.
Behind the button Display you can select the shown data. You even get a view to Critical
buffer times, if there exist buffer times below the limit you set there. The minimum buffer time
can be limited between 0,5 and 5 minutes. In the case of existing critical buffer times they are
shown in common with the critical train and the
section in which the problem is to be found.
The train data sheet has got a second page at
which you can find only the arrival and departure
times of all stations and locations and if marked
a train diagram and the parameters to get it and
the results of energy consumption.
The button Remarks opens a text window in
which you can fill in free text to give another user
hints to this train. It is thought as an electronic
notice sheet and is saved in the timetable file.
You can define a Period in a special window for
statistic calculations. You can differ between a
special period and a statistic period. The
special period is only useable inside the
timetable period, because it needs the concrete
definition of public holidays and the sum of every
weekday. The statistic period is used to get an
independent model to compare timetables. Further details you can read at chapter 3.5.2,
page 77.
To get the best details for your statistic you can select some options here.
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3.5.2 Statistics-table
At first to typical examples to use the statistic functions:

 Calculation of parameters of your timetable to do further calculations or
comparisons. To calculate mileage depending costs you have to count all miles
which trains run in the timetable.
 For later analysis of the real operation statistic data is need from the timetable.
Many parameters to build trains mean that the figures for a train depend on the mileage
and/or to the operation days.
At first you should define the period, which would be evaluated. So time
related data is ever relative to the current chosen period. So year does not mean in every
case year, it can be a special period or a statistic period.
The special period can be the period of the timetable or a part of the timetable period.
The statistic year is a method to calculate data independent from the current year. You
would better avoid this method but sometimes it is ordered by an organisation. To get more
informations to this method have a look at Annex – Statistic Data.
All listed data can be differed to the whole line or to the zones defined in
Infrastructure data > Zones. Both options are identical if there are no zones defined. The
evaluation can be also made for 1st class or 2nd class and all the other options to be seen
there.
This column can sort all lists with a little arrow inside. Just click at it to change the sorting
direction. Please note that the lists are sorted alphanumeric and not by the numbers.
You can export the tables in the clipboard or in files as text or as a Rich-Text-Formatting. The
file type can be chosen in the save as window.

3.5.3 Energy-Time-Spreading
This function is created to analyse the energy consumption in different periods. The window
consists of two parts. The first part sets the periods and the second part lists all the trains
inside of the graphic timetable. As default the period runs from 0.00 to 0.00. You can add
your own periods by adding new limits using the

button. Fill in the new limitation time by

the known hh.min,s format. If you marked a period and press the
button and a
confirmation asks you to delete the end of the current limit. The periods are saved for the
session and can be used in other opened fpl-files too.
The Refresh button reloads the data of the trains to the defined periods. At the end you can
see the list of trains including the head code, the total run time, the energy consumption
per run and the spreading to the periods. The shown value can be changed by the context
menu inside of the list. You can differ between energy spreading in percent (default), time
spreading in percent, absolute energy spreading or absolute time spreading.
The button Weekdays allows you to cut down the days included in the calculation. The
known from window from chapter 3.4.4 at page 73 is shown in which you can use the
checkboxes or the text field on the bottom to fill in your limitation.
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The whole list can be copied into clipboard and used in other programmes.

3.5.4 Evaluation
This function is not completely redesigned to respect the new functions like rout sections,
different operation days of train parts and so on. So you cannot use this function until the
redesign is finished. We apologize for any inconvenience.

3.6 Moving inside of the graphic timetable
3.6.1 Zoom in/out
In large graphic timetables it might be helpful to zoom into special parts, to control data or to
see more details for conflict handling. This can be done in two ways:

 You can zoom in positioning the mouse pointer at one of the corners of the zoom
area. Press the Alt button and move the mouse to the other edge of the zoom
window. The margins are shown on the screen to control the size of the window.
After leaving the Alt button the window is frozen on your screen. A click inside of
the window zooms in and a click outside of the window erases the window.
 You can change the zoom factor by typing a new zoom factor and pressing Enter
independent from the choosen mouse button in the toolbar. There are also predefined
relative functions available (Page width, Page height, Whole page) or often used
absolute zoom factors, which can be called up by a list.
 The
(+/- button at the keypad) buttons increase or decrease the zoom factor
by 50% at every click.
 You can skip between the current and the last zoom factor by F12.
By useing this functions you change the connection between the defined paper and the
shown contents on your screen as to be seen in the known graphic.

Turning and Moving of the
“graphic timetable wheel“

Setting paper
size and
orientation:

(Setting the shown part on
the paper by):

, scroll bars
Zooming in/out of the shown part
of the paper on your screen by:

,
arrow buttons, page
up/down, mouse wheel or

(Edit display
settings)
Alt+Mouse, Ctrl+mouse wheel

Ctrl+Enter
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3.6.2 Moving the current position
You can move easily inside of the graphic timetable. There are two functions available to
change the current position, which is shown to you without changing the settings for the
shown data on the paper:

 Move the mouse during you click inside of the graphic timetable.
 You can also use the vertical and horizontal scrollbars. If necessary you might
activate them in Options menu.

3.7 Further information
If you want to change data of a train please do it in a graphic timetable which includes the
whole train run (in your network). Otherwise you might have mixed data during trains runway.
This might bring you a lot of trouble at later steps in your work.
To get a graphic timetable for whole train run you can click a train in an open graphic
timetable and use the context menu. If you find the item Show graphic timetable of that
train you do not see the whole train in the current graphic timetable. The further steps are
explained at 3.1 at page 27 step 4.
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4 Driver’s timetables
4.1 Create a Driver’s timetable
Or Network > New Driver’s timetable...
If you have set a standard format for the Driver’s timetable you will reach at first the window
to select the train, which should be filled into the
timetable. If you have not selected a standard
format a window opens in which you have to choose
the format you would like to have for this Driver’s
timetable.
You can select one or more trains to create their
Driver’s timetables. On the bottom of the window
you can choose between the whole train’s route or
a section of train’s route only. By pressing the
Ok-button there will open another window in which you can mark the part of the route, which
should be printed in the Driver’s timetable. The timetable includes all informations, which are
relevant between the first and the last marked stations. This window does not appear, if the
whole route should be respected.
After that the object Driver’s timetable will be
created. If you marked more than one train and
you would like to create driver’s timetables only for
a section of train’s route, you will be asked for the
first and the last station, which should be included
to the next train’s timetable.
The data is taken from the whole route known by
this iPLAN-file. If all relevant data is handeld
carefully in the iPLAN-files you will have no or less
work to get the complete driver’s timetable. If you miss data in the driver’s timetable please
correct them in the graphic timetable and not manuall at the driver’s timetable. If these
changes are related to some trains it is faster than the manuall changing in some objects. By
doing this changes manually you will have to change this data in all driver’s timetables.
These changes are also lost if you use the Update button.
After loading the new driver’s timetable you will see the result of all collected data, which
includes in every case:
 Train number and head code in the headline,
 the start and end terminal of the run inside the defined network,
 as known in graphic timetable the remarks and special operting days of the train,
 engines series, maximum speed, load and minimum braking percentage (if this data
differes in different sections the data from the first section along the run is shown),
 stations and locations at which the train passes including the arrival and departure time
or the pass through time rounded to a complete minute,
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 absolute mileage of the stations and locations, maximum speed on the line and speed
changes between the stations and locatons; the speeds are taken from the graphic
timetable file, which is set for this train,
 entries for train crossings and overtakings, if it can be taken exactly from the timetable
file,
 entries for trains which have to stopp in front of home signal boards, if the other train
arrives earlier or later than the current,
 number of track inside the station, if it is selected in the station track useage at the
timetable file,
 abbreviations of train messages, which have to be send if they have been set in the
timetable file.
As you can see in this list, it is less work to do if you manage your graphic timetables
carefully.
All following explanations are related to the Standard design of driver’s timetable. If you use
your own design, some contents can be positioned at different places or can be filled in
additionally or kept away. The standard design shows the following stations and locations:
 all train order change places (also by status: out of use, under planning,
abandoned/withdrawn),
 all block signals, but not block posts,
 all access places,
 all stopps,
 political borders (it might be also a border of railway infrastructure company).
A change in the line classification is not shown, also not, if the owner (railway infrastructure
company) changes. If you would like to show this data set a location Country border in the
graphic timetable. This is also helpful to mark other control centres to be called in case of
emergencies or something else. Cab radio zones are also shown and are independent to the
country borders.

4.2 Customized driver’s timetables designs
The Standard design includes nearly all possible function in relation to driver’s timetables. It
is the only one, which is translated and this is also available in englisch, german, french and
if required in other languages.
All other designs are created by customers’ guidelines. So they are not generally accepted
and so not translated. New designed driver’s timetables are also delivered to other
customers, which use the same language to be able to create nonstop driver’s timetables.
The deliviering to other customers can be blocked, if you tell us. Changes to existing driver’s
timetables, which are not made for you, are not allowed.
If you need your own design call the service to define your design.

4.3 Driver’s timetable menu
4.3.1 Sychronisation with graphic timetables ...
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This function can only be used inside the Driver’s
timetable window.
If you have changed data inside your timetable files the
data of all objects in the networks, which link to this file
have to be checked. To do this as fast and as easy as
possible you can use this function.
A dialogue window opens. Here you can choose options
for data, which should be synchronised. So you can select only special data like arrival and
departure times or cab radio areas or set to Create whole driver’s timetable again. This
option delets the current data and builds a complete new driver’s timetable with the current
design. All manuall changes you made until now will be lost!

4.3.2 Calculation of minimum braking percentage...
The iPLAN programme collects all relevant data along the whole run of the train and
calculates the minimum braking percentage. So you will get a window with a table inside,
which includes all data for calculation. At the end you can adopt the result to fill it
automatically into the driver’s timetable or cancel the calculation.
By reaching the table from outside of the table a hint is shown to you, which contents the
next stations to give you information of the line section in which this part is positioned.

4.3.3 Calculation of required parking brake capacity...
This function is used to calculate the arrows along the driver’s timetable. The iPLAN
programme collects all relevant data along the whole run of the train and calculates the
required parking brake capacity to be shown as no, one or more arrows. So you will get a
window with a table inside, which includes all data for calculation. At the end you can adopt
the result to fill it automatically into the driver’s timetable or cancel the calculation.
By reaching the table from outside of the table a hint is shown to you, which contents the
next stations to give you information of the line section in which this part is positioned.

4.3.4 Graphic export

The created driver’s timetable can be saved as a graphic
file. By clicking this item a new window opens in which
you can choose the settings for the graphic.
Only the current page will be saved as a graphic file. So
you have to repeat this function for every page you would
like to have as a graphic file.
4.3.4.1

Part Graphic format

You can choose between three available formats:
 Win32 Enhanced Metafile,
 Bitmap or
 JPEG.
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4.3.4.2

Part Graphic dimension in Pixels

The dimension can be set in pixels for Width and Height. Some options are available to get
a pleasant look of the driver’s timetable.
4.3.4.3

Part “Margins”

The margins can be kept away from the graphic file or can be used proportional to original
or unchanged to original.
4.3.4.4

Part “Background colour”

The background colour can be changed by your requirements by clicking the coloured box.
You can select the new background colour by a Windows®-colour change window. For some
useages it might be helpful if the background would be transparent, so you can also this
“colour”.
4.3.4.5

Part “Destination of export”

The graphic can be copied to the clipboard to be inserted into other programmes or can be
saved as file at the position you selected.
4.3.4.6

Part “Graphic qualitiy”

If you would like to save the graphic as a *.jpeg, you can also set the qualitiy of the file.
4.3.4.7

Preview

The preview button opens another part of the graphic export window. So you can see the
result of your settings and can correct them on the right of the window by the functions to be
seen there.

4.3.5 Print
or

or Ctrl+P

The known FBS-print-dialogue opens. So it is not explained here again.

4.4 Edit Menu
4.4.1 General settings

4.4.1.1

Part “Paper alignment”

The papaer aliment allows you to set the size, which is usable for the driver’s timetable. As
default DIN A5 in vertical direction is used. You can also use individual sizes.
4.4.1.2

Part “Margins”

To have a margin at every side of the paper you can set here the size of them.
4.4.1.3

Part “Layout”

At first you can see here the Format of the Driver’s timetable. You can change the format
here, but please take care, that the programme wants to create a new driver’s timetable if the
contents are diffrent. So all manual changes get lost. This function is only helpful if you did
not do any manual changes or for a check of other formats.
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The Number of first page can be set here to include the whole Driver’s timetable into an
existing or new Driver’s timetables book.
As usual in all FBS-timetables you can change here the Rounding rule for arrival-/
departure time. We advise you to round of all times,
so that the driver will not get the feeling of beeing to
fast. This can happen, if you select round
mathematically and the train should pass regularly at
min x,5.
Some information should be written in the Head- &
footlines at every page of this Driver’s timetable. So
the button calls up a shortcut to the Head- & footlines
window. Further information to handle them you can
find at chapter Edit Menu>Head- & Footlines on page
88.
4.4.1.4

Part “Display in column for speeds”

The handling of speed restrictions along the run of the train is handled different from operator
to operator. So you can display all line speeds independent from the maximum speed of
the train. To avoid misunderstandings it is better to Limit line speeds to maximum speed
of train so that there is no speed to be seen, which is higher than the maximum speed of the
train. If you choose this option, you can display speed restrictions for this train only so
some speed restrictions are not to bee seen, because the train is not allowed to run so fast. It
is also possible to display the maximum speed of the train in these situations, so the
driver can control the maximum speed for his train by the Driver’s timetable. This is the way
to get the highest safety into the system of speeds so it is default for the standard format.
For you information you can see the Original train number on the bottom of the window.

4.4.2 Edit contents
or Ctrl+Enter
4.4.2.1

Preliminary note – to be
read absolute

You can change every Driver’s
timetable by yourself. In an extreme
case you can create a complete new
Driver’s timetable, which has nothing
in common with data at the timetable
files. This function is not made for
that purpose.
In every case you have to check
before printing Driver’s timetables the
following data manual:
 Checking of Minimum braking
percentage and the Braking
switch. If you did not
calculate
the
graphic
timetable
by
minimum
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braking percentage, fill in the minimum braking percentage and add the related
Braking switch. iPLAN uses only blanket data.
 Check the mileage of every speed restriction (speed change) along the whole run.
 Check and complete the data in the column train messages (if it exists). The
automated entries cannot be used unmodified in every case.
 If there are more train crossings to be done in a station or other longer entries exist, it
can happen, that this text is placed in the height of another station. For a better
overview you should fill in blank lines to get some free space.
 To detect a train crossing, there exist three ways. Also so called “half crossings” are
included:
 “real (normal) train crossing”: Inside the graphic timetable at a single track line a train
running in the other direction arrives before the own arrival and starts after the own
departure,
 “half crossing departing“: Inside a single track line section another train, ending at this
station arrives inside 20 minutes before the own arrival,
 “half crossing incoming“: Inside the graphic timetable at a single-track route section
another train starts in 20 minutes after the own arrival.
 To detect overtaking, there exist two possibilities. In this case only “real” overtaking can
be detected:
 Overtaking another train: another train running in the same direction arrives earlier and
leaves after the own arrival,
 To be overtaken by another train: Another train running in the same direction arrives
later and leaves before the own departure.
 It goes without saying, that not all detected cases are correct and make sense. So
reoperation should be done. The programme does not know, whether there is a
signalman at the station or not and if the entries in the column Crossing
with/Overtaking are necessary. Read the following parts how to edit the entries of
train crossings and overtaking.
It has to be annotated here, that the authors of the programme exclude liability for situations,
which are caused by wrong or questionable data in the Driver’s timetable. The automatic
created Driver’s timetables cannot be used possibly without a review! Printing of Driver’s
timetables without postprocessing is an incorrect use of the programme. The Railway
Infrastructure Company has the complete liability for the correctness of Driver’s timetables.
Last but not least you are able to edit every information manual.
If you have problems or questions by producing the correct topic, please call service. We try
to help you by hints or programming.
It is helpful to wait for editing Driver’s timetables until you need them, especially if you know,
that the graphic timetables might be changed. By a synchronisation your manual changes
can get lost, so that you have to fill them in again. We cannot give you a guaranty that all
your changes are kept alive.
4.4.2.2

Editing Head

The head includes the train type, the train number and the operation days of the train, if he
does not operate every day. The typeface of these lines is fixed by the design of the Driver’s
timetable and cannot be changed.
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The next line is reserved for trains’ route so it includes the start and the end terminal of the
train.
The next line includes hints for example for the period of this Driver’s timetable. The
programme does not fill this line and so it can be used for other hints to the driver.
4.4.2.3

Further information in the head of the Driver’s timetable

The small printed lines in the head o the Driver’s timetable show information, which have
been the basement for the calculation and so for the usage of this paper. The driver can
check the data of the current train and the content of the Driver’s timetable to make
conclusions about the truth of the content. For example if a freight train has not the load by
which he was calculated he might be faster and so he can accelerate slower as normal.
So you have four boxes to fill in this information. The boxes are titled to find the information
in every Driver’s timetable at the same position. So a Driver’s timetable includes information
about the Maximum speed of the train composition, the (working) engines, the Load or
Coaches and Waggons and the Brake settings.
4.4.2.4

Editing a Driver’s timetable line

Double click a line or Context menu > Edit line

A relative mileage related to the start of the Driver’s timetable sorts the lines inside the
Driver’s timetable. This mileage is only important for sorting and so it is not shown. So it is
also not interesting if this data is correct.
If you fill in new lines manually, you can use every mileage between the existing lines. Only
the absolute mileage is shown, if the entry exists.
The usage of every field in the Edit line of driver’s timetable window depends on the format
you have chosen. Only less formats use all entries. Especially the fields for Crossing with
train and Overtaken by or from are used seldom.
In Germany Wavy lines are used to show the driver how many hand brakes have to be used
to keep the waggons in the current gradient. So the locomotive is not calculated, to be able
to keep the waggons alone and use the engine for other jobs. This data is only used in
exceptional circumstances – so very seldom. If you want to use this information to, you can
change the number of Wavy lines in this window too. The wavy lines do not have their own
start or end line. They start with the last line being shown end finish with the next line of
driver’s timetable. The system in Germany is calculated by an effective gradient of 50 m is
higher than 10 % and continues for more than 50 metres. If the gradient is higher than 20 %
two wavy lines are used and so on.
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The field Maximum speed of train from here and Maximum line speed from here can be
empty, if the values do not change here. If this values change here, you have to fill in both
speeds, that iPLAN is able to differ, which speed is relevant for the train. The maximum
speed of the train can change along the run by adding or leaving waggons or for run time
calculation reasons.
Train crossings and Overtaking are detected and filled in automatically as written above.
Train crossings and Overtaking in stations, in which one of the train changes the graphic
timetable are only detected and filled in correct, if the arrival and departure time of both trains
are to be found in one graphic timetable.
The row of entering a station is filled in standard format only, if the station has the property
Without home signals (look at 3.2.10.4 at page 39).
The column Reports includes all Train messages, which are found in the graphic
timetables. To find out who has to send this message, iPLAN looks in to the track data to find
out, if the station is unstaffed so that the message has to be sent by train’s crew. So the
guard is shown, otherwise signm. (signal man) is set to explain, that this message is send by
the staff of the station.
An empty line in a Driver’s timetable can be made by the function Insert line before or above
the current line. Fill in some space characters, so that the programme does not ignore the
line. A line without any content would not be shown, because of no information in the line.
The context menu allows you also to delete a line, if you are sure, that
this line is not needed. This way of erasing a line has the
disadvantage, that this line will be detected as a change by
synchronisation the Driver’s timetable to the graphic timetables. It can
be blocked by clicking the box Hide this line.
The edit window allows you to set a Page break after this line.
4.4.2.5

Special characters...
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Driver’s timetables use normally
an FBS-own font, to be able to
show all rail specific special
characters. Special characters
can be used in every input field
to show special information. To
insert a special character click
move the cursor to the position
of the special character and use
the button Special characters.
The programme knows the last
used characters and the last
shown group of characters.
There exist several groups of signs. If you cannot find the symbol you are interested in, you
can call the service to help you.
4.4.2.6

Footers

Sometimes it is necessary to explain an entry by more details. So you can use footers to give
more information to all data outside the table. Move the cursor to the position of the footer
and press the Footer-button.
At first choose Footer’s character out of the list and
then fill in the Footer’s text. You can also use here
Special characters, if you want.
By using the context menu inside the part footers of
the edit driver’s timetable window you can select the
positioning of the footers at the First page, last page
or all pages.

4.4.3 Head- & Footlines

Head- and footlines are written in the margin always. Headlines run from the margin line up,
footlines down. An optional parting line is drawn exactly on the margin line.
The head- and footlines are shown on every page, which is created inside the object.
Alignment of headlines and footlines text can be
managed by sequences of control characters. Text is
aligned as default (i. e. without any input) to the left.
You can realize a centric or right-justified alignment
by use of control characters <M> and <R>. The
alignment concerns text, which follows a sequence of
control characters up to the next sequence of control
characters or up to the end of line.
You can input sequences of control characters as well as following macros by using the right
mouse button.
Available macros are:
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«PageNr»

= current page number

«FirstDate»

= first day of timetable period*

«LastDate»

= last day of timetable period*

«Date»

= current date

«Time»

= current time

«ObjDate»

= date of previous modification of object

«ObjTime»

= time of previous modification of object

«FileDate»

= previous date of saving *.ntz-file

«FileTime»

= previous time of saving *.ntz-file

«ObjName»

= name of object

«NetzName»

= name of iPLAN-network

«FileName»

= *.ntz-filename without path

«FileNameAndPath»

= *.ntz-filename with path

«FilePath»

= path of *.ntz-file

«LizName»

= name of FBS-license

«SerNr»

= serial number of FBS-license

«LizVers»

= version of FBS-license

«CurrentUser»

= current user of windows login

«LogoXxxxxx»

= logo picture-file (see below)

«EditUser»

= username of previous modification of the object

* First and last day of timetable period can be displayed only, if the periods of all involved
timetables are defined and equal.
Within the keywords of macros there is case sensitivity. Date and time indication use preset
formats from system control.
In order to display the logo, which is declared at options / configuration / operator-logo,
following format can be given:
«LogoLxxxxx»

= logo aligned at left margin

«LogoMxxxxx»

= logo aligned at centre of page

«LogoRxxxxx»

= logo aligned at right margin
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If the logo is aligned centric, eventually also centric aligned text is displayed above the logo.
There has to follow either a two digit declaration of height (in mm) or two digit declarations in
the specified manner <width>x<height> (e.g. 11x22) after the keyword. If the height is
declared only, the width will be calculated proportionally to the height analogical to the logo's
original ratio of dimensions. If both dimensions are declared, they have to be separated by x.
Valid declarations are e. g.:
«LogoR10»

= logo aligned right, 10 mm high, width proportional

«LogoL08x15»

= logo aligned left, dimensions 8 x 15 mm.

You can also use Special characters inside the Head- and footlines.
The context menu gives you also the possibility to change the Type size for headlines and
footlines texts. Please position the cursor before you choose this function to the beginning of
the fields.
For a better view you can set the Distance to page margin … by context menu.

4.5 View Menu
4.5.1 Zoom in/out
or + (at keypad) as the case may be

or – (at keypad)

For a better control of the readability of the driver’s timetable you can zoom in and out. You
can also use the list on the right
of the window to use specific values of
zooming. If you would like to
have a zoom size, which is not included in
the list, you can also fill in a value manually.

4.5.2 Previous/Next page
or Page up as the case may be

or Page down

This function is needed to move between the different pages of one driver’s timetable. You
can only see one page a time. So do not forget to check all pages before printing these
drivers’s timetable.

4.5.3 Display margins

To control the position of the margins you can show or hide them. This might be helpful if you
use headlines and footlines.

4.5.4 Display legend
If you are interested in displaying the headlines of the columns of the driver’s timetable. You
can differ between three options:
 off,
 at first page only,
 at all pages.
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4.6 Functions fore some Driver’s timetables
All this functions are only available by the context menu in
the objects parts. The details about this menu items are
written here because it might be easier to understand this
functions if you know at first how to handle driver’s
timetables.
For all the function you have to select at first the driver’s timetables, which you would like to
use for the function.

4.6.1 Edit all selected Driver’s timetables
This function allows you to exchange data inside of the selected driver’s timetables. So you
can Add or replace text in all fields with the title you can choose by a list. You can select
four possibilities to fill in the new text into new lines before, or behind or into last existing
line or Search and replace an existing text. You can also delete all existing text and
replace with the following text as written in the field.
You can also Add or replace a complete line as found by
the km, abbreviation of a station or station name. After
choosing the search criteria you can select the function,
which should be done there to Insert a new line at the
given place, Insert a new line behind the given existing
line or Replace an existing line by the new one, which
can be defined behind the button Contents of the new
line….
After Ok the programme does all the choosen activities.
This way you can edit driver’s timetables quickly.

4.6.2 Mail merge of driver’ timetables

4.6.2.1

Part “Printer”

You can choose here the
printer you would like to use for
printing the driver’s timetables.
Your computer and printer set
all the functions here. The
items here are normal windows
style.
4.6.2.2

Part “Paper size and alignment”

Here you can change the direction of the printed-paper.
4.6.2.3

Part “Margins”

You can set here the current margins for printing. These margins can differ to default values
of margins. The changes here have no influence to the default values.
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4.6.2.4

Part “Print range”

The range of the printed driver’s timetable can be set to all Driver’s timetables or the
selected Driver’s timetables only. In brackets you can see the number of the selected
driver’s timetables. The Driver’s timetables will be printed in their order in the list of objects.
You can change the order with the functions “Move object up/down”.
4.6.2.5

Part “Page numbering”

To Keep existing numbers of Driver’s timetables you can select this option. For a better
handling you can Renumber all pages new, beginning with a page number selected by
you. This way is only useable, if you used the field «PageNr» in your Driver’s timetables.
Otherwise iPLAN is not able to print the new page numbers.

4.6.3 Summarize driver’s timetable
Normally most or all Driver’s timetables are summarized in a loose-leaf. To create a table of
contents, there exists the function Summarize Driver’s timetable in the context menu of a
Driver’s timetable. The following window is designed to configure the table of contents of the
“book”. If you have selected the information you would like to have there, you will reach the
print preview. Here you can change typeface and other formats of the text. These settings
cannot be saved, because at the next call, you might use other settings.
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5 Customer’s timetable
5.1 Preliminary note
5.1.1 General
Customer’s timetables can be created in FBS along any lines, line combinations or line
sections, which are summarized in one network. The following comments understand a
Customer’s timetable as a schedule for one relation. This relation can include branches
separated by direction of travel. A Customer’s timetable can consist of some tables
depending on the size of paper and the number of trains. In general you need to create two
independent schedules – one for each direction.
Customer’s timetables are saved as a object inside the *.ntz-file.

5.1.2 Hints to times published in schedules
In opposition to timetables used inside the railway system (graphic or driver’s timetable, …)
customer’s timetables are mostly published. The tenth of a minute are not shown there to
keep the overview to the large table of times. It is not attractive to round the tenth in
mathematical way, because a rounding up means, that the train departures earlier es
published to the customers. So nearly all customers’ timetables show you rounded down
times. It would be possible to use the worst case rounding up for arrival times but this can
result negative stoppage times in the customer’s timetable.
The rounding down system has the effect the times between the arrival of the own train and
the departure of the connecting train seems to be longer as it is.
The whole probleme “published times in schedules” is old, but canot be disregarded. Today it
is solved by the timetable construction to use departure times at complete minutes or shortly
after complete minutes.
You can set the Rounding rule in Register “Layout & content” inside
the “View” window. Default rule is the UIC.

5.1.3 Layout-variants
Before you start creating customers’ timetables you should inform yourself to the layouts,
which could be made by FBS. We suggest you to set a default layout before you start
producing customers’ timetables at the configuration. You can change the layout later, but
some symbols have to be changed manual to get an exact switch to the other layout. You
can change the layout complettly if you reload the trains from the graphic timetable.
The UIC defines the customter’s timetable layouts in two ways: The hot type and the
photosetting. These terms are taken from printing and can be use here in the name of the
layout and not the way of printing because only fewer timetables around FBS are typesetted.
The decision of the layout, which would be used for your timetables, is in your hand and not
given by the programme. It is also possible to combine parts of the layout from one face to
the other. At the end FBS is not as flexible as a manuall setting of the customers timetable
could be, but it gives you a lot of possibilities to create a schedule in a practicable way. We
think it is the best way between optimized readability and fast, automatic creation of
customers’ timetables.
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The layout can be set in the Options menu > Configuration > Customer’s timetable
(chapter Register “Customer’s timetable at page 23). The individual settings are explained in
chapter Register “Customer’s timetable at page 23. It might be the best way to try both
variants and decide than, which one you would prefer and which changes should be done. A
possible mixture of both layouts is the adjusted photosetting as created by FBS.

5.1.4 Limitations of Layout
As said at the beginning, FBS is not able to create all known cases of customer’s timetables.
The limitations are as follows:
 The original hot type could show trains, which are shared in a part of their run, in one
column at split them at the part of the line, which thay run shared. This is not possible
in FBS. Both parts of the train need their own coloumn above the whole run of the
train. You do not need more space and both entries can have the same head code of
the train.
 There has been a special face for lines with less traffic. So the stations have been
positioned in the middle of the table and the trains in one direction were shown on the
left and the other direction on the right of the stations. The trains in one direction had
to be read from up to down and the other direction from down to up. This is also not
possible in FBS. You have to create separate schedules for each direction.
 In hot type the train run informations are shown by ovale, negative printed footers. We
are sorry, but it was not possible to position these special characters inside the FBS
font. You could use the rectangular symbols too. The difference between the
rectangular and oval signs is not so big. This problem is also not so important, if you
use train-running rows.
 The distance is often shown only at the first table of a direction. The following tables
and the opposite direction often have not this information. In FBS you can show the
distance completely or hide the distance at all tables. The distances can be shown by
an exactness of tenth of kilometres. If you use another system to calculate the tariff
as the distance you should use a hint at the beginning of your book of timetables but
not keep the distance information away.

5.2 Adding a new Customer’s timetable
An assitent helps you to get a new customer’s timetable. He collects all informations that are
needed to create the schedule. The data to select the train to be shown inside the customer’s
timetable can be changed later on.
Plase note that you have to create a *.ntz-file to
create a customer’s timetable, also if you would like
to have a timetable for only one line.
Step 1: Select relation
After clicking the Create new customer’s
timetable-button the first part of the assistant opens.
The list inside the window shows all selected
stations for the customer’s timetable. You have to
choose at least the first and the last station of the
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schedule. This has to be done by clicking the boxes of the stations inside the network
graphic. Normally there are only the important stations to be seen, which are often the first
and the last station of a customer’s timetable too. If you would like to create a customer’s
timetable starting or ending at stations, which are at the moment not inside the graphic, use
the next stations outside the customer’s timetables, which are included in the graphic. If you
have choosen the wrong station you can delete here by a double click inside the list.
If you have some possible ways to get from the first to the last station you should select the
stations along the line by yourself by the first, the intermediate stations and then the last
station. The selected intermediate stations are printed in bold inside the schedule. Branches
can be filled in later. If you have choosen the main line of your customer’s timetable press
the Continue button.
Step 2: Adding branches
If the schedule shall include branches you should answer the question with yes. So another
window opens in which you can select the (first) branch by the same system as the main line.
Select at first the station in which the branch is connected to the main line and after that the
end station of the branch. It is not possible to add lines, which have no connection to the
main line. After Ok you set the direction of trains, which should be shown inside the
customer’s timetable.
After this you come back to the step to select a branch. You can repeat it as often as you
want, but please take care of the readability of the customer’s timetable. It is not possible to
create schedules with more than 255 station lines. Two or three branches are mostly enough
for one timetable to understand which train runs which line.
Step 3: Layout and Headlines
This window allows you to change the Layout-Variant from the default to the special variant.
Here you can also fill in the Number or head-code for the chart and the Title of the
customer’s timetable. You can just design the title in the style written in Register “Title &
remark at page 100.
Step 4: Edit stations
After completing the selection of lines the Edit station window opens. All the functions, which
can be done inside this window are explained in chapter Stations at page 98.
Step 5: Adopt trains
Now you can choose all limitations to add trains to the customer’s timetable. As standard
only the public passenger train types to be filled in are marked. The chapter Reload the
whole customer’s timetable at page 105 tells you all the settings you can do here further.
After that, the customer’s timetable is being created and shown to you in a window. Right
now you can edit the train table or change the headlines or everything else.



Hint: Alle examples inside the documentation or delivered files for the programmes and
timetables of existing railway companies or train lines do not show you the real data.
Sometimes the data is change to show special effects and functions of the programmes.
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Simple customer’s timetable in hot type

5.3 Timetable Menu
5.3.1 Print
or

or Ctrl+P

Here you find some hints for printing a customer’s timetable:
 You can print the customer’s timetable by using every printer being correctly installed
by Windows®. We advise you to print these timetables not smaller than DIN A4 and
to sizen them outside of FBS before final printing.
 Caused by different resolutions of the screen and the printer it can happen, that the
design of the print is different to the design on the screen. The resolution of the
printer is normally higher than the screen, so that it is possible to bring more
information in a line by printing. If there are only less trains inside the last table this
table can be removed in some cases if it is possible to show more trains in one table
as to be seen on the screen. The resolution on your screen is sized by FBS, that you
are able to read all the signs, which are arranged inside the customer’s timetable.
Maybe you can change some parameters after a look at the print preview given to
you by the Print function. It can happen, that the result of the print looks different to
the print preview. This depends on the font settings and the printer driver, so that we
have no influence to this problem. Finally you can check this only by some tests.
 Not only the settings in the print window have influence to the schedules also the
colour- and size settings made in View-function at page 99 and the parameters set
inside the Configuration as explained starting at page 20.
 The Standard type size inside the schedule books is 2 mm including the line distance,
which is also used as default in FBS. If it is possible for you to use larger sizes (2,5 to
3 mm), please use them, especially for posters or flyers. (look at Part “Table at page
99 to edit the type size)
 Caused by a lot of small signs and symbols you should use a printer for customer’s
timetables, which as a high resolution. We advise you to use a laser printer with more
than 600 dpi (dots per inch) for producing large numbers of customer’s timetables.
Special or coloured tables for example for a poster should not be printed with less
than 720 dpi. Do not print below 300 dpi!
 If your printer driver includes the option: Print a graphic as grid pattern or bitmap,
TrueType-Fonts as graphic, print unidirection please switch them on. If you have
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problems by printing, please check whether you can deactivate the memory inside
the printer and use the function: create graphic inside the computers memory.
 Normally the first print is not perfect. Try some settings and write them down to use
them again.
All the functions inside the Print window are similar to them explained in chapters before, so
they are not repeated here again.

5.3.2 Export

5.3.2.1

Register “Export as text”

You are able to export the customer’s timetable into a text file.
5.3.2.1.1

Part “Output format”

Here you can select 8- or 16-bit-unicode text or 8 bit text in the character set, which has
to be taken from the shown list.
5.3.2.1.2

Part “Special characters”

Special characters are not defined in the normal font
sets so that you could get in trouble with them. You
can replace by normal text, if it is possible
(operation days, and symbols for running through,
diversion or wavy line are possible, multiple unit,
sleepers and so one are not possible) or Do not
replace special characters, but export them
unchanged. To read them correct in the text file you
need special software or a unicode set of characters
to display.
5.3.2.1.3

Part “Destination of export”

To export the data to the right position you can choose to export the data to the Clipboard or
the a *.txt-File in the directory given by the save as-window (…) or filled in manually.
5.3.2.2

Register “Export as graphic”

All the functions are similar to them, which are explained in chapter 4.3>Graphic export at
page 82.
Hint: For exchanging the customer’s timetables for professional publishing to a print office ths
PostScript- or Adobe-Acrobat-files are usually used. These files can be produces by the
Print-function as explained above.

5.3.3 Other functions
All other functions here a similar to the functions explained in the chapters before and so
they are not written here again.
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5.4 Edit Menu
5.4.1 Stations
or Alt+Z
5.4.1.1

Part “List of all operating locations”

This list shows you all stations and locations along the customer’s timetable. They are sorted
at first by the Line part and than by the mileage depending on the direction of the running
trains.
To add a station from this list into the
customer’s timetable mark it and use the
arrow to the right table or double click at the
station.
The Edit place of access window opens to
set the data related to this station. This
window consists of two registers. The
Content register includes the settings to be
seen in the station column like Name, Tip
and Distance to be shown and only for
synchronisation the Abbreviation of
station.
The Display register sets the parameters for the data
shown in the station line. So you can change the format the
following ways:
 Write names of the station in bold type: This is
helpful to mark important stations or stations for
train changing.
 Indent row: This option is normally used for stations along diverted lines.
 Write whole rom in italics may also be used for diverted lines.
 Insert a splitting line after this row: A splitting line should divert Branches and main
lines. It is also used to divert arrival and departure times, if they are shown for one
station. The lines are also helpful for a better reading so they are used after more
than five rows.
 Combine station names with the following row: This
function is also used if you show the arrival and departure times
of a station in two following rows. So the station name is to be
seen only once and not two times.
 Highlight row by another background colour: To create
customer’s timetables, which are used as timetables posters at a
station you can highlight here the row of the station to get a faster
overview of the table. It is also possible to highlight some stations inside the timetable
to mark new stations or important stops for tourists. (Note: The different colour of a
background of the column is set in foreground and the background colour of a row is
set in background. So a background colour is to be seen in front.)
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5.4.1.2

Part “Rows of the chart”

This list shows all stations, which are included in the customer’s timetable. The column
Distance, Abbreviation, Name and Arrival/Departure time show the data to be seen inside
the timetable. The names are indenting, if this option is used. The rows, which should be
shown in bold type, are written here in bold too. The Format column shows you the
abbreviation of additional format settings as explained on the bottom of the table.
If you would like to change the settings for a station do a double click and you are back in the
Edit places of access window as explained above to edit the data.
The arrival and departure time property is set the following way: If a station is filled in the
first time the property is set to departure time. By filling in the station again the new row is
positioned above the existing row and the property is set to arrival time. The last station
inside the table becomes the arrival property too.
5.4.1.3

Part “Route of the timetable chart”

This table shows you the files of the lines, which are included, and the first and the last
station, which is to be seen in the List of all operating locations.

5.4.2 View
or Alt+A
This window is used for general settings of this customer’s timetable in addition to the
general settings made in Configuration-window as explaind starting at page 20. The window
is separated into two registers.
5.4.2.1
5.4.2.1.1

Register “Layout & content”
Part “Paper alignment”

Here you can set basic data for the used papers to print the timetables. You can choose the
DIN-A-formats or individual sizes defined by the Width and Height in mm. The orientation
can be changed here from Vertical to Horizontal or back.
5.4.2.1.2

Part “Margins”

Here you can set the margins at all sides of the paper. Default values are 20 mm.
5.4.2.1.3

Part “Layout”

This part sets the Format to Photosetting or Hot type. To number the pages during the
printing you can set the Number of first page for this customer’s timetable. Take care, that
customer’s timetables can use more than one page, depending on the number of stations
and the amount of trains.
The button Head- & footlines… give you a shortcut to the headlines and footlines settings
explained in Head- & foo at page 107.
5.4.2.1.4

Part “Table”

To get a timetable design by your way you can hide or show informations or use colours and
so on as explained as follows:
 Show distance column is
used to show or hide the
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distance along the customer’s timetable.
 Show train running rows shows the start and the end station of the train to be able to
find out trains running special relations directly. It is often used if there are trains
inside the timetable, which do not start or end inside the customer’s timetable. They
are only defined for photosetting but FBS allows you to use them in hot type too.
 Differing background colour: If you set Show train running rows this item appears
to set the backbround colour of the train running row. Click the button at the end of
the line and the known colour-changing window opens to set the colour.
 Use train forground/background colours takes the colour settings from the graphic
timetable and does not use the default colours for the entries. Do not forget to allow
coloured printing at your printer.
 Display train part number instand of train numbers might be helpful if trains with
completely different head codes run in one slot at the same time.
 Display legend below last/every table you can select here the positioning of the
legends. It is helfpful to use the legend after every table if the tables include a lot of
stations, so all the tables might be printed at several pages.
 Display timetable period in table’s title shows a bar above the tables with black
background and written in white colour the operation days for this table.
 Number of headlines in table: you can change here the number of lines in the
headline of every table to be able to show more information or to save space. If you
set the value to 0 the default value of the customer’s timetable format is used.
 Minimum width of the station column (blank) this size is used to set a minimum
width for the station column if you need this space to show all relevant information.
The size is set in blanks. If you set avoid incomplete train columns in Register
“Customer’s timetable at page 23 this size might be overstepped. If this option is not
used the station column is set to the width of blanks set here.
 Standard type size (mm) is used to set the size of the not bold types inside the station
and train columns including the distance of rows. All the other type sizes are handled
proportional. Default value is 2 mm, which should be used as an absolute minimum.
 Enlargement factor (%) allows you to enlarge the whole data inside the customer’s
timetable and not only the size of the types inside the tables.
 Rounding rule for arrival and departure times is used to change the rule for
rounding the times inside the customer’s timetables. Take care of the changed
informations to your customers and the consequences resulting by them.
The Copy from … button opens a window to copy the settings from another existing
customer’s timetable from all open *.ntz-files.
5.4.2.2

Register “Title & remarks”

The positioning of the Table No., Title, Remarks to the title depend on the choosen layout.
In hot type they are centered and in photosetting they are left-justified and framed.
Head of a customer’s timetable in hot type:

The same head in photosetting:
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You can edit here the following informations:
 The Table No. is normally the number of the line in your schedule book or the number
of train line. You can use here text, figures or Special characters.
 Title: Here you set the start and end station of the customer’s timetable and important
stations between them. If the timetable includes branches you can handle the
stations like a fraction. Set all branches in braces and separate the upper station up a
| from the down station. You can create difficult titles as you want be using the braces
and the |. The example shown above was filled in this way: Wernigerode - DreiAnnen-Hohne - {Brocken|Eisfelder Talmühle - Nordhausen Nord}
 Remarks to the title: can be a name of a line or hints to the operation days of this
schedule. The entries here a shown in italic.
 Remarks top right: Here are hints to be found to the classes, multiple unit or not,
narrow gauge railways and so on.
 Entry in the top left column of the chart: Normally the railway operation company is
shown here on top of the station column.
 Enter writing “Class”: sets the keyword “Class” in this field too to get a new row in the
headline of the chart to show hints to the class.
 Include logo file: you can also set a logo on top of the station column, which could be
a gif, jpg, jepg, bmp, ico, emf or wmf-file. You can use here also relative paths to the
logo by keywords <FBS>, <USER> and <OWNER> so that the logo is to be found
after moving the files on your computer. <FBS> means the path to the FBSprogramme; <OWNER> links to the path where the *.fpl- or *.ntz-file is saved and
<USER> shows to path own files as set in Windows®. By using the … button you
can select the file directly in an absolute path.
 General remarks in the header: are shown between the headline and the first table.
Normally you find here information to tariff or operation days of the schedule.
 General remarks under (each) chart: this remarks are repeated after each chart in
opposition to the legend, which is shown only once under the last chart of the tables.
There are often hints to other lines or stations, which are not linked by railways.
You can use in every field Special characters to show informations in symbols. The special
characters are the same as defined in the wholw FBS-family.
It is also possible to fill in the same Macros as explained in chapter Head- & Footlines at
page 88 in the following fields: Remarks to the title, Remarks top right, General remarks
in the header and General remarks under (each) chart. At the moment it is not possible to
fill them in by context menu, so it the easiest way to fill them in is to use the Copy & Paste
function from the Head- & Footlines window.

5.4.3 Edit train table
or Alt+T
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5.4.3.1

Preliminary note – to be read absolute!

After starting this function you are
able to edit every data inside the
customer’s timetable so that you can
have a completely different timetable
from the graphic timetable – including
all consequences. So the same rules
as explained in Preliminary note – to
be read absolute starting at page 84 are valid too.
For a better overview you can Fix station columns during scrolling inside the table. So they
are not moved like the other cells. If you reach the end of the screen the table moves
automatically horizontal to see more trains.
You can start editing the table the following ways:
 Mark a cell and call up the context menu by the right mouse button,
 Double click a cell,
 Mark a cell and press Enter.
The upper part of the window is separated into three parts. The first part is to be seen on the
left and includes all data related to the station columns. The second part is on top of the table
and includes all data related to a train like head code, general operation days and so on and
the third part are the cells for the times.
If you would like to mark some trains click at the part between the time cells and the train
headcode and hold the Ctrl key pressed.
5.4.3.2

Edit station data

You reach the Edit place of access window again to change the data. This window is still
explained in Edit Menu, Stations on page 98.
5.4.3.3

Edit general train data
Normally all data here is taken from the graphic timetable, so
that the fields are fullfiled automatically. Some train categories
could be hide by the configuration of the customer’s timetable,
so that these trains are not included in the table.
So the Train category, Train number and Train part
number(s) can be changed here.

The Operation days are filled in here to create the correct
symbol – depending on the layout (hot type or photosetting) if
the train does not operate daily. A unique footer inside the
legend rows shows the Special operation days. If you
change the special operation days, iPLAN tries to erase the
old legend entry and to create a new one. Please take care, that some train might use the
same legend entry.
Informations related to the whole train for special waggons (sleepers, dinning cars, …) are
shown inside the Class and general hints field. The classes are only shown, if they are not
standard. If all trains inside the customer’s timetable have the same classes of waggons it is
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normally shown in the head of the table. If you set the number of headlines in table
(View>Register “Layout & content>Part “Table at page 99) higher than 2 the lines are given
to this fields to get more informations to the train.
The fields Train runs from/to include the start and end station of the train, which are shown
inside the Train running rows, if they are activated (View>Register “Layout & content>Part
“Table at page 99). Every entry can use two lines in the width of the train columns. The
programme sets a line break automatically if a blank or divider could be found in the field.
iPLAN cannot do automatic syllable division, so that you should divide long station names by
yourself. A “hard” line break can be made by Enter-button.
If you use Train colours (View>Register “Layout & content>Part “Table at page 99) you can
see here the current colours for this train. You can change them by clicking the small boxes
behind the item and set a new Foreground or background colour. At the field behind these
items you can check the relation of the two colours. You can also Keep the background
colour of the sheet to keep the colour like the whole timetable. The foreground colour takes
the way from the Train number database to the graphic timetable to the customer’s timetable.
So you can change the colour at all this parts of the programme two, but have to be sure
about the consequences. That means if you change the colour in the train number database,
all trains of this train type get a new colour.
5.4.3.4

Edit time entries

A train column and a station row locate a time entry. It is
not necessary, that they have to be filled with a time. These
cells can also include nothing or symbols.
The time entry cells consist of two parts. A small part for
symbols is reserved on the left and a large part on the right
for the time.
5.4.3.4.1

Part “Add at the left margin of the column”

You can select here one of four predefined symbols or a
special character of footnote symbol. Some combinations of
the symbols are possible, but you cannot show more than
two of them. The symbol of the regular service days is
set automatically depending on the choosen format (photosetting or hot type) and the
operation days of the train. This works only, if a symbol is defined for this kind of operation
days. If this is not possible, you should use a Special character or footnote symbol and
explain the limitation of operation days in the legend.
5.4.3.4.2

Part “Show in the middle of the column”

If a time should be shown in the time cell on of the options Public stop, Operational stop
and Run through has to be choosen. So a field is shown in which you can fill in the time in
the known FBS-format. You can select for public stops also Mark as stop by request
symbol can be shown, if the station is not a general stop by request. If there is an operational
stop selected, it can be caused by Infrastructure company or Operator. By using another
line the Symbol for diversion should be shown. You can also fill in Text horizontal or
vertical for hints or train names for example. The cell you filled it in centers the vertical text.
So use a cell in the middle of the cells, which limit the space for the vertical text, to get a
better view. The text is not shown vertical inside the Edit train table window. It is also
possible to use Special characters as known from FBS-programme-family.
5.4.3.4.3

Part “Colours”
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It is also possible to set different colours to a cell. Clicking the boxes after the items can
change the colours and at the field on the right you can check the contrast of the chosen
colours. It is also possible to write the contents Exceptional in italic type. That means if the
entrie would normally shown italic it is shown normal and reverse.
5.4.3.5

Change row of trains

The trains are sorted by the time inside the table. You can move the whole train by drag the
cell with the train type and number and drop between two other trains.
5.4.3.6

Add a new train

Ctrl+Einfg
This function is normally designed for filling in empty columns or bus runs or rail replacement
bus services.
Click the train column after which you would fill in the new run. Use Ctrl+Einfg or the
Context menu item to start the function. A confirmation window helps you to check the
position of the new column. Now you can edit all the data in this column as explained in the
steps above.
5.4.3.7

Delete train(s)

Ctrl+Entf
To delete a train, which does not run any longer or something
else you can use this function. The whole train data will be
deleted after your confirmation.
5.4.3.8

Search & Replace

Ctrl+R
For faster editing of the table you can use a Search and
Replace function. A dialoque window opens in which you
have to fill in the Search string, select as minimum one of
the fields: Train category, Train number, Class and general hints, Train runs from or
Train runs to and fill in the new string. You can also use special characters to replace or to
be replaced.
5.4.3.9

Delete entry/entries

Del
This function delets the whole entry in this cell and replaces for example the departure time
by a symbol for Run through.
5.4.3.10 Operation day lettering
This function can be used for one or for selected trains to set or delete the operation day
lettering. The letters are taken from the operation days set in the graphic timetable.
5.4.3.11 Surcharge lettering
The surcharge lettering can also be used for one or for selected trains to set or delete the
letters for surcharge. The lettering depends on the train type.
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5.4.3.12 Copy times of this train
Ctrl+C
You can copy the data inside the time entries to use them by other trains inside this
customer’s timetable.
5.4.3.13 Paste copied times
Ctrl+V
The copied times can be filled into the marked column this way. If the copied times do not
replace or reach existing times the run through symbol is set in the lines, which have been
empty up to now.
5.4.3.14 Save table as…
It is possible to save the customer’s timetable as a grafik or text. Further details to this
function can be found in Export at page 97.
5.4.3.15 Synchronise

There are two possibilities to synchronise the data inside of your customer’s timetable. You
can Reload the whole customer’s timetable or Synchronise times and trains routes
only.
5.4.3.15.1 Reload the whole customer’s timetable
If you use this function the whole train data gets lost and you restart the creation of the
customer’s timetable. So you have to confirm, that you would like to use this function.
A window opens, which allows you to configure the trains to be shown inside the customer’s
timetable. As default Regional and Long distance trains ar marked. These are the train
categories, which are normally to be seen inside a customer’s timetable. You are also able to
show only the Public cargo trains or
Non-public cargo rains to get a cargot
schedule.
In
some
cases
also
Service/operational
train,
Empty
passenger trains, Empty cargo trains
or Light engines might also be
interessting. The links of train categories
to the groups used here are set in the
train number database as explained in
12.3 starting at page 150.
You can also select In addition/In no
case adopt trains of the following
categorie(s) to show or hide special
categories. So you can hide night trains
or other train types if you like to. It is also
possible to show or hide train lines by the
function In addition/In no case adopt
trains of following line(s). You can fill
them in manually or use the arrow on the
right of the field to select them by all
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categories used inside the current network.
If you would like to create customer’s timetables for several operation days you can also do a
Selection of days of operation in opposition to Adopt trains of all days of operation
(daily). This might be usefull if the trains operate at different slots for example at weekend
and during Monday to Friday. To set the selection the known Calendar window opens to
Define special service days for Customer’s timetable. You can use here all known
functions for this window, which are explained in Annex – Declaration of operation days
starting at page 162. You are also able to exclude periods (if the timetable period is defined
inside the graphic timetable), in which special timetables are in use. If you did not define the
days correctly you can reactivate this window by toggling the days of operations.
To Adopt trains only, which have at least one arrival or departure time within the
following time window you can limit the shown trains further. This might be helpful if you
would like to show only one or two interval period(s) in a customer’s timetable. The times
have to be filled in the known FBS-style.
If you created a customer’s timetable within branches or other lines it might be possible that
trains run in a section the “wrong” direction to use another part of the customer’s timetable in
the correct direction. So you can use a Restrictive direction detection to show only the
trains, which have raising times in all section or use Advanced direction detection so that
trains are shown, which have a minimum of section in which the time steps are raising up.
Normally only traffic stops are included in the customer’s timetable to keep the overview and
to avoid discussions of overlooked signs of running through trains. If you are interested in
showing these times you can Consider through running trains too and show theire times
of through running. It is also possible to Consider trains with operational stops too and to
show these stops. You cannot activate the running through times without activating the
operational stops.
To avoid single time entries by reaching or leaving a branch or other line you can Do not
show times, which are separated a section.
Coupled trains parts can be adopted in three ways:
 In separated columns,
 With different first or last stations separately or
 Fundamentally in one column only.
This setting should be handled carefully. If you show coupled train parts in separated
columns it is difficult for the customer’s to find out, that this two trains operating the same
times run as one train. If you show them only in one column the information of trains, which
leave the other train part inside the customer’s timetable cannot be found as trains operating
coupled in the section before. So the middle way might be the best way so that only this
coupled trains are shown in separate columns, which have different
first or last stations.
In the right bottom corner you can see Further settings for symbols,
which are taken from the train data to show special informations to the
passengers. These symbols can be choosen by the button on the right
of the list.
By pressing Ok the new data is collected and sorted in the customer’s timetable.
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5.4.3.15.2 Synchronise times and trains routes only
This option keeps the whole data
of the customer’s timetable alive
and looks for (saved) changings
inside all graphic timetables for the
trains include in the schedule. If
changes could be found a window
appears and shows Trains, which
were changed within graphic
timetables and if you selected one you can see on the right the Changes of current train.
The Lists are sorted by Train and show you Train’s route and the kind of Changes.
The right part shows you the row inside the customer’s timeable and the changed data.
You have three possiblities to synchronise the data finally. So you can synchronise:
 All changed data,
 Marked trains or
 Marked changes along a train run.
So you can mark single or grouped changes to synchronise them into the customer’s
timetable. This way you can update your data inside the customer’s timetable quite fast after
changings in the graphic timetable.
5.4.3.16 Edit Legend
The entries in the legend are set automatically, so far as FBS can handle them. So you
should check the legend before publishing the customer’s timetable. You can display the
legend below every or the last table as set in View>Register “Layout & content>Part “Table
(explained at page 99). You can show the Standard symbols for operation days by using
the Legend button at the bottom of the window and use the last item there. Normally these
symbols are explained once inside the schedule book, so that they are not shown as default.
If you use the customer’s timetable outside of the schedule book you might add them to clear
all the symbols inside the table.

5.4.4 Head- & footlines

This window and the functions are same as explained in Head- & Footlines at page 88. The
headlines & footlines them selves are not linked so that you can handle them different for
Driver’s timetables and Customer’s timetables.

5.5 View Menu
5.5.1 Move row highlight up/down
Ctrl+up/down
If you activated the Highlight row function you can move the row by the combination
Ctrl+up/down quickly. This might be helpful if you have finished the creation of your
customer’s timetable and would produce station posters for small station in a fast way. For
important stations it would be better if you use the Arrival & Departure poster as explained
in chapter 2.3.4 starting at page 18.
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5.6 Options Menu
5.6.1 Default legend for customer’s timetable
This function helps you
and the customer’s to
keep the overview insight
of all of your timetables in
one period. All legends
use the same operating
day symbols, if they are
required in this timetable.
So it’s blocked to use the
symbol in one timetable
for one operation day and
in another timetable for other operation days. It is also possible to use all symbols below
every customer’s timetable, also if some of them are not required. The symbols are
numbered figure by figure starting with number 1.
The operating period can be defined by the
button. A small window opens, in which you
can change between a not defined and a defined period for the validty of this legend. The
from and until date can be filled by a calendar, which opens by clicking at the arrow at the
right end of the box. The settings can be Canceled or accepted by Ok.
The table in the middle shows all defined Symbols, Legend texts and the
rule To be used for the following operating days. If there are operating
days used, which are not included inside the list they are added
automatically. You can change the order of the list entries by drag and
drop.
These buttons are designed for
adding or deleting new symbols.
The New button leads you to the same window as to
edit an existing entry, but it is without any content. A
new window opens, in which you can define the new
legend entry. The symbols can be differed for
photosetting or hot type layout. The signs will be
shown in Customer’s timetable in train columns and in
the legend below the table. You can use all signs
defined inside of your font or Special charatercs by
using the button at the lower end of the window.
The Legend text is only to be seen inside of the legend.
Last but not least the operating days have to be defined, which should be replaced by these
legend entry. The operation days are defined by the know FBS-Calendar as explained in
chapter 2.2.2 starting at page 14.
The Insert all from network button collects all existing operation days and there symbols. A
list shows you the customer’s timetables and the realeted operatioin days. You can also
abort this insert.
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You can also use the existing operation day symbols from other networks by the Copy from
button.
The context menu at a legend entry shows you two functions to Existing Customer’s
timetables. You can Check for accordance of this entry. That means iPLAN checks all
existing customer’s timetables for using this symbol or another symbol for the same
operation days. If there are differences they are shown to you in a list.
It is also possible to Search and replace symbols. The window
shows you the current symbol and you have to select the new
symbol. This function can be limited to hot type or
photosetting customer’s timetables or both of them.
All settings have to be confirmed by the Ok button or can be
Canceled.

5.7 Create opposite direction …
This function can be called up the context menu inside the object window on the right bottom
of the iPLAN-window. Select the customer’s timetable, which you would like to “turn around”.
Call up Create opposite direction … function and now you are inside the creation process
of a new schedule at the position choose places of access or as explained as Step 4 in
chapter 5.2 at page 94. All the other steps are also explained there. So you need to create a
customer’s timetable within all steps only for one direction and can create the other direction
quite faster.
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6 Circulation plan
6.1 General
Circulation plans rule the row of trains, which are composed by certain vehicles. These plans
can be differed by engine or waggon plans.
You can create Circulation plans for any groups of trains, so that you can choose the content
of the plan for only a region are the complete network.
The most important property of a circulation is that it is closed. That means the circulation
starts and ends at the same station. So that you can break this circulation at any station and
you can repeat the circulation as often as you want. The shortest possible circulation
includes only a round trip from A to B and back.
Caused by the long trips of the vehicles they often do not arrive at the same station again as
they started in the morning. That is why typical railway circulations are some days long. That
means the row of runs repeats after same days and not every day. Circulation plans are
normally not longer the 30 up to 40 days. Longer periods are difficult to handle because you
will even have too much trouble in the row of the circulation.
Another typical property of rail circulation plans is the difference of runs at weekends. So at
Saturdays, Sundays and often on Mondays there are different rows of runs as at the other
days of the week. A classical circulation plan is separated in Monday, Tuesday to Friday,
Saturday and Sunday.
FBS handles the seven days of a week separate for a circulation plan. The known classical
circulation plan is in FBS only an accident of the same row of trains at Tuesday to Friday. A
one-day circulation plan includes every day the same runs.
Today the Railway Operation Companies try to create Circulation plans with a length of 30 to
40 days. The advantage of such a Circulation plan is to be seen in the equal distances of
every circulation day for a better handling of maintenance and the centralisation of depots.
FBS tries to reach equal distances as one of the criteria for optimisation.
A Circulation plan shows not the usage of a special vehicle (the current number of the
vehicle) for a run. In theory you can recalculate the current vehicle running a service in the
Circulation plan by start situation of the plan and the number of days, which are gone. This
follow of runs often has to be changed in praxis by a dispatcher because of maintenance,
breakdowns or public holidays or extra tours. The vehicle usage plan is similar to the
dispatching mode in graphic timetable to handle the plan for daily operation. It is possible to
include the vehicle usage plan in FBSbahn if you are interested in.

6.2 Create a Circulation plan

After clicking this button an assistant starts to lead you through the first steps of the creation
of a circulation plan. The following steps should
be done to get a useful result:
1. Selection of Engine or Waggon/coach
circulation plan
110

Documentation to FBS
Edition November 2015

Chapter 6  Circulation plan
6.2  Create a Circulation plan

Choose here the type of vehicles, which you would like to fill in a circulation plan.
You can create different plans for engines or waggons.
2. Selection of Engine series or group of waggons
You can choose the series of the engine or the group of waggons as found as a
single train part in any graphic timetable inside your network. This selection is not
possible if only one series or waggon group could be found. Press the Continue
button after setting this data.
3. Potential restriction of line numbers
If the train parts are linked to a line number you can limit here the circulation plan
to some lines or exclude some line numbers from the calculation. The line
numbers are taken from the train data window in graphic timetable.
4. Potential restriction if smaller vehicle groups are included in larger vehicle groups
This restriction can be done by a Filter function. Before using the filter function
you have to make sure, that all train parts are linked to a line number. A special
declaration of appropriate days of operation, separated by tab behind the train
part number, can be made, if a train part shall not be selected on all of his days of
operation.
Blank lines and lines beginning with a semicolon will not be interpreted.
Furthermore it is possible to write any remarks behind the declaration of days of
operation, separated by tab or space. These remarks will not be interpreted, too.
A train part is selected only on his declared days of operation, if such a
declaration follows his number.
If the filter is used negated ("only read in trains, which do not correspond to the
filter"), the circulation plan will embrace:


train parts, which are not included in the filter list



train parts, which are included in the filter list with declaration of days
of operation on such days, which are not declared
After that the circulation plan window opens.
5. Setting of global and local preparation and postprocessing times
Here you can set the preparation and postprocessing times, which are needed in
every station when a train starts or ends. Special jobs like train heating or
shunting jobs inside a station can be set later and are not defined here. The
further functions of this window can be read in chapter Register “Preparation and
postprocessing at page 113.
6. Overview above Train balance
A window opens, which shows you the train balance. So you can have a fast look
to the result of the calculation. If the Difference arriving and departing trains
during the whole week is not 0 empty running might be needed. Further details to
this window can be found in chapter Show train balance at page 126.
After that you are in the middle of the creation of the circulation plan. Now you can use the
functions to define additional jobs, which should be respected by the calculation. You get
back to this window after every recalculation. For the first time you can see only a frame
without contents. In the bottom of the window you see the list of trains (explained in chapter
Show trains at page 122).
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By setting forced links you can fill in your own boundary conditions to the calculation (for
example the respectation of outdoor advertising).
After the calculation of the variants the following steps are necessary, which are explained in
the following parts:
1. (optional) completion of fixed jobs, which are not train runs, e. g. shunting or train heating
2. (optional) setting of forced links
3. check and selection of useful results
4. review and optional adding of maintenance and other times
5. printing

6.3 Circulation plan Menu
6.3.1 Synchronize with graphic timetable > Update trains
or Alt+R or Show list of trains > context menu
This function is made for simple handling of
your Circulation plans. If you created once
your Circulation plan and the settings in the
graphic timetable have changed and saved
your Circulation plan can be updated this way.
So you do not need to delete the Circulation plan or change the data manual. The window
shows you all the changes made in the graphic timetable file. If the train is not included up to
now you can select the train and use the Insert button or Update for trains where only data
is changed. The Delete button deletes trains from the Circulation plan, which are not found in
the graphic timetable.
After finishing this function the warning sign appears to show you, that this Circulation is not
correct. A new calculation has to be done.
Please note, that the changes in the graphic timetable can have such an influence to the
Circulation plan, that you might need more or less vehicles.
6.3.1.1

Synchronize with graphic timetable > Select trains manually

This window is created for including or
excluding trains from the circulation plans. So
you can select trains, which should be
respected by calculation. All other properties
inside your calculation are kept alive in
opposition to recreation of the circulation
plan.
Select the trains in the upper window and
click the Insert button to ad d them to the
calculation.
Trains can be deleted by the same way using
the Delete button.
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Synchronize with graphic timetable > Recreate circulation plan

By using this function the whole Circulation plan is erased and you restart the assistant for
defining a new Circulation plan.

6.3.2 General circulation data
or Alt+A
This window is necessary to set the method, the side conditions and the aim for circulation
calculation. This window opens automatically by creating a new Circulation plan. You can
edit the settings by recalling this window in an existing Circulation plan.

 Hint: The success and the convenience of an automatic created Circulation plan depend
hard on the setting of some entries at the general circulation data. So do not skip or scan and
skim this window if you would like to have useful circulations. If you try to “anger” or
challenge the programme too hard, it will “answer” the settings with senseless or no
Circulation plans.
6.3.2.1.1

Register “Preparation and postprocessing”

Between the arrival of a train and the departure of the next run there has to be a period for
changing crew or for shunting. Here you can set Global preparation times to start a train
and Global postprocessing time after finishing trains run. These times are added and so
the sum of them has to be left between two services of a vehicle. These entries here show
you the minimum of turning times in the terminals.
The table in the middle of the window allows
you to set special times to stations, which you
have marked in graphic timetable file as a
terminal (look at chapter 3.2.10.4 at page 39)
To
change
the
Preparation
and
Postprocessing times for a station double click
the line and a window opens to enter the
Preparation time and after Ok the
Postprocessing time can be set. The times
have to be filled in, in the normal FBS-style
(h.min). If you would change from special
turning times back to the global turning times
fill in -1.
If some trains need special times for
preparation or postprocessing you can set this times directly to the train outside of this
window.
On the bottom of the register you can select the Rounding rule for this circulation plan. This
setting is saved in relation to the circulation plan. So the settings made by Configuration are
only relevant for new circulation plans.
Please note, that modern railcars and push-pull trains need only some minutes between two
train runs. During the calculation of the Circulation plan the arrival and departure times are
rounded in the set rule, so that it can happen, that minutes might be lost. It is helpful to set
the preparation and postprocessing times by three or four minute turning times down to one
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minute. Please make sure that the turning times are not too short, so that they are unreal and
might bring you trouble.
6.3.2.1.2

Register “Empty runnings”

iPLAN is able to preview possible empty
runnings, which are needed to close the
circulation. You should use this function, if
you could not take care for a complete
circulation
during
the
timetable
construction. If the Train balance window
is checked iPLAN suggests you to
calculate a circulation plan without empty
runnings, if this is theoretically possible.
Empty runnings do not always mean an
extra slot or train, because they can be
combined with existing trains or changed days of operation of a train.
So you can calculate circulation plans Without additional empty runnings or Allow
additional empty runnings.
You can set the following Data for empty runnings by a click at this button.
For a faster calculation the empty runs are handle with an average speed. The current
average speed of all trains inside the circulation plan is shown to you to get an image of a
useful average speed. The usage of free slots in the timetable is only done, if you respect the
explanations in chapter Register “Empty runnings at page 114.
You can limit the maximum empty running distance to avoid runs through the whole
network only for saving one car but paying
for the slots and the run itself.
To calculate useful slots, the programme
needs less data to calculate the run of the
train. The normal train data has to be filled
in like in the train data window of graphic
timetable. Do not forget to choose an
engine, if the circulation plan is only made
for waggons!
If additional empty runnings are allowed,
you have to choose between the following
two targets criteria:
 less empty runnings: Here you fill
in the accepted link time between
two trains, before an empty run will
be suggested. The maximum link
time is a time limit for links. It will make no sense to keep a train waiting from a train
arriving on Monday morning until Thursday evening. The programme crosses this
time only, if there is no possible trains found in this period.
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 less vehicles: Here you set a time limit, which has to be overrun by an empty running
to be “better” as waiting for the next possible train from the same station, without an
empty running.
6.3.2.2

Register “Circulation forming”
This register is only available if you switch the
More button on the right top of the General
circulation data window.

Here you can set two parameters, which have
an influence to the quality of the circulation
calculation.
To fewer variants may cause that the expected
circulation plan would not be found. Too many
variants on the other hand my cause that the
programme calculates unnecessarily long.
The Iteration depth indicates how many links
(departing trains per arriving trains) the
programme will take into consideration first, as
to say “how far it looks”. It is comparable with
the number of moves a chess computer “thinks” in ahead. It is recommended to set the
iteration depth at the maximum number of trains being at one time in a station plus one.
This may be for instance a depot at night. The value
is predefined by the maximum of trains at one time in
a station being calculated in Train balance window
for every station and shown in the column Trains
maximum.
The Fixing period means a time limit. If the time
between the arrival and the departure of a train is
shorter than the Fixing period this link is handle like
a fixed link between the trains. All times longer than
the Fixing period are handled inside the programme
as variable links between two trains. This value can
be set also in the Spreading ( ) window too. This
window can be opened up after the first calculation of
a circulation plan. You can see there the relative number of link times for this circulation plan.
The blue line shows the Fixing period, which was used for the done calculation. You can
move the fixing period here by clicking the blue line and keep it clicked during you move the
mouse pointer left or right. The relative number of fixed trains this way is shown below the
diagram. If all links are fixed it is
impossible
to
optimize
the
circulation plan, so only the
circulation plan diagram has to be
calculated and shown. If the fixing
period is set to nearly zero, the
programme has to calculate many
variants, which results a long
processing time.
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6.3.2.3

Register “Selection of variants”

This register is only available if you switch the More button on the right top of the General
circulation data window.
By calculating the possible circulation plans many possibilities can be resulted. To find out
the obviously best one of them you can do settings here.
You can do a Selection of variants by lower number of vehicles or shorter total mileage.
The first one is better if the vehicles are rare and the second one if the slot costs are high.
The spreading of runnings can do another possible sorting. You can prefer a Smaller
number of vehicle groups1 or an Equal mileage division of the vehicles.
You can also limit the shown number of variants of the best circulation variants.
For saving space you can also set to Save one of a group of equal variants only, because
some variants may only be different in the night links but not in the runnings along a day. So
you do not see them as different variants but they are different for the programme.

6.3.3 Start circulation > Target aim: less vehicles

This function starts the calculation of the Circulation plan. The
target here is to use as less vehicles as possible with the
current properties. To make sure, that you are interested in
recalculation all variants of this Circulation plan you have to
confirm the next window. At first the programme checks
whether it is possible to get variants of circulations or not. This
check might need some seconds inside huge circulations. If it
is not possible to get a result, you get a hint to change the
basic data. If it is possible to start calculation – the calculation starts.
Depending on the number of services and their dependence to each other service you can
have a lot of variants for circulation. Up to now it is not possible to calculate the number of
possibilities and so the time for calculation the circulations. To get a faster overview of the
needed vehicles you can use the option Quick calculation (one variant only). If you would
like to see some circulations a window appears, which shows you the current data for
calculation. You can stop the circulation search if you want by button Close.
A complete calculation of the circulation can take some minutes up to some hours,
depending on the number of runs, number of links and the used method. It might be, that the
founded circulations do not include the optimum. The algorithm is designed to find with a
high chance the best variants at first, but it is not possible to include all the different values of
the parameters to predict the best variants.

1

A group of runs means a circulation, which starts and ends at one and the same station so these
circulation days can be run without any connection to the other circulation days. Most of the railway
operation companies try to get circulation plans with fewer groups. A circulation for a group could be
handled as a single circulation plan or a circulation plan for a series of engines (or waggon groups)
can be (if groups exist) seen as a sum of different circulation plans.
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After finishing or stopping the search you can evaluate the found variants, change the
parameters or forced links and restart the calculation.

6.3.4 Start circulation > Target aim: less empty runnings
This button is similar to the Target aim: fewer vehicles. The only difference is the target to
minimize empty runnings. This way is useful if you have a lot of traffic inside your network
and you see less chance for empty runnings. Please note, that empty runnings can be
combined with existing runnings, without an additional slot for transferring vehicles.

6.3.5 Start circulation > Quick calculation
This function stops the calculation of circulations after the first circulation variant is
completed. You can switch it on or off. This function is only used in connection with the
different target of optimizing.

6.3.6 Sort variants > Delete all other variants
Show list of circulation variants > context menu
If it was possible to create more than one variant the best of them are saved until the
maximum of best circulation variants you set (chapter Register “Selection of variants, page
116) is fulfilled. If a better variant could be found the worst one of the existing variants in the
list is erased. If you have checked all the variants and found out the best one for you, you
can Delete all other variants to save space on your disk.

6.3.7 Sort variants > Current variant to the top
Show list of circulation variants > context menu
If the best variant suggested by iPLAN is not the best for you, you can set the current marked
variant to the top of the list.

6.3.8 Sort variants > Delete current variant
Show list of circulation variants > context menu
If an existing variant does not make sense in your mind, you can delete this variant to avoid
analyzing this variant again and again.

6.3.9 Export forced links...
If you set forced links inside your Circulation plan, it is possible to export them into a text file
to import it again, if you have created a new circulation plan. By starting this function please
fill in the name and the directory of the file and press Save.

6.3.10

Import forced links...

For importation of forced links you can use this function. After selecting the file a window
shows you the result of importation.

6.3.11

Export circulation plan > Text format
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6.3.11.1 Part “Destination of export”
Many users have to use Circulation
plans in other programmes for example
to handle statistics or vehicle usage
programmes. You can export the
Circulation plan into clipboard or into
a text file. Do not forget to choose the
Long or Compact layout for your
usage. The text formats are not
standardized, so that they can be
changed in every new version of FBS.
If you want to have an own export
standard please call the service.
6.3.11.2 Part “Output format”
You can choose here also the output format as 8 bit text or 8 or 16 bit Unicode text.
At the end you can choose the Long or Compact layout depending on the weekday sorting.
There are also interfaces to other programmes possible. For further information call the
service.

6.3.12

Export circulation plan > VISPER

Finished Circulation plans can be summarized to the import layout of programme VISPER.
This programme is made by Fraunhofer-IVI and handles staff and vehicle usage. The dongle
settings have to be changed for using this function, so it is blocked if you do not have
VISPER on your computer.

6.3.13

Print

The design of the Circulation plan is made for horizontal usage of paper in DIN-dimensions.
So the prints are also defined as horizontal papers. On the bottom of the print window you
can select the Weekdays from … until and the Rows per sheet and the Rows from … to
…. It is also possible to print the Circulation plan With header and/or Use of colours. You
can also print the Circulation plan to a pdf-file by the known way.

6.4 Edit menu
6.4.1 Search train
This function jumps to the train in the train list. You cannot use it to jump to the train in the
circulation graphic.

6.4.2 Edit train/Insert train
Context menu inside the graphic circulation plan or Context menu inside the train list
or context menu inside the Circulation table
This window allows you to change the data for one train inside the circulation plan or to
create a new train. A train can mean here different jobs for an engine or a group of waggons.
The trains defined here are taken into the list of trains and not into the graphic. To find these
trains inside the graphic you have to recalculate the circulation. The warning sign shows you,
that there is a difference between the train list and the trains inside the graphic. The sign
disappears after a new calculation of the cirulcation graphic.
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So at first you can choose between different kinds of jobs: Passenger operation, Freight
operation, Empty coach stock, Empty freight operation, Light engine, Shunting service,
Maintenance, Readiness/Emergency service, Train heating, Train cleaning and Filling
engine. This setting changes the hatching of the bar.
All train runs can be set by the window to be seen on the right and all the other possible
kinds of jobs can be set by the window shown on the left.
Existing trains are shown with all data being found inside the graphic timetable or in the *.ntzfile related to this run. If you insert a new train run or service or maintenance an empty
window is shown.
6.4.2.1

Train runs

The train Category and Train number are the typical data to
identify a train. The field Regular service days are shown if
they cannot be shown in the list on the right of the window.
The Start of preparation and the End of postprocessing are
important for calculation of circulation plan. This data is
calculated by the pre- and postprocessing times filled in by you
in the register belonging to the General circulation data
(chapter General circulation data at page 113) and the
departure and arrival times taken from the graphic timetable.
These times and the stations for the start and the end of the
run are also shown to you inside the window.
The Distance is also taken from the graphic timetable and
used for calculation the whole circulation data and the
consumptions related to the distance.
To keep additional information to this run you can fill in a free text in the Remark field. The
Line field shows you a line code given by the graphic timetable if it could be found there. The
Engine is taken also from the graphic timetable and important for the circulation. You can
change the entries here, but they are not relevant for a recalculation of the circulation plan.
You can change the Colour of the train run by the button in a known Windows®-style.
The operation days on the right show the days in which the train run exists (exactly starts his
run).
6.4.2.2

Not train runs

Not train runs means all the jobs, which do not include a run from
one station to another station.
So you can set only the station in which this job is done and the
times from start to the end of the job. You can Set back
consumption counter 1/2 to get an additional calculation of the
consumption counters. They might be helpful for calculation of
filling stops or something else.
You should fill in a Description, which is shown inside the
circulation plan and you can fill in a Remark for your one
information.
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For example a shunting service means also movement of the engine and so the Running
performance to be counted should be estimated by you and filled in to get a realistic
calculation of the whole run of the engine.
You can also set this job only for some or all days of the week by the boxes of the days on
the right of the window.

6.4.3 Delete train
This function deletes the current train run after your confirmation.

6.4.4 Assign forced links
Alt+U
If you need to force links between two jobs of an engine
or a group of waggons you can tell this the programme
this way. After marking the ending train you can call up
this window and see the list of operation days of the train
repeated on top of the window. So you can select
another train by a list given to you. This list includes at
first the trains, which can be reached by this engine or
waggon at the same station. The second part includes
all other trains found in the next 24 hours.
So you can set the link to the next train. You can also
jump to next or a further day. You get a bigger gap inside of the circulation plan. If it is
possible to set this forced link to some operation days a dialogue window opens to help you
to copy this link to the other operation days.

6.4.5 Show empty running possibilities
or Alt+L
If it was possible to find a slot to bring the
engine or waggons to the start of the next
operation, the possibilities are sorted by the
following way:
1. Using existing slots before adding
operation days or defining new slots
(Target: safe train mileages)
2. Trains of the own circulation before trains in other circulations (Target: coupling of same
vehicles)
3. as possible a small number of existing train parts at the existing train (Target: reducing
couplings)
4. as possible a long stop for coupling the train parts (for brake test and so on)
5. as possible a long stop for uncoupling the train parts
(for passenger changing if needed)
6. as possible a long time to the next run (to get
enough time for shunting and so on)
The window lists all possible trains, which can be used
to bring the engine from the end of the last run to the
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start of the next run. There is only one Newly to assign slot shown.
This slot starts as fast as possible after the last job to bring the engine as fast as possible to
the next job. (How knows what will happen during the empty run…). The slot is optimized by
latest possible departure and earliest possible arrival time. At every junction a stop is
calculated, because it is not sure, that the run can pass the station without a change of
direction.
It can happen, that now empty running possibility is shown. This can happen in some cases,
caused by the average speed being used to calculate the run. So the average speed might
be too slow or it is not useful in a line section or the usage of the line (section) is really so
high, that it is not possible to run the train with average speed. All the cases, which appeared
right now, could be cleared by a manual slot search.
If you double click an empty running possibility the following details are shown in an extra
window:
1. If you picked an existing slot you can Go to train data window of the existing train in
graphic timetable. The data of this train will not be changed automatically, so you can fill
in the train data for the additional train part by yourself.
2. If you only need to change the operation days of an existing train the same procedure as
explained in 1. has to be done.
3. In case of the new empty run slot you can Insert new slot to the graphic timetable(s).
The graphic timetable will be opened and the slot is filled in and the train data window for
this run opens. So you have to check the train settings by yourself.
These steps have to be handled stringent by the user, that the timetable design is not
destroyed by an optimized circulation plan. The final liability for inserting the new train keeps
by the user of FBS-programme family!
By name of multiple units or engines empty runnings multiple units are possible so that you
can couple some vehicles of the same series. That means for the circulation plan, that some
vehicles drive a train at the same time. So you have to check the graphic timetable again,
whether multiple unit runs have influence to the running times (at least the length of the train
changes).
So you can update the train data
and recalculate
the circulation plan. It is useful to
update the trains included in the circulation plan after handling all empty runs. Otherwise you
might get empty runs to round the circulation plan with an “old” empty run so that you could
have trains running through the network, which are not needed for traffic but for a mistake in
calculating circulation plan.

6.4.6 Current service > Reset consumption counter 1/2
Context menu inside the graphic or table circulation plan
This function resets the consumption counter 1 or 2 to zero at the beginning of this run. So
you can control the consumption depending on the mileage. It does not have to be
consumption in the sense of the word you could also use it for limitation of maximum
distance without toilet cleaning or something else.

6.4.7 Current service > Reset time counter
Context menu inside the graphic or table circulation plan
This function resets the time counter to zero at the beginning of this run. So you can control
the consumption depending on the time. It does not have to be consumption in the sense of
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the word you could also use it for limitation of maximum time without toilet cleaning or
something else.

6.4.8 Current service > Exchange current link
Context menu inside the graphic or table circulation plan
This function is not available now.

6.4.9 Current service > Extract (skip) journey
Context menu inside the graphic or table circulation plan
This function hides the current journey. By recalculating the circulation plan the journey is
respected again. So the run is not completely erased from the circulation calculation.

6.4.10

Insert new journey > Current train

Context menu inside the graphic or table circulation plan
This function copies a service from one circulation day to another. You can set the new
circulation day only at the current operation day or on the following weekdays as
checked in the boxes on the bottom.
The current job will be copied to the other circulation day. To delete the original job from the
circulation day use the function Extract (skip) journey as explained above.

6.4.11

Insert new journey > Insert a new train

This function combines the Insert train function with Insert
new jouney > Current train. So you can define here
additional jobs for the engines or waggons, which are not
included in the graphic timetables and bring them into the
circulation graphic. If it was not possible to find a gap for this
job inside the circulation day and the operation day a message
tells you the problem. In this case the job is taken into the train
list but could not be placed inside the graphic. So a recalculation solves this problem, but
please take care, that you might need more engines to fullfill all your wished jobs for this
circulation.

6.5 View Menu
6.5.1 Show trains
or Alt+Z
This function opens or
closes a part inside the
Circulation plan window,
which shows all trains and
train parts, which are
relevant to the current Circulation plan. The train runs are summarized along the whole run if
the train runs through different Graphic timetables. The train runs are connected by their train
part number and not by their train number, so please take care during the creation of Graphic
timetables.
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The first columns of the table show the Train and train section number and the days of
operations. The next column includes the start terminal and the departure time, the arrival
time and the end terminal. After that the Beginning and End column show the time where
this service starts and ends, so it is the departure respectively the arrival time added by the
preparation respectively the postprocessing time at this station. These times can be
changed as written in chapter Register “Preparation and postprocessing at page 113. So the
entries there are used to calculate the circulation.
The Remark column is not filled automatically but can include hints for you. The hints can be
filled in as written in part Edit train at page 118.
The columns of the weekdays show an x if the train operates this day or nothing if the train
does not operate. If the entry shows an arrow to the right a forced links is set, so that the
calculation has no freedom to change the link from the arriving train to another departing
train. So the last column includes the trains, which follow the current run if they are a Forced
link, differed by the operation days if necessary. Look at chapter Assign forced links (page
120) to set or delete forced links.
The context menu in this part gives you short cuts to train related functions.

6.5.2 Show circulation variants
or Alt+V
This function also opens another part inside the Circulation plan window, which shows you
the know variants. The known variants are at a minimum of one up to enormous numbers or
limited by your self. You can limit the number of variants automatically by Register “Selection
of variants as explained at page 116 or by stopping the calculation.

During the calculation you can see the best of the variants by their calculation number, which
are renamed again after finishing the calculation.
The table on the left includes the most important data for one circulation. That means the
number Groups, the needed Vehicles, the Total mileage of the whole Circulation plan and
the average Mileage per vehicle, the average Difference per day and the Difference per
week. This part of the table includes a context menu, which allows you to sort the variants
your way. The functions inside the context menu are explained starting in chapter Sort
variants > Delete all other variants at page 117.
The table on the right shows more details to the circulation plans shown on the left. So you
can see the number of the Variant, the Group in which this vehicle is sorted and the number
of the Vehicle. The following columns show you the mileage per week and the mileage as
average per day for one vehicle. Below the first line you can see the mileage the vehicle
runs at every day of the week. So you can control here the parameters for the Circulation
plan.

6.5.3 Show circulation graphic
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or Alt+G
A Circulation plan is often
handled as a graphic, but
it is also possible to show
the data in a table.
Normally you find the
following data in relation
to one train:


The train number above the train bar.



The start station and the departure time. The hour along the x-axis and the minute
written below the train bar.



The end station and the arrival time. The hour along the x-axis and the minute written
below the train bar.



On the left you find the data for this vehicle circulation, including the circulation
number, link to the circulation before this circulation and the station at which the
vehicle is waiting for the next job.



On the right of the graphic you can see again the number of the circulation, the link to
the next circulation and the station at which the vehicle is waiting for the next job.



At the midnight time line the total mileage of every circulation day is shown.



The picture above shows also a calculated empty run in circulation one between 9.41
to 11.00 from NRV F to NRV, that means a distance of 4 km and the prediction of the
running time of 6 minutes. At the end your Circulation plan should not include such
unplanned empty running. How to handle the empty run information can be read in
chapter Show empty running possibilities at page 120.



For a better view the information’s of the runs inside the graphic Circulation plan is
shown in the colour, which is used in the Graphic timetable. So you can also differ
here between the different train head codes.

6.5.4 Show circulation table
or Alt+T
The circulation table is another way to show the circulation data. This mode allows a
compressed presentation in relation to the circulation graphic.
The information about the predicted time for an empty run is not shown.
On the right you can control the different counter values for Maintenance, Consumption 1
and 2 and the Operation time
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6.5.5 Show graphic header

The graphic header is designed especially for printing of circulation plans.
This function hides or shows the graphic header if the circulation graphic is shown. The
header cannot be shown in the circulation table. The contents of the header can be set as
written in chapter Headlines... at page 125.

6.5.6 Zoom in/out

To zoom in or out you can use this function. This function works only in the circulation
graphic.

6.5.7 Fit to page width

This function is only useable in the graphic circulation plan and if you selected to show only
one day (look at part Day of week, at page 126). By clicking this button the graphic is sized to
the width of your screen to get a better overview of the graphic. The height of the page is
also sized in the relation given by DIN-A-paper format to the width.

6.5.8 Headlines...
This function allows you to change the data in the head of the Circulation plan. The Headline
and Circulation plan’s title includes the data shown in bold type in the centre part of the
headlines.
The left box of the headlines is normally used for Railway administration, operation yard
and so on. The contents given by the programme can only be a hint for you.
The right box can include a mixture of text and data shown
by the following synonyms:
 #fa – for the number of runnings,
 #fz – for the number of vehicles needed,
 #gr – for the number of vehicle groups,
 #zg – shows the number of trains inside the circulation
plan,
 #l1 – shows the running performance of all vehicles
per week or
 #l2 – shows the average running performance per
vehicle and days.
You cannot change the typeface of the headlines.
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6.5.9 Day of week
or Alt+1 to Alt+7 for single day of the week (1=Monday … 7=Sunday) or Alt+0 for the
whole week
You can select here directly the day of the week, which should be shown in the graphic
circulation plan. You can differ between the whole week and a single day.

6.5.10

Line height/line number

This function sets the height of a line or the number of lines, which would be seen. This is
helpful if the runs are only short and so many data are shown in less space. You can also fill
in a number of lines per page.
You can also set the height of the line automatically to use the size of your screen as
maximum.

6.5.11

One line up/down

or Shift+Up/Down arrow
You can scroll one line up or down this way to use defined jumps between the rows of the
graphic circulation plan.

6.6 Tools
6.6.1 Show train balance
or Context menu inside the train list
The train balance window is designed to show the Number
of Arrivals and the Number of Departures in all stations
in which trains start or end. The Difference between
arriving and departing trains is shown in extra column. If
this difference is 0 in every station at every day a simple
circulation plan without empty runnings could be calculated. If the difference is not 0 in on of
the stations (and so automatically in a second station too) empty runnings are unavoidable.
The window shows also the number of Trains maximum in the station to be able to control
the Iteration depth of the circulation calculation (as explained in Register “Circulation
forming at page 115).
The table inside the window is sorted at first by the abbreviation of the stations and as
second by the Days of a week.
The button Mo…Su shows the balance for every day of the
week. The difference in arrivals and departing at single
days is not a sign for necessary empty runnings. The sum
of the week is important for the need of empty runnings if it
is not 0. So you can also show the sum of every station in a week.
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It might be possible to create better circulations within empty runnings also if the train
balance in all stations all over the week is 0. A better circulation might be a circulation with
fewer vehicles.

6.6.2 Arrival and departure list
or Context menu inside the train list
The arrival and departure at reversing station window shows
a list of Arrival times and Train numbers in opposite to the
Departure times and Train numbers at a station and on a
single weekday. This list might be helpful for you to control,
whether all trains are found and which links are useable at
this station.

6.6.3 Show links
This window shows you the Day, the Train, the Arrival time and the station, in which the
train ends. The next Possible links to another train is shown by the train number, the
operation day, the departure time, the next final station and if the button Time is set the
link time between the postprocessing and
the preprocessing time.
For a better overview you can see only
one day of the week with all the possible
links at this day.
To define a forced link you can double
click a line and the known forced link
window opens (explained in chapter
Assign forced links at page 120)

6.6.4 Convert circulation
forced links

into

This function sets all the links in the current circulation plan to forced links. After this the
circulation could not be optimized any more. So a dialogue helps you to make sure that you
know what you are doing. If the circulation plan includes empty runnings another window
shows you this and asks you, whether this links should be set to forced links too or not.

6.6.5 Show link spreading

This function opens the window, which is still explained in Register “Circulation forming at
page 115.

6.6.6 Ruler > Off
This function hides all rulers inside the circulation graphic.
All ruler functions are only useful if you have choosen one job, which resets one or more of
the counters.

6.6.7 Ruler > Operation time
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This item activates the Operation time ruler inside the
graphic. This timer shows you the sum of the time used since
the last reset of the time counter. So you can control the
operation time.

6.6.8 Ruler > Mileage maintenance
This ruler can control distances between two maintenance jobs. To use it correctly you have
to define at least one job for maintenance inside the circulation plan.

6.6.9 Ruler > Mileage consumption 1/2
Both mileage consumption counters can be used for two different jobs depending on the
mileage, for example for refilling water and coal. They are not combined so that you can use
them for completely different jobs.

6.6.10

Check counter value...

This function opens a window, which
allows you to check the counter value
to a maximum of kilometres or hours.
By pressing Ok a window opens that
shows you at which job the maximum
value will be overrun. There is only the
first job to be seen, which could be
found. If no job crosses the counter limit it is also shown to you.

6.7 Moving inside of the circulation plan
6.7.1 Zoom in/out
In large circulation plans it might be helpful to zoom into special parts, to control data or to
see more details for conflict handling. This can be done in two ways:


You can zoom in positioning the mouse pointer at one of the corners of the zoom area. Press
the Alt button and move the mouse to the other edge of the zoom window. The margins are
shown on the screen to control the size of the window. After leaving the Alt button the window
is frozen on your screen. A click inside of the window zooms in and a click outside of the
window erases the window.



You can change the zoom factor by typing a new zoom factor and pressing Enter independent
from the choosen mouse button in the toolbar. There are also predefined relative functions
available (Page width, Page height, Whole page) or often used absolute zoom factors, which
can be called up by a list. Das funktioniert nur im Bildfahrplan?! Wenn das überall gehen soll,
dann das ganze Kapitel nach vorn als Grundlage für alle Programme?



The
(+/- button at the keypad) buttons increase or decrease the zoom factor by 50%
at every click.



You can skip between the current and the last zoom factor by F12.

By useing these functions you change the connection between the defined paper and the
shown contents on your screen.
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6.7.2 Moving the current position
You can move easily inside of the graphic timetable. There are two functions available to
change the current position, which is shown to you without changing the settings for the
shown data on the paper:


Move the mouse during you click inside of the graphic timetable.



You can also use the vertical and horizontal scrollbars. If necessary you might activate them in
Options menu.
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7 Interval graphic
7.1 General
The graphic timetable is a helpful paper to get an overview of the railtraffic along one line
inside of a network. If the passengers or freights use some lines during theire trip it is
important to synchronize the traffic on different lines for an easy journey. This can be done in
side the interval graphic, which shows only the important stations and the arrival and
departure times there. Railway networks with theire lines can be shown easily this way.
The interval graphic shows the nodes and the train lines operating theire in a schematic way,
which are linked to the geographic positions and the timestamps taken from the graphic
timetable. So you can see the important timetable connections of a railway network in one
view.
The interval lines inside of the graphic can have different line styles, width and colours to
differ between train types and interval times of different trains. The interval lines are
connected to the stations along the run and change theire direction orthogonal. Additional
points along the line can give you informations to the stops between the shown stations, the
name of the line and so one.

7.2 Adding a new interval graphic
After calling up the function new interval graphic the basement of the graphic is created in
the background. So the title, the stations and the defined logo are positioned inside of the
graphic.
A window appears, which allows you to edit the Properties of interval graphic as explained
in chapter 7.3.6 part Properties starting at page 139. It is helpful to select the paper size
before editing the interval graphic, because the elements do not move or size if you change
the paper size later on.
After that you are in the interval graphic window to start editing the interval graphic.
To create a useful graphic, you should walk the following steps:
1. Editing the nodes
2. Filling in the interval lines
3. Move the elements for well arranged view
4. Synchronize the changings to the graphic timetables
5. Filling in explanations and hints
6. Printing.
All these steps are explained in the following chapters.

7.3 Graphic Menu
7.3.1 Synchronise with timetables>Current interval line’s point
Context menu for a marked interval line’s point
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This function is only available, if an interval line’s data point is marked. A basepoint cannot
be compared with the graphic timetable.
A window shows you the difference between the graphic timetable and the interval graphic, if
there exists one. You can Correct the data or Cancel the changings.

7.3.2 Synchronise with timetables>Current interval line
Context menu for a marked interval line
This function is only available, if an interval line inside of the interval graphic is selected.
A list shows you all changes along this part of the interval line. Marking them and pressing
the Correct-button can brings the changings into the interval graphic.

7.3.3 Synchronise with timetables>Whole interval graphic
This function checks all the data inside of
the interval graphic against the data to be
found inside of the graphic timetables. If
changes could be found a list opens, which
shows you all changes. Select the data by
the Windows® marking system and use the
Correct-button to achieve the changings.
If no changes could be detected, a message
shows you this.

7.3.4 Print
Ctrl+P
This function opens the FBS-print-window, which is not explained again here.

7.3.5 Close
Alt+F4
This functioin is trivial to finish editing an interval line and closing the object.

7.3.6 Edit Menu
7.3.7 Edit off
F1
This function deactivates all active editioning parts inside the interval graphic. So you can
deactivate them faster than clicking every one alone.

7.3.8 Edit of stations/interval lines/graphic elements
F2 … F4
This button activates or deactivates the different editioning functions. There are different
functions group behind this buttons. You can Insert new station or Delete stations by
activating the Edit of station function.
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The Edit of interval lines allows you to add, change or delete interval lines.
Edit of Graphic elements is used to fill in or change additional informations to the interval
graphic.

7.3.9 Insert new station
or Context menu
This function opens a list of all train order change
places or access stations, which could be found
inside of the defined network. By using the right
mouse button inside of the table you can show all
operational facilities. The list is sorted by the
Abbreviations and includes the full Name, the
Number of lines, which have been found there
and the coordinates taken from the Station table

7.4 English translation
Sorry, for this new function does not exist an english documentation. It will be filled in as
soon as possible.
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8 Create Arrival & Departure poster
The posters are designed for passenger informations at a station. The design of these
posters is not defined in any directive, so that we give you a help to create this kind of
passenger information.
At the end of the creation of a new timetable poster Microsoft®-Word or Microsoft®-Write are
opened to see the result of your work.

8.1 Part “Timetable poster for...”
Here you can select the station or location for which you would like to create the timetable
poster. You can also differ between arrival and departure times.

8.2 Part “Included trains”
Here you can controll the train types, which should be shown. At first you can differ between
passenger trains and freight trains and others. It is also possible to choose no one of
these options and fill in the train types manuall. Please separate them by commata. If you
click the arrow on the right of the box, a list, including all train types in the network, is shown.
You can also click the train types there.

8.3 Part “Rounding rule ...”
Here you can select the rounding rules for the included times.

8.4 Part “Created poster...”
At the moment you can only save it as a file. You can fill in the path and file name manuall or
use the Windows®-save as window to choose the position of the created file. The data is
saved as Rich-Text-Format-files (*.rtf).

8.5 Part “Contents”
The contents are set here to give you the possibility to create the timetable posters in the
design you are interested in.
So you can select at first the data belonging to the train at the current station. So you can
include the time, the days of operation in UIC411-style or an FBS-style. If you want to have
operation days at every train please activate the show daily also box. The train type, the
train number and the track can also be shown.
For a better overview it might be helpful to see the start and end terminal of the whole train
run added by the linked times.
Some railway operators like to show the next stations following after the current station. One
option is to show all following stopps until a limit of stopps is reached. You can also include
stopps, which have a regular stoppage time higher than a time limit set by you. Also all
stopps with the highest-level service can be included. It is also possible to include stopps by
yourself to mark stations with a special interest for the passengers. For example: to get
access to a fair area or a park or something else.
It might be helpful for you to get every station in theire own line. This can be helpful if you
would like to go one designing the timetable poster in other programmes.
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Station database (look at chapter 9 at page 145). If iPLAN could find coordinates you can
choose the option to Insert station at thertical coodinates on the bottom of the window. If
the coordinates cell is empty, you can only Insert station at mouse coordinates. Calling up
the function by the Context menu uses this option the best way. Otherwise the mouse
coordinates are set to the upper left corner of the interval graphic.
Coloured stations are still included to the interval graphic. You cannot insert them again.

8.5.1 Delete station
or Context menu
This function deletes the selected station from the interval graphic after your confirmation to
this function. All train lines, which have a connection to the station, are deleted too.

8.5.2 Insert new interval line
or Alt+N or Context menu
A line means here a group of trains running from one station to another station in a clock
face time. By calling up this function an assistant starts to lead you through this function.
8.5.2.1

Step 1: select an interval for the line

The window shows all lines, which are
found inside of the whole network. By a
context menu inside the table you can edit
the filter function to select the shown
trains. It is possible to show the Intervals
only, All passenger trains or All trains.
The table consists of different columns, to
give you the possibility to choose the right
one of the lines. The Type is taken from the train type as set inside the train data window.
The data inside the Line columns is taken from the line entry done by a train part row inside
of the train data window as explained at chapter The registers of the single route
sections at page 59. The following columns show you the operation Days, the Interval, the
Number of trains, which belong to this line, the From station and theire Departure time and
the Arrival time at the To station.
If you used different train part numbers you will find two lines with the same name and train
type operating from station A to B and B to C. The connect them you have to check the train
part numbers inside of the different graphic timetables. If you made a circulation plan with
this trains, you also might have found different jobs for a train you created for running
through. So take care for the train part numbers to get a correct behaviour of the iPLAN
programme.
So please select the line operating from A to C and press the Next button.
8.5.2.2

Step 2: select the route for the line at the graphic

All stations along the run of the line are shown in two lists to select the First and the Last
station of the interval line inside of the graphic timetable. The first and the last station, which
could be found is marked automatically, so that you can skip this step by the Next button, if
you are not interested in changing the first and the last shown station.
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If you made a mistake you can get back by the
Back button.
Step 3: select the interval for the opposite
direction
The next window shows you all kind of
trains, which belong to the same group you
have choosen for the first direction, which
are running the opposite direction. So
please select here the line for the opposite
direction or use the option No interval in
opposite direction on top of the list. After
that, use the next button to get to the last
step.
8.5.2.3

Step 4: configure additional properties of the interval time

At first you can change here the Name of the line to get another labelling of the line.
Below this line you can see one or more registers in relation to the stations during the run.
The stations, where the operation days change en route, separate these registers.
Just for youre information you can see at
first the Operation days. After that you
can change the Interval/Line type. There
exist line types for the steps of 15, 20, 30
minutes, 1, 2 or 4 hours and a free style
for trains or groups of trains, which do not
operate in intervals.
The Line width and the colour can be
changed to mark the importance of the
train.
All these settings can be differed for every
operation day register.
After finishing these steps you can use the Ready button to insert the interval line or the
Cancel button to stop it. You can skip between the steps by the Back and Next buttons.
A new interval line’s point can be filled in as explained in chapter 8.5.14 starting at page 141.

8.5.3 Delete interval line
or Context menu
This function deletes the selected interval line from the interval graphic after your
confirmation to this function.

8.5.4 Delete interval line’s point
Ctrl+Entf or Context menu
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This function works different by the function of the selected line’s point. If you selected a
point, which is only used for fixing the line or changing the direction it will delete the point
without any confirmation. If the point includes further informations, you have to confirm the
deletion of the point.

8.5.5 Exchange interval line’s point with previous/next point
To get a better overview you can change the positions of two line points with additional
informations.

8.5.6 Insert a new graphic element
or Context menu
You can fill in five types of graphic elements:
 Rectangle,
 Textbox,
 Picture,
 Line and
 Legend.
The rectangle is only a graphic element, which includes no text or pictures. It is only used for
marking an area.
The textbox is filled with a text to explain some facts.
A picture can be used to
Please give all elements a name to be able to identify them in other lists again. This helps
you to copy the elements from on
interval graphic to another.
8.5.6.1
8.5.6.1.1

Element Rectangle
Part “Position at page”

Two points define the rectangle. The x
and y-coordinates set one of the points
and the other one by the Width and
Height of the rectangle.
8.5.6.1.2

Part “Margin”

The Interval/Line type, the Line width and the Line colour, which can be changed here,
define the margins.
8.5.6.1.3

Part “Filling”
The rectangle can be kept blank
or filled with colour, which you
can select here.
8.5.6.2

Element Textbox

A textbox is used to fill in
additional hints in clear text. The
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box on the left bottom gives you a preview to the settings, which you still made. The preview
is only made for checking the contrast between the text, the Font settings and the
background. The text himself has to be filled in the field above the preview area. Fill in the
text without respect to the size of the box. The alignment is done after closing this window.
You can set the Font by clicking the button within the current typeface. A Windows®
typeface editor opens to change the settings. The bounding rectangle can be defined
behind the button, which shows the current settings. The top left corner and the width and
height define the rectangle here too.
In some cases it is helpful to position a text in an angle. You can set them by the field Arc.
8.5.6.2.1

Part “Filling”

You can select here the background colour for the text. If you would like to get a coloured
rectangle within your text you should define a rectangle with the wished background colour
and position it behind the textbox, which has no filling.
8.5.6.2.2

Part “Horizontal/Vertical alignment”

The alignment of the text can be edited here. You can mix here three positions in horizontal
and three positions in vertical direction.
8.5.6.3

Element Picture

The picture element fills in a graphic file into
the interval graphic. You might use it to show
logos for operators or logos for regions,
which are shown here. The file can be
choosen by the button behind the Path and
filename of picture file. If you set a logo
inside the Configuration window, this logo is
set here as default too. You can change it
here or add other logos this way. The
position of the logo is set by the x- and ycoordinates and the Width and Height. To get a good view to the face of the logo you can
mark the check box on the bottom to Keep original height-width-dimensions.
8.5.6.4

Elements Line and Legend

These elements are not available right now.

8.5.7 Delete graphic element

All graphic elements are delected this way, after your confirmation.

8.5.8 Duplicate graphic element
Context menu
This function copies and pastes the element again into your interval graphic. The new
element is position close to the existing element and has the same name. So it might be
helpful to change the name of the new element as soon as possible to keep the overview of
all elements inside of the interval graphic.
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8.5.9 Move object into foreground/background
Alt+V for foreground and Alt+H for background or Context menu
These functions are used to bring one of the elements infront or behind another element, if
they overlap at any parts. The elements are always shown behind the stations and the train
lines.

8.5.10

Show list of objects

or Alt+L or Context menu
This window shows you all elements,
which could be found inside of interval
graphic. Stations, Interval lines and
Graphic elements are differed in the
three registers. You can control the
elements by some properties, which are
shown inside of the tables. You can
select elements from each one of the
registers or Select all inside of the
interval graphic. All selected elements
are summariezed on the bottom of the window. The context menu inside of the tables leads
you to three items.
8.5.10.1 Edit element
The Edit function brings you to the different property windows of the elements. The list of
objects is kept in the background and activated again after finishing the editing.
8.5.10.2 Move/Resize selected elements
You can also Move/Resize the elements to reposition. A new window opens, which allows
you to Move the elements by dx and dy in millimetres to use get a better overview. It is also
possible to move and scale free by factor to get larger or smaller elements. If you select
this you can set the calculation to Round coordinates by grid size and/or to Scale
up/down type size too.
Otherwise you can Move to left
up – right down the selected
elements to the four corners of the
defined graphic.
Last but not least you are able to
Move and scale into the full
paper size. So the programme
calculates
the
scale
factor
automatically to get the best
useage of the interval graphic. It is
useful to activate the option for Proportional scaleing to keep the form and layout of the
graphic alive. The Distance from margin can be set to keep space between the elements
and the margins. The dimensions of textboxes can be considered or not to keep the all
elements inside of the margins or only the stations and train lines.
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Some functions are only available if they have an influence to the result.
8.5.10.3 Copy to …
The selected elements can be copied to another interval graphic inside of all open *.ntz-files.
A list allows you to select the target of the copy.

8.5.11

Properties

Alt+Enter
The content of the property window depends on the element you selected. The properties of
the interval graphic can be changed if you did not select an element.
8.5.11.1 Properties of interval graphic
8.5.11.1.1 Part “Paper alignment”
The size and the orientation of the used paper can be set here before you start the Printfunction. It is possible to use predefined DIN-A-dimensions of paper in Vertical or
Horizontal orientation. If your papersize is different to the German DIN-format you can fill in
an individual Width and Height of
the paper.
The sizes and positions of the
objects inside of the interval graphic
are not changed automatically. So
you can define a larger papersize if
you find out during your work, that
the choosen size is too small.
8.5.11.1.2 Part “Margins”
You can define here Margins to
keep the elements in a distance to
the paper dimensions. All four of the
margins can be changed independed
for example to create enough space
to file the paper.
8.5.11.1.3 Part “View”
This part allows you to Show margins at the screen only or to hide them.
As default value all trains times are shown on the rightern side in running direction. You just
can turn it around, if your trains are running left-handed. To activate this option please set the
check box Show times for left-hand operation.
In some cases it could be helpful to see the run-through times. These times are shown the
same way as departure times, but there is no arrival time to be seen.
For showing the differences of stops between faster and slower train categories it is helpful
to show the number of stops, which are not to be seen inside of the interval graphic. If there
is only one stop between two included stations there is a point to be seen, which can also be
shown by a single stop as number.
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Clicking the button, which shows the current setting, you can change the Font for time
values. A Windows® known window opens to set another typesize.
8.5.11.1.4 Part “Grid”
The grid is used to catch moved or sized elements to a grid. The result of your work will have
a better view if all elements in a line are in a line. Two grids exist here: one for the General
positioning of elements and the other one for the interval lines at stations.
Setting the value to zero deactivates the grids.
8.5.11.1.5 Part “Loading train data from graphic timetable”
The line name is normally taken from the cell being filled in the Train data window (as
explained in chapter The registers of the single route sections starting at page 59). You
can also recrute a line number, if there is nothing filled inside the train data. The name will be
set together by train type and number. To keep the overview it is possible to use only the
first figures of the train number by selecting the divisor for the train numbers to get the line
number. So you can also define a line name by clever train numbers.
As known from other objects or other results of FBS you can change here the Rounding
rule for arrival and departure times by a given list of possibilities.
8.5.11.2 Properties of a station
A station can be handeld as a
combination of the elements
Rectangle and Textbox. The upper
part of the window allows you to
edit the settings of the rectangle,
which is needed to connect all the
lines passing or starting or ending
at the station. Further details to
the settings are written in chapter
Element Rectangle starting at
page 136.
The other part is used to set the
shown text. The functions of a
textbox are still explained in
chapter Element Textbox at page
136.
8.5.11.3 Properties of an interval line
The Name of line is used for sorting and showing
it in lists and to label the interval line inside of the
interval graphic.
8.5.11.3.1 Part “First line type”
You can change here the Interval/Line type, the
Line width and the Line colour. These settings
are only validly for the current part of the interval
line.
8.5.11.3.2 Part “Source data of interval line”
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This part shows you the train numbers, which are used to collect all shown data. One of them
runs in the first choosen direction, the other one just the opposite. The check box shows you,
if a non-interval train creates this interval line. This box should give you a hint that a
comment should be given to this line, because there is no interval to befound behind this line.
8.5.11.4 Properties of an interval line’s point
The properties of interval line’s points are explained in chapter Insert a new interval line’s
point starting at page 141. To reach the properties of an interval lines point, you have to
select the interval line and after that the exact point.
8.5.11.5 Properties of a graphic element
The properties of the graphic elements are still explained in the chapter Insert a new graphic
element starting at page136.

8.5.12

View Menu

8.5.13

Zoom in/out

or +/- at the keypad
You can zoom in or out this way to get a better
overview or to see more details. It is also possible to
select one of the given zooms inside the
list
or to fill in a value by your self.

8.5.14

Further Functions

8.5.15

Insert a new interval line’s point

Ctrl+Einfg or Context menu (if an existing interval
line’s point is marked)
8.5.15.1

General

There are several interval
line’s points available to
show
different
informations. A Basepoint
is used to change the
direction of the interval
line.
The
Arrival
/
Departure times show the
times along an interval line in relation to a station. The No. of intermediate halts can be
shown separate to see the different stops during a run. If there are different interval times in
some sections a Change of line type is required. A Split of interval line separates the lines
in two ways: a train is shared to run on two (or more) lines or to change the lines and this
way also the interval times. For example Labelling of interval line can show the name of a
train line.
Except of the Arrival / Departure times all other informations can be shown independent from
a station. So you can set the coordinates absolute or relative to the station selected by the
list of stations.
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8.5.15.2 Basepoint
A Basepoint is used to change the direction of the interval line, without any additional
information. So a basepoint is filled in the line without any additional information. You can
move the basepoint by drag & drop and change the direction of the interval line easy this
way.
8.5.15.3 Arrival / Departure time
8.5.15.3.1 Part “Coordinates”
This line point can only be shown at a station line, so that you
can only edit the x- or y- coordinates of the Arrival / Departure
time. It is easier to position the point by drag & drop inside of the
graphic.
8.5.15.3.2 Part “Arrival / Departure”
This part shows at first the Orientation of the shown times. One
point shows even the arrival time of one direction and the
departure time of the other direction. If the train Runs through,
there is only the departure time to be seen. The shown times are
to be seen inside of the Arrival Direction A or Departure
Direction B. If the train of this train line Run through just click
the check box behind the times. If you fill in a new Arrival /
Departure lines point, you can also collect the data from the
timetable, which would be exact.
8.5.15.4 No. of intermediate halts
8.5.15.4.1 Part “Coordinates”
The Number of intermediate halt(s) is shown between two
stations. So you have three ways to position the point:
 At the Page coordinates,
 Relative to the station or
 Centered between the neighbouring points.
The page coordinates are given at first by the mouse
coordinates and can be changed inside of the window by the
x- and y-coordinates. It is easier to mark the point inside of
the graphic and move it per drag & drop.
If you would like to position the point Relative to the station,
you can select by the first list the station and the second list
shows you the four possible edges of the station rectangle and as fith option a freely
moveable position. The point can be moved by drag & drop inside of the graphic, but it is not
possible to position the point outside of the station rectangle as long as this option is
choosen.
For a better view and an eaysier positioning you can also use the option Centered between
the neighbouring points. As points are only the Arrival / Departure points and the
Basepoints accepted. It is not helpful to position another information centered between two
other information points, which are freely moveable.
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8.5.15.4.2 Part “No. of intermediate halt(s)”
You can fill in the value directly into the filed or Compare with timetable to get the exact
figure. It is possible to Set size manually if you use the checkbox and fill in the new size of
the data point.
8.5.15.5 Change of line type
8.5.15.5.1 Part “Coordinates”
This part is the same as explained in Part “Coordinates” at the No. of intermediate halts
chapter at page 142.
8.5.15.5.2 Part “Change of line type”
Here you can change the Interval / Line type by a given list. The Line
width and the Line colour can also be set here, if they should be
changed. A change of line type is automatically set, if it appears at a
border of a graphic timetable.
8.5.15.6 Split of interval line
8.5.15.6.1 Part “Coordinates”
This part is the same as explained in Part “Coordinates” at the No. of intermediate halts
chapter at page 142. The only one difference here is, that these points cannot be centered
between the neighbouring points. A train line cannot be splitted outside of a station rectangle.
8.5.15.6.2 Part “Split of interval line”
Here you can select the Target interval line and
direction by the name of all filled in interval lines. This
data is used to show the correct data along the line
starting here.
8.5.15.7
8.5.15.7.1

Labelling of interval line
Part “Coordinates”

This part is the same as explained in Part
“Coordinates” at the No. of intermediate halts chapter
at page 142.
8.5.15.7.2

Part “Labelling of interval line”

The content of the label is set in the Text field. The
data is taken at first from the train data inside of the
graphic timetable. You can change the name here, if it
is needed. Using the button, which shows you the
current settings of the font, you can edit the Font.
The alignment of the text is normally set at the right angle to the bisecting line of the angle
given from the interval lines. So the Arc can be calculated automatically by the programme
or beeing set by yourself after deselecting the check box for automatic calculation.
The Horizontal and the Vertical alignment inside of the label can be set by the two lists.
The Type of shape can be changed to a
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 Rectangle,
 Rounded rectangle,
 Square,
 Circle or
 No shape.
The Line settings and the Filling of the shape can also be changed behind the buttons. In
some cases you can edit special data for one kinde of a shape.
The Font, Line and Filling colour can be fixed to the same as colour of interval line.

8.5.16

Extend interval line

Context menu
This function is only available, if you selected the last existing point of an interval line. The
interval line will be extended this way to a point, which you have to select in the opened
window. This way you can indicate trains running out of the area shown inside your interval
graphic. The settings of this point can be done in the same way, as if you would insert a new
interval line’s point.
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9 Station table
9.1 English translation
Sorry, for this new function does not exist an english documentation. It will be filled in as
soon as possible.
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10 Create Arrival & Departure poster
The posters are designed for passenger informations at a station. The design of these
posters is not defined in any directive, so that we give you a help to create this kind of
passenger information.
At the end of the creation of a new timetable poster Microsoft®-Word or Microsoft®-Write are
opened to see the result of your work.

10.1 Part “Timetable poster for...”
Here you can select the station or location for which you would like to create the timetable
poster. You can also differ between arrival and departure times.

10.2 Part “Included trains”
Here you can controll the train types, which should be shown. At first you can differ between
passenger trains and freight trains and others. It is also possible to choose no one of
these options and fill in the train types manuall. Please separate them by commata. If you
click the arrow on the right of the box, a list, including all train types in the network, is shown.
You can also click the train types there.

10.3 Part “Rounding rule ...”
Here you can select the rounding rules
for the included times.

10.4 Part “Created poster...”
At the moment you can only save it as a
file. You can fill in the path and file name
manuall or use the Windows®-save as
window to choose the position of the
created file. The data is saved as RichText-Format-files (*.rtf).

10.5 Part “Contents”
The contents are set here to give you the possibility to create the timetable posters in the
design you are interested in.
So you can select at first the data belonging to the
train at the current station. So you can include the
time, the days of operation in UIC411-style or an
FBS-style. If you want to have operation days at
every train please activate the show daily also box.
The train type, the train number and the track can
also be shown.
For a better overview it might be helpful to see the
start and end terminal of the whole train run added
by the linked times.
Some railway operators like to show the next stations
following after the current station. One option is to
show all following stopps until a limit of stopps is
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reached. You can also include stopps, which have a regular stoppage time higher than a
time limit set by you. Also all stopps with the highest-level service can be included. It is also
possible to include stopps by yourself to mark stations with a special interest for the
passengers. For example: to get access to a fair area or a park or something else.
It might be helpful for you to get every station in theire own line. This can be helpful if you
would like to go one designing the timetable poster in other programmes.
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11 Station database editor
11.1 General
This programme is included in the FBS programme family and allows it to create and edit
your own station database or to change an existing file.
The station database links the abbreviation and the full name of a station or location. Nearly
all FBS programmes work together with the station database. So you can create stations and
their abbreviations very fast to use them in all programmes.
If you would like to create your own station database please note the following conditions:
-

Every station has to have an own abbreviation.

-

Abbreviations have a maximum length of 5 letters or figures.

-

One and the same abbreviations cannot exist for two stations.

-

Upper and lower case is only differed at stations name.

-

Station names can have length up to 25 letters or figures.

11.2 Create a new station database
or Ctrl+N or File > New
A new empty database is shown to you.

11.3 Open an existing station database
or Ctrl+O or File > Open…
The open a file dialogue opens and you can select the file you would like to edit. Station
database files have the ending bsv.

11.4 Fill in a new station or location
or Alt+Einfg or Edit > Insert station…
At first you have to fill in the abbreviation of the station. Upper and lower case is not differed
in the abbreviation.
The station is sorted into the list by their abbreviation. The position inside the programme
cannot be changed.
After that, please fill in the at least the name and the type of the station. The settings can be
changed later if you would like to. The programme calculates the type of the station. Open
the extra window by click on the … button. Here you can change the properties of the station.
The complete settings are a sum of operational and transport properties and the current
usage (out of use, under planning, …). If you call up the station in a graphic timetable the
properties are filled in automatically.
The other properties you do not need to fill in. They are normally used to handle interfaces to
other programmes.
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Helpful are the properties Longitude and Latitude. If you would like to create a network in the
iPLAN programme you can use this data to position the station in the real distance to other
stations.
After pressing the button Ok the station is sorted in the list. This may take some time
because some stations might be moved. If the abbreviation still exists a message is shown to
you and you will get back to the edit window. So change the abbreviation to be able to fill the
station into the list.

11.5 Delete current station from database
or Alt+Entf or Edit > Delete station
By calling up this function the current selected station or location will be deleted. The deletion
has to be confirmed. It also might take several times because some stations might be moved
inside the list.

11.6 Edit name or properties of a station
or Alt+Enter or Edit > Edit station
You can reach this function also by double click at the station in the list. The window to fill in
a new station is opened and the station data is shown there. You can edit all properties and
finish it by button Ok or Cancel the changes.

11.7 Search a station by abbreviation
or Alt+A or Search > Search for a station abbreviation
Here you can search a station by her abbreviation. If the abbreviation is not found in the list
the station, which is as close as possible to your search string in alphabetic order is shown.

11.8 Search a station by name
or Alt+N or Search > Serach for a station name
A window opens in which you can fill in the search string. It is enough to fill in the first letters
of the station. You can also search for strings, which are included in the string and not at the
beginning of the station name. The programme searches automatically all stations, which
have this string at first. The search starts at the current position in the list. If the found station
is not the right one you can continue search by
on.

or Enter or Search > Search further

11.9 Detailed search
or Alt+F or Search > Detailed search …
Other programmes of the FBS-family to search for a station can also call up this function. A
window opens in which you can fill in all the properties the station has or the stations you are
looking for should have. You can use every combination of properties to limit the search. A
double click at one of the found stations fills them into the programme you used.
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12 Train type and head code database
This programme extends the possibilities to fill in the train type and head codes of trains. By
defining train types you get a working title for trains, which have to run by the same type of
transport. So you can show trains well arranged in timetables by their train type. It is also
possible to calculate statistics for train types.

12.1 Menu file
These functions are similar to all the other FBS programmes. Please do not forget to save
your znv-file after finishing your work.

12.2 General description of file
The general description of file is only a text to explain the data included in the file. For
example: Train types until 2003.

12.3 Administration of train types
12.3.1

Insert a new train type

or Edit > New train type
Every train type has an own name and abbreviation.
Please fill in the new abbreviation and the full name of the
train type. The description is only optional but it may help
you if you would like to edit the train types later. Every train
type should be assigned to one of the general train types
shown in the box.
The design of the train lines in the graphic timetable is also
set here. You can change the line style, the width and the
colour. Normally important trains are shown in fat lines and
empty stock trains are shown in broken line.

12.3.2

Edit a train type

or Edit > Edit train type
Please select at first in the left column the train type you would like to edit. You will reach the
same window as in item New train type but filled in with the data of the current train type.

12.3.3

Delete a train type

or Edit > Delete train type
The marked item in the list is deleted this way. Of course there will be a call back before the
train type is finally deleted.
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12.4 Administration of number range
12.4.1

General

By filling in trains into FBS it is helpful if an inserted train number gets automatically the right
train type. The right column in the programme window shows you the currently known
number ranges. A range of numbers can be used by more than one train type.

12.4.2

Insert a new number range

or Edit > New number range
You only have to fill in the last possible train number in this
range. The beginning is set automatically at the first train
number after the end of the number range before.
For example if you fill in 1199, the current range ends at
this number and the next range starts at 2000.
In the next line you can fill in the train types, which are
allowed to use this range of numbers.
It is also possible to leave a remark here for later changes.

12.4.3

Edit a number range

or Edit > Edit current number range
The known number ranges can be edited be selecting them in the list and one of the
possibilities shown up here.
There opens the same window as to insert a new number range.

12.4.4

Delete a number range

or Edit > Delete number range
The marked item in the list is deleted this way. Of course there will be a call back before the
train type is finally deleted.

12.5 Menu View
or View > Show description of train types
This function shows also the description of train types in the list. This might be helpful at
rarely used train types. Normally this text is hided to show more train types at the screen.
or View > Move train up / down or Ctrl+Nach oben / Ctrl+Nach unten
This function moves the current train type up or down in the list. So you can change the order
of train types to see often used train types on top of the list at the train data window inside of
a graphic timetable.
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13 Engine Database Editor
This programme is designed for you to check engines data and for short tests of other engine
configurations. Please call the Service to define new engines to your database.
The programme “TFZ” allows it to you to show the engine data as a graphic and to add your
engines in a simple way. The programme calculates the relevant data for run time calculation
by help of “normal” technical data (motor power, mass). To fill in the data correctly assistants
will help you. So difficult manual calculations and to look up for empiric figures in large tables
can be saved. The assistant uses the know formulas by WENDE and includes a huge
formula and figure database.
The functions explain themselves by hints (stop the mouse pointer a moment above the
button).
The programme window is divided in two parts. On the left you can see the list of engines
sorted by railway companies. This list is longer then the list of engines on the right, because
the same type of engine can be used several times at different railway companies. If you
click a series entry at the left the engine is also shown on the right window. If you select an
engine the first entry of a series with this engine is shown to you.

13.1 Menu File
The file menu is similar to the other programmes of FBS family.
You can only save the files if you have the full version of FBS!
If you save the file the list in the open iPLAN file is being updated so that you can use the
engine without a restart.
Additional here is the function to join files. So you can open other files to add them to the file,
which is still open.

13.2 Menu Edit
Please note: You cannot change all data for engines, which are not defined by you! Some
data are fixed. We do not recommend you to change the data of engines, which exist right
now in the database. Small changes of some figures have an important influence to the
results you can achieve and so to your timetable and all following data. If you are not sure
how to fill in the data correct please contact the service!

13.2.1

General engine data

Alt+A or Edit > General engine data or context menu
Here the general data of the engine is filled in. At first the
maximum speed in kilometres per hour and the mass of
the engine.
The length of the engine is important to calculate the right
length of the train.
The number of driven axles and non-driven axles is
important to calculate the right force by starting the train.
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So please fill in the correct adhesion weight in tons.

13.2.2

Special engine data

Alt+S or Edit > Special engine data or context menu
By this window you will see you need a lot of special data to fill in or edit an engine correctly.
The first fact called Coefficient of mass increase is a special factor to describe the rotating
mass inside of the engine.
The next box is made for defining the front of the engine. Fill in the Front area as a crosssection area in m² into the field and select one of the Head shapes included in the list.
The Type of bearing has also an influence to the force resistance. Please select roller
bearing or plain bearings.
The small table is needed to fill in the
Braking masses of the engine if it
doesn not work in a train. To fill in the
braking masses to the breaking
switches a double click opens a new
window.
On the right side of the box you can fill
some data to the equipment of the
engine. If your engine or train has a
tilting technology please fill in also the maximum tilting angle and the maximum tilting speed.

13.2.3

Traction and performance figures

Alt+L or Edit > Traction and performance figures or Context menu
In this window the lines to create
the
speed-force-diagram
are
defined.
At first the sum of the power of the
motors is inserted in kW. The next
data describes the maximum of
power for other functions (e. g.
cooling, trainlines, …) also in kW.
After that the efficiency of the
complete traction system is
inserted in percent. So the traction
power is calculated. You can also
turn calculation and fill in a
traction power to calculate the sum of the motor powers.
The next box shows you only the formulas, which
combine the different figures.
At the right table you can fill in single points to describe
the traction curve. These Traction values are the
results of the traction force measurements made with
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this engine. To get a usable traction curve it is needed to fill in the values in steps of 10 km/h.
Auxiliary traction curves have similar the same function as
the traction values. You can fill in the coefficients, which are
explained in the box Information to describe these formulas.
To fill the coefficients use the context menu and select new or
edit curves.
If you have finished filling in the data use the
button to
calculate the Traction characteristics. You can control the
data by diagram
or table with traction-speed values
.
The diagram includes all the curves being able to calculate with the data of the window. The
table shows only the figures, which are interesting in further calculations.

13.2.4

Train resistance

Alt+W or Edit > Train Resistance Data or Context menu
The resistance of the engine or train is defined in this window.
You can change the coefficients of the quadratic equation.

13.2.5

Engine Information and Remarks

Edit > Engine Information and Remarks or Context menu
The data inserted in here is not important for
calculation but it is important for you to find the engine
in the list of the useable engines.
At first the Manufacturer is description for series is
needed to sort the engine into the manufacture list.
Additional descriptions can be filled in the second field.
The axle arrangement (normally related to the German
system) is also only for your information.
Important is also the Sort key of manufacturer. This
key is the sum of the manufacturer, the series and the version or sub-series. You cannot
change this key here. To change it look at chapter 13.2.9.

13.2.6

Engine series data

Enter or Edit > Engine series data or Context menu
This data are important for statistic calculations in iPLAN. Please fill in the number of seats in
the first and second class and the part of low-loader. You just can edit these data for all
engines or better rail cars in this window for one time.

13.2.7

New Engine
or Ins or Edit > New engine or Context menu

This function leads you through the definition of a complete engine. Starting by Manufacture
and Type description to the General engine data to the Special engine data and the
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Traction and performance figures. At the end you can assign the engine to the series of
some railway companies.

13.2.8

Copy Engine

Alt+C or Edit > Copy Engine or Context menu
This function is only available for engines defined by you.
By calling up this function you can change the Manufactory and the Type description so that
you do not need to fill in all the data again if you want to define a similar engine.

13.2.9

Rename Engine

Edit > Rename Engine or Context menu
This function is also only available for engines defined by you.
You can change here the manufactory and / or the type description. The engine will be
sorted in the list by the new sort key.

13.2.10

Delete Engine

Edit > Delete Engine or Context menu
This function allows you to delete engines, which you have defined. You cannot delete all the
other engines. A call back prevents you before mistakes.

13.2.11

Rename Series

Alt+Enter or Edit > Rename Series or Context menu
This function is similar to the Rename Engine function as written in 13.2.9 on page 155.
Here you can change the railway company and / or the series description.

13.2.12

New series

Alt+Ins or Edit > New Series or Context menu
This might be the most important function for you by handling the list of engines.
At first enter the Railway Company using this series. Insert the companies name for this
series and press Ok. After that a window opens in which you have to select the engines,
which has to be related to this series. Here you can also change the number of seats if this
company uses another seating.

13.2.13

Delete Engine

Edit > Delete Series or Context menu
This function allows you to delete a series. A call back prevents you before mistakes.

13.2.14

Edit Railway Companies

Edit > Edit Railway Companies or Double click at a railway company in the list
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Railway companies are managed by their abbreviation. You can change the name in the list
by a double click. A new company will be created if you create a new engine. You can also
delete a company in this window. They are not deleted automatically if there is no engine
related to the railway company.

13.2.15

Edit Manufacturer List

Edit > Edit Manufacturer List or Double click at a manufactory in the list
The system here is similar to the system of the railway companies. You can also edit the
name or delete a manufactory. New manufactories are filled in automatically by creating a
new engine.

13.3 Menu View
13.3.1

Traction-Speed-Diagram

or View > Traction-Speed-Diagram
This function shows you the result of all settings made for the engine in a diagram. The xaxis shows the speed and the y-axis the power. All lines that limit the useable power are
shown in the diagram too.

13.3.2

Display value table

or View > Display value table
A table including the relevant data for the selected engine is shown to you.

13.4 Check Selection
This menu includes the “conventional” items but one, which might be really interesting for
you.
The item Check Selection opens the list of Available Engines as know from iPLAN. Here
you can control all changes you made to the list, which you normally use in iPLAN.
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14 Annex – Statistic Data
14.1 Statistic data of one train part
This data can be set in register “Train parts…”
Basic values:
 Spacially: total mileage of the train part
 temporally: total run time, total travel time
 attributes:


Number of operation days per period



Train parts mass (to be selected by only, including or without engine)



Number of axels (to be selected by only, including or without engine)



Number of seats (including engine, to be selected by 1. and/or 2. class)

Derivated values:
 Run time share (= total run time / total travel time)
 Average travel speed (= total mileage / travel time)
 Average run speed (= total mileage / run time)
 Tons kilometre (= train part mass x total mileage)
 Axle kilometre (= Number of axles x total mileage)
 Seat kilometre (= Number of seats x total mileage)
 Tons per year (= train part mass x number of operation days)
 Axels per year (= Number of axels x number of operation days)
 Seats per year (= Number of seats x number of operation days)
 Sum of operation time per year including stops (= total travel time x number of
operation days)
 Sum of operation time per year excluding stops (= total run time x number of operation
days)
 Mileage per period (=total mileage x number of operation days)
 Tons kilometres per year (= train parts mass x total mileage x number of operation
days)
 Axle kilometre per year (= number of axels x total mileage x number of operation days)
 Seat kilometre per year (= number of seats x total mileage x number of operation days)
Sums all over some train parts:
It is possible to sum all values, which include the operation days. But often it is difficult,
because you cannot see a train part or if there are some train parts coupled.
So the mileage per period can be applied:
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a) It is the same as the mileage per period if all trains parts run single (uncoupled).
b) It is the same as the vehicle mileage per period if all train parts consist of the same
vehicle2
c) The value has no use, if the train parts consist of different engines or waggons and /
or run partially coupled.
These values are normally not shown in the programme to avoid confusions by the train
kilometres per year.
To explain it in another way: The sum of train parts travelling time is called Sum of operation
time including stops. So you can get the impression to use this time to guess the engineers
working hours. This is not right because not every train part needs an engineer. You might
use this time to guess the working hours of your conductors if you would have a conductor
on all train parts. This time can also be used to guess the maintenance figures of engines if
all train parts include the same number of engines.
General meaning can only be done by sums, which show properties exactly to the vehicles:
 Sum of ton kilometres a year
 Sum of axle kilometres a year
 Sum of seat kilometres a year
The incorrect property train parts are replaced by the exact properties mass, axles or seats.
So no misunderstanding is possible. These values are always shown in statistics.

14.2 Statistic values of a train
These values depend on the line section and operation days but are independent to train
parts.
To calculate all this values the trains are separated in sections with the same number of
operation days. So the sections are not separated if only the train part data is changing
(number, load, …). Strictly speaking the sum of operation days are the or connections of the
operation days of all train parts of a route section. This sum of operation days is shown in
train data window at the register of a route section in “Train operates in this section:”
Basic values:
 Spacially: route length (“train kilometres“)
 temporally: travel time, run time
 attributes: number of operation days in period
Derivated values:
 run time share (= run time / travel time)
 average travel speed (= route length / travel time)
 average running speed (= route length / runtime)

2

This way you can calculate the vehicle mileage per period in a graphic timetable without calculating a circulation plan. This can
make sense if a head code or a graphic timetable includes only on type of vehicles.
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 mileage in the area (= route length x number of operation days, “train kilometres a
year“)
Sum of some trains:
You can only sum values of some trains which include the operation days. That means you
can only sum the number of operation days and the train kilometres a year.
The number of operation days changes to the number of runs in period. A train operating on
WXSa (250 days) and 10 trains at Sa+S (104) results 6040 train runs in period. The change
in measures is explained by:

Runs
operation _ days
Runs
x

operation _ days
period
period
The factor 1 is often forgotten because a train runs only once an operation day.
It makes no sense to add travelling times of trains directly:
Example: 4,5 h at WXSa + 3,7 h at Sa+S = 8,2 h at ???
To get such an information the sum of travel time and running time has to be related to the
operation days:
 Sum of travel time a year =

 t

R,i

 Average weighted travel speed =

 ni 
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 (s  n )
R,i

i

i

i

i

si ²  ni

 t
=
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i

 (the same way for running speed)
with

ni = number of operation days of train i
si = route length of the train i
tR,i = travelling time of train i
vR,i = average travelling speed of train i

14.3 Calculation of operation days in a statistic year
Please avoid using a statistic year. The resulting number of operation days is a statistic value
again, which fills in two problems:
a) The number of working days “WXSa”, the Saturdays “SaXS” and the Sundays and public
holidays “S” exists often only unexact. A train, which is not operating in this operation day
periods, has to be interpreted in relation to the given numbers of days. This interpretation
of the operating days can be handled different in regions. FBS allows you to fill in the
relative number of public holidays an working days and on weekends to solve this
problem.
b) It is not an exact calculation if you round a value in your calculation until a result based
on the statistic year is calculated. iPLAN rounds the number of operation days of a train
to whole days also if this is not the result of the calculation.
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Example 1:
A train operating on Mo-Do+So from a city to the region for example to prepare the following
rush hour train from Mo-Fr. The mileage he runs is 83 km. The statistic year includes 294 x
WXSa, 52 x SaXS and 64 x S. So iPLAN calculates the numbers of operation days as follow:
 Number of days by WXSa = 4/5 x 249
 Number of days by SaXS = 0
 Number of days by S = 52 + 5/7 x (64-52)3
 Total number of operation days = round(4/5x249 + 52 + 5/7x(64-52)) = 260
 Total mileage in a year = 260 d/a x 83 km = 21.580 km/a.
Example 2:
The same train operats at Mo-Do+SoXvS, that means to prepare a train operating WXSa:
 Number of days by WXSa = 4/5 x 249
 Number of days by SaXS = 0
 Number of days by S = 52 + 5/7 x (64-52) - 4/7 x (64-52)
 Total number of operation days = round (4/5x249 + 52 + 1/7x(64-52)) = 253
 Total mileage in a year = 253 d/a x 83 km = 20.999 km/a.
This way is not the best but it is the easiest way to describe a statistic year only by three
figures. This way bases on the model, that every day in a group of days has the same
number like the other days in the group. So a public holiday is in one year a Monday in the
next a Tuesday and so on. But this is not true. It would be better to calculate the real number
of working days inside of “WXSa” and the public holidays “S” and to use this figures. So FBS
allows it to use an alternative way to put in the numbers of all 14 single week days and public
holidays in the year.
 Example 2 shows you a bad side of the statistic: If the train starts early in the morning at
WXSa to run to the city it results 249 days (Number of “WXSa”). If the train is prepared the
evening before ((So+Mo-Do)XvS) he runs also 249 days and not 253 days as calculated in
the example!
 Another basic mistake of the most of the statistic years that the result has to be 365+1/41
/400 = 365,2475 days and so the single components have to able to be a real number.
 It would be consequent if there only this trains are allowed, which operate exact on WXSa,
SaXS, S, Sa+S, XSa or daily. This should be enough for strategic studies. But the example
above shows you, that it is not done this way. And in some regions the real train orders (train
kilometres) are calculated by a statistic year and financed this way.

14.4 An exact statistic year
How should a statistic year look like?
Example Saxony: 13 public holidays

3

Here a year has as much Saturdays as Sundays. So the number of public holidays is the same as number of S without
number of SaXS This number is balanced in many statistic years to 1/7 to every day of the week.
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 New Year’s Day

variable holiday

 Good Friday

even on Friday

 Easter Sunday

even on Sunday

 Easter Monday

even on Monday

 May Day

variable holiday

 Ascension day

even on Thursday

 Whit Sunday

even on Sunday

 Whit Monday

even on Monday

 Anniversary of German unification

variable holiday

 Day of Reformation

variable holiday

 Day of repentance and pray

even on Wednesday

 Christmas Day

variable holiday

 Boxing Day

variable holiday

Real division of the holidays
 Mo

2x

Fr

1x

 Di

0x

Sa

0x

 Mi

1x

Su

2x

 Do

1x

variable

6x

Every Weekday exists 52.1782 times in a year with 365,2475 days. To calculate now the
number of the working days of a week we subtract the number of holidays at this weekday
and 6x1/7 for the probability that a variable holiday will be at this day:
Mo
Di
Mi
Do
Fr
Sa
Su
Sum

Working days of a Week
52,1782-2-6/7 = 49,32
52,1782-0-6/7 = 51,32
52,1782-1-6/7 = 50,32
52,1782-1-6/7 = 50,32
52,1782-1-6/7 = 50,32
52,1782-0-6/7 = 51,32
52,1782-2-6/7 = 49,32
352,24

public holidays
2+6/7 = 2,857
0+6/7 = 0,857
1+6/7 = 1,857
1+6/7 = 1,857
1+6/7 = 1,857
0+6/7 = 0,857
2+6/7 = 2,857
+
13,000

= 365,24 days

14.5 Statistics and train coupling and sharing
The difference between the train part mileage in the area and the Mileage in the area shows
the train kilometres, which can be saved by train coupling and sharing.
 This is important if you couple trains to save route toll.
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15 Annex – Declaration of operation days
15.1 General
FBS differs between regular operation days and special operation days. Regular operation
days have been developed in the history of railway systems. They are known around the
world and easy to handle. Nearly all cases can be described this way. Special operation days
can added to the regular operation days in special cases.
FBS understands the two letter abbreviations of the days of a week. Just for customizing
some operators to describe the operation days depend on the language you have selected.
So you are not able to use the German system if your language is set to English and the
reverse way too. FBS also knows the abbreviations of the months depending on the
language of your Windows® settings.

15.2 Regular operation days
Regular operation days represent the seven days of a week without any connection to a
concrete date or week. To differ the working days from a public holiday there exist seven
operation days too. So the regular operation days consist of the seven working days of a
week, which are not public holidays, and seven public holidays of a week.
The syntax behind the system, which is used in FBS has been developed since the first
railways started operation. The system consists of:


Abbreviations for the seven days of a week,



Abbreviations for often used combinations of weekdays and public holidays of a week,



Logic operators to combine the symbols.

The abbreviations depend on the language settings of FBS. Please look at the table at the
end of this annex.
For controlling the public holidays of a week there exist special codes.
If the train operates at all working days but not on public holidays you can use the code: W.
Just for the opposite (only on Sundays and public holidays) you can use the symbol: S.
Trains which operate a day before a public holiday can be described by the Symbol: bS. aS
describes a train operating at the day after a public holiday or Sunday. By using 2bS and
2aS you can set operation days to two days before or two days after Sunday and public
holidays.
W
=
“Working days“: Weekdays Mo-Sa without the public holidays at these days
S
=
“Sundays and public holidays“: Weekday Su and all public holidays
(Sunday and all other weekdays if they are public holidays)
bS
=
Working day (including Saturday) before a Sunday or public holiday
2bS =
Working day (including Saturday) two days before a Sunday or public holiday
aS
=
Working day (including Saturday) after a Sunday or public holiday
2bS =
Working day (including Saturday) two days after a Sunday or public holiday
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15.3  Special operation days

As operators you can use in all languages:
+ , ; & or Space for the simple addition (logic or). The programme reads all this signs and
“translates” them to a “+” and shows only this sign.
[ ] Definitions in square brackets show the days in which the train does not operate
(logic NOT, negativ-days, not on). The square brackets symbolize the frame, which
would be signed if the operation days would be written down by hand. You can also
fill in parentheses or braces, which are translated by the programme to brackets. All
negative days are positioned behind the positive days.
- The minus is used in the combinations specified above as “until”-sign.
Every positive or negative area can include four codes for operation days.
You can use every combination of operation day codes without any difference in function.
FBS does not summarize the combinations e.g. We+Th+Fr will not be changed to We-Fr. If
FBS builds combinations itself (for example by summarizing train parts) it uses the shortest
way to show the operation days. The programme prefers the operates line before the not on
line. The combination of two train parts operating on Mo-Fr and Su is summarized to Su-Fr,
whether [Sa] would be possible.
If it is not possible to summarize the operation days of train parts the programme shows VT
(German abbreviation of operation days Verkehrstage).

15.3 Special operation days
A special operation day is nothing else than a concrete date. To calculate with this date the
timetable period has to be set by the first and the last day of operation in this period. The
beginning and the end of the timetable period are saved relative to the 30.12.1899. To
rebuild a timetable which was used before that date please ask the service.
To define the special operation days they are differed in three ways:
-

Only means a period or single days in which the train operates. Only days limit the
operation period of the train.

-

Also means a period or single days in which the train operates additional to the
regular operation days.

Not on means a period or special days in which the train does not operate whether
the regular operation days require it. These days are often used exclude operation
days for example a day between a public holiday and a weekend.
The operation day settings are handled in the following priorities:
 The highest priority belongs to the only days. No one of the following days can be out of
the range of the only days.
-



Not on can exclude single days or a period in another period. No one of the following
days can include these day again.



Also can include single days or a period in another period. No one of the following days
can exclude them again.



The following days are decided by the regular operation days.
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15.4 The data bS, 2bS, aS and 2aS
This data defines special days inside of the group of the regular operation days. Their
opportunities places them between the regular and the special operation days. You can say
they are the special regular operation days.
Related to a Sunday they are redundant to the following regular operation days:


bS = SaXS



2bS = FrXS



aS = MoXS



2aS = TuXS

In relation to the public holidays, which are not a Sunday, you can use the functions only if a
timetable period is defined and includes the concrete public holidays. That means: the
before and after dates are used as regular operation days if there is no period defined
or the timetable does not have any public holiday. Or said the other way: To use the
before and after dates you have to define a period and include the public holidays.
In this case the before and after days work to Sundays and public holidays, which are not
Sundays or another public holiday.
Operation days, which are defined in brackets, have a higher priority then the other dates.

15.5 Train which operates as required (+Q)
Another railway historic phenomenon is the train that operates as required. This information
was used to show the railway employee along the line that a train could be cancelled without
a foregoing notice. Along the time many influences changed the meaning of train, which
operates as required. Actually this information is used seldom. It is avoided at passenger
trains and freight trains operate nearly normally as required without any special sign.
FBS allows the as required labelling by an own window:


Train operates at the given days as required only.
This option does not effect the internal function of operating days. It is informational
only and is normally used in Station Timetables to tell the staff that the train may be
cancelled without notice.



Train may additionally operate as required at days not shown.
This option sets the internal function of operating days to “daily” to secure that there ca not
be any conflicts at any day. In the graphic the regular days are still shown. The train has only
influence to the statistic at his regular operation days.



Q does not overwrite the only or not on areas.

Example:

We+Q = at Wednesdays only and only as required
Q+We = only as required, but even on Wednesday
QXS = only as required but not at Sunday or public holiday

Priorities of operation day settings:
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1. only can do further limitation to the general period; no one of the following settings
can be outside of this area
2. not on can exclude single days or periods inside of the timetable period; no one of
the following settings can include this days again
3. also can include days or periods inside the timetable period; no one of the following
settings can exclude this days again
4. the following days are decided by the regular operation days.

15.6 Helpful function in defined timetable periods
If you have to change the operation days of trains shortly you can change them by keywords
today, tomorrow, the day after tomorrow. FBS calculates the dates itself and shows them to
you. It is also allowed to start the entries at the special operation days (only, also, not on) by
a concrete day. You can also combine such entries if they are separated by “;”. A legal entry
would be: tomorrow; 3.10.; also 20.12.-31.12.; not on 24.12.
Please note that you have to fill in the month after every day. FBS tries to reduce the entries
and changes the entry 3.04.-12.04. to 3.-12.04.
For a further simplifying you can fill the month in Arabic numbers, in small or upper roman
figures or the name of the month or the abbreviation of the month depending on your
Windows® settings.
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16 Annex – Stations and Locations in FBS
You can differ between operational places and access places along a line. The functions
can of course be combined.
Operational places have an influence to the operation of the railway especially for slot
search. They can be differed to train order change places and to train following places.
Train order change places can be used to change the order of the trains for
example to overtake trains or to cross trains at a single track line.
Train following places limit the room in which a train can drive. So you can handle
only running in blocking limits by FBS. Train following places regulate the distance
between the trains and not the row of them.
Access places are the interfaces to the railways. They are differed between passenger and
freight traffic. The clearest attribute to a passenger access places is stop to change
passengers and a platform. They are further differed in
Category (a): service personal, ticket counter and information
Category (b): “machine” service and
Category (c): only placards.
Often passenger access places are interfaces to other means of transportations (for example
to the bus).
Freight access places can be differed in freight stations for example to handle containers or
public good sidings or private sidings.
You can combine every access places with every operational place. The following part
explains especially the properties of operational places because they are important to the
timetable. All other properties are mostly used for your information or to handle interfaces to
other programmes.
Meaning of the following “classic” properties of an operational place in FBS:
 Temporary unstaffed4: During the time of operation no signal man has the controll
about this station. The station can be managed every time by a train crew which
arrived at the station. So there is no functional difference to a staffed station.
 Temporary out of use: The station is not staffed in times, which you selected. So the
station is not controlled locally, or remote controlled and cannot be managed by train
crews. In these times the station has no function for railway operation.
 Remote-controlled: That means the station is operated from another place and the
dispatcher has no visual contact to the station. For FBS it is the same as a local
operated station. The differences are shown in times of failures but this has no
influence to the timetable. This option cannot be activated if “temporary out of use” is
chosen.
4

Only unstaffed would be wrong, because a real unstaffed station has no influence to railway
operation.
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Meaning of other properties of all stations and places in FBS:
 Out of use: The station is regularly not used but it still exists and can be reactivated
for construction levels or changes in the timetable. This property sets all operational
and transport properties out of function.
 Abandoned / withdrawn: The station cannot be used any longer and is filled in here
only for information. This property sets all operational and transport properties out of
function.
 under planning is only for information and has no influence to the function.
 Country border, Tariff border, Depot, Engine shed and power station are only for
your information. This properties will be used in further versions of FBS to get another
basic conditions (e.g. depots for circulation plans).
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Examples for typical stations
local staffed station
 Operation: train order change place, station class I - IV depending on the meaning

-

iPLAN does not take care for train following places between the home and the distant
signal

In iPLAN the station has an unlimited capacity
Station controlled by an Integrated Electronic Control Centre

 Operation: train order change place, station class I-IV depending on the meaning, remote
controlled

Functions in FBS like a local controlled station
unstaffed station in direct traffic control (“Zugleitbetrieb”)
-

 Operation: train order change place,, station class III or IV, station without home signals,
remote controlled

-

Stations without home signals (normally unmanned stations at simple operation
systems) are handled by capacity of one train per running direction. A following train
is kept in the station before until the train in this station has left5. At a train crossing
the train that reached at first can start as far as the other train reached the station too.

5

So “real“ overtakings are blocked by FPL. If you would like to do an overtaking you should end the
first train, run the other train and restart the first train.
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Such a station has a more restrictive influence to following trains as to crossing
trains.6
-

if you use self reset points please take care of the entries in the speed lists.

-

or if you can change the used track please note the regular station track list

remote controll is also possible, if there are no local controlled elements there (for
example by Radio Electronic Token Block).
Unmanned station at simplified operation systems “Zugleitbetrieb”
-

 operation: train order change place, normally station class IV, temporary unmanned

-

Default position of the points leads to the main track, trains reach always at this track.

-

It works in FBS like a normal station, so it is not checked that the first train enters the
running through track.

-

It is not relevant whether the station is temporary controlled by a signal man or by
trains crew.

-

Because of manual route controlling use a crossing time by 5 minutes.

Neither general speed limit by entering the station or a speed limit by the station
tracks
Junction (two lines)
-

 operation: train order change place, junction, as the case may be remote controlled
 transport: no properties

-

iPLAN blocks train crossings at junctions. It is possible to set the train property train
leaves/changes to the line. Overtakings, ending or starting trains are also not
allowed7.

If your line uses the slower direction of the junction please set the lower speed to the
line speed limits and not to the station speed limits.
crossover between single and double track areas
-

 operation: train order change place, Crossover, as the case may be remote controlled
6

Because of this discrepancy the longer blocking time for following trains is not shown in the blocking
time stairs.
7

Exception: Trains can look like trains starting or ending at a junction at the end or beginning of a line.
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 transport: no properties

-

It is not possible to create overtakings and no beginning or ending trains.

The speed of the slower track inside the point has to be filled in the line speed limit of
the direction.
Crossover between single and double track areas in combination with a stop
-

 it is absolutely needed to separate this into a stop and a crossover

crossover inside a double track area
 operation: train order change place, crossover, often remote controlled
 transport: no properties

If it is possible to change the track but it is regulary not needed it would be better to
define it as a train following place (blocking signal).
Station without sidings or loops
-

-

either fill it in as a normal station and handle the restrictions manual

-

or separate it into a stop and two crossovers or train following places (recommended)

Please note that the stop can be a train order change place if trains end or start there.
Crossing station with only a one side controlled siding

 operation: train order change place, station class IV, station without home signals,
temporary unmanned or remote controlled
 transport: no properties

-

Use a large crossing time (around 10 min)

There are no overtakings allowed. If they are needed separate the first train into an
ending and starting train.
Passing loops
-
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Passing loops are a special case in Germany: It becomes a "goods siding with crossing
possibility" if it is combined with goods siding. The passing / crossing of trains is possible
with token-less runs only. Though passing loops are arranged with train order change places,
they do not work like those. I. e. iPLAN does not suggest any train crossings or passings
there. At such infrastructural facilities crossings are possible under very special conditions
and functional combinations only.
Stop
 operation: no properties (look at the comments)
 transport: passenger transport

-

If trains shall begin or end there, you can use two ways to reach the target:
If there are block limits there, configure it as a train order change place, station
class IV, without home signals, temporary unmanned
Or handle the train as a train running through a part of the section only

Block post
 operation: train following place, block post, as the case may be remote controlled
 transport: no properties

Please note: If both signals of a block post have an important distance separate them into to
different train following places with relevant pre- and post blocking times. It is possible to
differ the direction of the block signals.

Stop in combination with a block post
 operation: train following place, block post, as the case may be remote controlled
 transport: stop (non serviced passenger transport)

Stops in combination with a private siding or loading bank
 operation: no properties
 transport: Stop and private siding or loading bank
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Trains to operate the private sidings or loading bank have to marked as trains running
through a part of the section only.
ATC block post
-

 operation: train following place, ATC block post, remote controlled
 transport: no properties
These block posts are only used for trains using ATC. Trains, which are driven by signals, do
not attend this train following places.
Dividing lines at simplified operation systems
 operation: train following place, block post, temporary unmanned or remote controlled (!)
 transport: no properties or any kind of passenger transport

-

The technique of the train following place (block post, block signal or group of signals)
and the manning can also be selected free

Look also at the remarks to “stop“
Locations, which have only a transport function, have no operational properties or simple
access places.

Under planning: This location is shown in brackets and cursive in all pictures and can be
identified this way easily.
Country border and Tariff border are locations, which show you the borders of ownerships,
excutive bodies or tariffs. This locations are suggested in the menu Zones at infrastructure
window as borders.
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17 Annex – Overview of hotkeys in FBS
The hotkeys explained here, are shown like you can find them in the menu items. So the
following keys are translated as:
Strg = Ctrl; Umsch = Shift; Alt = Alt; Tab = Tab; Bild auf = page up; Bild ab = page down;
Einfg = ins; Entf = del; Enter = enter.
General hotkeys
Umsch+F1

- change to FBS-Dispatcher

Umsch+F3

- change to BFO-Programme

Umsch+F4

- change to iPLAN-Programme

Umsch+F5

- change to Station database programme

Umsch+F7

- change to Engine database

Umsch+F12

- close all FBS-Programmes

Ctrl+Alt+L

- change Language

Ctrl+Esc - opens Windows®-startmenu
Alt+Tab

- changes to the next running programme (if there are some programmes running)

In a field:
Strg + C

- copy the marked text to the clipboard (also Strg + Einfg)

Strg + X

- cut the marked text to the clipboard (also Shift + Entf)

Strg + V

- fill in the text from the clipboard at the cursor position (also Shift + Einfg)

In lists and tables:
Strg + Einfg

- copy the list as a tab-separated text into the clipboard

Network timetable programme iPLAN
Tab

- skip to the next network file (if some of them are open)

Umsch + Tab

- skip to the last network file (if some of them are open)

Strg + F4

- close the current network file

Alt + F4

- close the network programme

Strg + A

- save all files

Strg + I

- Programme-information

Strg + K

- Programme-Configuration

Strg + L

- switch symbol line on / off

Strg + N

- open a new network file

173

Chapter 17  Annex – Overview of hotkeys in FBS
15.6  Helpful function in defined timetable periods

Documentation to FBS
Edition November 2015
Strg + O

- open a network file

Strg + P

- print the current network file

Strg + R

- reset the divider of the list

Strg + S

- save current network file

Strg + U

- save current network file as …

Circulation plan - window
Alt + A

- general circulation data

Alt + B

- show the complete width of the sheet

Alt + G

- show the circulation graphic

Alt + L

- show the possibilities of empty running

Alt + P

- print circulation

Alt + R

- check the trains in the circulation plan by the graphic timetable files

Alt + T

- show the current circulation table

Alt + U

- set determine links to the current train

Alt + V

- show the list of current circulation possibilities

Alt + Z

- show / hide the list of trains

Alt + F4

- close the circulation window

Umsch + up

- roll up the graphic one engine (without Umsch: roll in the current list)

Umsch + down

- roll down the graphic one engine (without Shift: roll in the current list)

Umsch + P

- switch the protocol on / off (produces an Uml.txt-file during the calculation of the circulations)

Graphic timetable
Strg + A

- save all

Strg + I

- Programme-Information

Strg + K

- Programme-Configuration

Strg + L

- switch on / off the symbol line

Strg + N

- open a new timetable file

Strg + O

- open a timetable file

Strg + P

- print the current timetable file

Strg + S

- save the current timetable file

Strg + U

- save the current timetable file as …

Strg + X

- switch on / off the horizontal scroll bar
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Strg + Y

- switch on / off the vertical scroll bar

Strg + <

- allow departure times at every tenth of a minute

Strg + 0

- allow departure times only at full minutes

Strg + 1

- allow departure times only at 0,1 minutes

Strg + 2

- allow departure times only at 0,2 minutes

Strg + 3

- allow departure times only at 0,3 minutes

Strg + 4

- allow departure times only at 0,4 minutes

Strg + 5

- allow departure times only at 0,5 minutes

Tab

- change to the next timetable file (if some of them are open)

Umsch + Tab

- change to the last timetable file (if some of them are open)

Strg + F4

- close the current timetable file

Alt + F4

- close timetable programme

Ctrl+Enter

- fill in the time to show

Alt + A

- opens “Edit display settings depending on timetable menu”

Alt + B

- activate menu “Edit”

Alt + C

- show conflict list

Alt + D

- activate menu “File”

Alt + E

- activate menu “Window”

Alt + F

- edit general timetable settings

Alt + G

- show / hide line tracks

Alt + H

- activate menu “help”

Alt + I

- edit info text

Alt + K

- show / hide head of timetable

Alt + O

- activate menu “options”

Alt + R

- changing rounding rule

Alt + S

- fill in line data

Alt + T

- copy the current train in clock

Alt + V

- open the window “traffic input data”

Alt + W

- choose the weekday which should be shown

Alt + X

- show train data sheet

Alt + Z

- show / hide the blocking times
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Alt + Einfg

- fill in a new train

Alt + Entf

- delete the current train

Alt + Rück

- undo the last action

Alt + 0

- round the shown times to full minutes

Alt + 1

- round the shown times to /10-minutes

Alt + 5

- round the shown times to /2-minutes

Alt + <

- switch slot search between until the next train order change place or trains end station

Alt

- change the train to edit (if some trains are selected)

Shift

- show train number of the train behind the mouse pointer

F1… F10

- activate the mouse mode (similar by pressing on of the buttons up on the toolbar)

F12

- skip between page width/height zoom and last zoom size

+ (keypad)

- enlarge zoom factor

- (keypad)

- scaling down zoom factor

1

1

Strg + mouse wheel - enlarging/scaling zoom factor
Alt + left mouse button - create zoom rectangle
Cursor left

- scroll the line section mileage down

Cursor right

- scroll the line section mileage up

Cursor up

- scroll the time 10 minutes earlier

Cursor down

- scroll the time 10 minutes later

Bild auf

- scroll the time 1 hour earlier

Bild ab

- scroll the time 1 hour later

ESC

- abort the current preview (if a preview line is shown)

Train diagram (s-v-Diagram)
Alt + C

- Copy chart to the clipboard

Alt + D

- print chart

Alt + E

- export the chart into a file

Alt + H

- use the full height of the sheet on / off

Alt + L

- show / hide legend

Alt + P

- show the complete protocol
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